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Preface

Intended Audience

This manual is for programmers at all levels of experience. It covers both user
interfaces of the debugger:

® The OpenVMS DECwindows Motif interface for workstations
¢ The command interface for terminals and workstations

On VAX processors, you can use the debugger with programs written in the
following VAX languages:

Ada BASIC BLISS C

C++1 COBOL DIBOL FORTRAN
MACRO-32 Pascal PL/1I RPG II
SCAN ¢

INote that C++ functionality is minimal in this release.

On Alpha processors, you can use the debugger with programs written in the
following DEC languages:

Ada BASIC BLISS C
C++! COBOL Fortran MACRO-322
MACRO-64 Pascal PL/1

INote that C++ functionality is minimal in this release.
2Note that MACRO-32 must be compiled with the AMACRO compiler.

The OpenVMS Debugger on OpenVMS Alpha systems can access all the extended
memory made available by the 64-bit processing of the OpenVMS Alpha operating
system. Hence, you can examine and manipulate data in the complete 64-bit
address space. ¢

The OpenVMS Debugger has been internationalized. For Asian users, the
debugger’s DECwindows Motif, command line, and screen mode interfaces can be
used with multibyte characters.

You can use the debugger to debug code only in user mode. You cannot debug
code in supervisor, executive, or kernel modes.
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Document Structure
This manual is organized as follows:

® Part I describes the debugger’s DECwindows Motif interface. Part I includes
the following chapters:

Chapter 1 introduces the debugger and gives an overview of its
DECwindows Motif interface features.

Chapter 2 explains how to prepare your program for debugging and then
start and end a debugging session.

Chapter 3, which is organized by task, explains how to use the debugger.

Chapter 4, which is organized by task, explains how to use the debugger’s
Heap Analyzer.

e Part II describes the debugger’s command interface. Part II includes the
following chapters:

L VAX il

Chapter 5 introduces the command interface.

Chapter 6 gets you started using the debugger.

Chapter 7 explains how to control and monitor program execution.
Chapter 8 explains how to examine and manipulate program data.
Chapter 9 explains how to control access to symbols in your brogram.
Chapter 10 explains how to control the display of source code.
Chapter 11 explains how to use screen mode.

Chapter 12 explains additional convenience features, such as key
definitions and other customizations.

Chapter 13 explains some special cases, such as debugging optimized
programs and multilanguage programs.

Chapter 14 explains how to debug multiprocess programs.
Chapter 15 explains how to debug vectorized programs. ¢

. Chapter 16 explains how to debug tasking (multithread) programs.

e Part III is the debugger command dictionary, followed by the appendixes:

Appendix A lists the keypad-key definitions that are predefined by the
debugger.

Appendix B identifies all of the debugger built-in symbols and loglcal
names.

Appendix C identifies the debugger support for languages.

Appendix D contains the source code of the programs shown in the figures
in Chapters 1, 2, and 3.

Related Documents \ _
The following documents may also be helpful when using the debugger.
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Programming Languages
This manual emphasizes debugger usage that is common to all or most supported
languages. For more information specific to a particular language, see:

¢ The debugger’s online help system (see Section 6.1)

¢ The documentation supplied with that language, particularly regarding
compiling and linking the program for debugging

e The VAX MACRO and Instruction Set Reference Manual or the MACRO-64
Assembler for OpenVMS AXP Systems Reference Manual for information
about assembly-language instructions and the MACRO assembler

Linker Utility

For information about the linking of programs or shareable images, see the
OpenVMS Linker Utility Manual.

Delta/XDelta Debugger
For information about debugging code in supervisor, executive, or kernel modes
(that is, in other than user mode), see the OpenVMS Delta/XDelta Debugger
Manual in the OpenVMS documentation set. This manual contains information
about debugging programs that run in privileged processor mode or at an elevated
interrupt priority level.

m OpenVMS Alpha System-Code Debugger

On Alpha processors systems, see the OpenVMS Alpha Device Support:
Developer’s Guide for information on debugging Alpha operating system code.
This manual describes how to create an Alpha device driver, activate the
OpenVMS Alpha System-Code Debugger through the OpenVMS Debugger, and
debug within the OpenVMS Alpha System-Code Debugger environment.

For information on System-Code Debugger-specific commands, see the CONNECT
and REBOOT commands in Part III. ¢

DECwindows Motif

For general information about the DECwindows Motif interface, see the VMS
DECwindows User’s Guide.

World Wide Web
For additional information on OpenVMS products and services, access the Digital
OpenVMS World Wide Web site. Use the following URL:

http://www.openvms.digital.com

Reader’s Comments
Digital welcomes your comments on this manual.
Print or edit the online form SYS$HELP:OPENVMSDOC_COMMENTS.TXT and

send us your comments by:

Internet . openvmsdoc@zko.mts.dec.com -
Fax 603 881-0120, Attention: OpenVMS Documentation, ZK03-4/U08
Mail OpenVMS Documentation Group, ZK03-4/U08

110 Spit Brook Rd.
Nashua, NH 03062-2698
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How To Order Additional Documentation

Use the following table to order additional documentation or information.
If you need help deciding which documentation best meets your needs, call
800-DIGITAL (800-344-4825).

Telephone and Direct Mail Orders '

Location Call Fax Write
U.S.A. DECdirect Fax: 800-234-2298 Digital Equipment Corporation
i 800-DIGITAL P.O.Box CS2008
800-344-4825 Nashua, NH 03061
Puerto Rico 809-781-0505 Fax: 809-749-8300 Digital Equipment Caribbean, Inc.

3 Digital Plaza, 1st Street, Suite 200
P.O.Box 11038

Metro Office Park

San Juan, Puerto Rico 00910-2138

Canada 800-267-6215 Fax: 613-592-1946 Digital Equipment of Canada, Ltd.
Box 13000
100 Herzberg Road
Kanata, Ontario, Canada K2K 2A6
Attn: DECdirect Sales

International - - Local Digital subsidiary or
approved distributor
Internal Orders DTN: 2644446 Fax: 603-884-3960 U.S. Software Supply Business
603-884—4446 Digital Equipment Corporation
10 Cotton Road

Nashua, NH 030631260

ZK-7654A-GE

Conventions
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The name of the OpenVMS AXP operating system has been changed to OpenVMS
Alpha. Any references to OpenVMS AXP or AXP are synonymous with OpenVMS
Alpha or Alpha.

The following conventions are used to identify information specific to OpenVMS
Alpha or to OpenVMS VAX:

The Alpha icon denotes the beginning of information
m specific to OpenVMS Alpha.
L

The VAX icon denotes the beginning of information
specific to OpenVMS VAX.

The diamond symbol denotes the end of a section of
information specific to OpenVMS Alpha or to OpenVMS
VAX. ‘

In this manual, every use of DECwindows and DECwindows Motif refers to
DECwindows Motif for OpenVMS software.

This manual contains many figures showing the DECwindows Motif interface to
the debugger. Because the display configuration of this interface is customizable,
these figures may not exactly picture the appearance. of debugger displays on
your system.



The examples in this manual have not been updated to reflect the fact that the
OpenVMS Debugger on OpenVMS Alpha systems can access all the extended
memory made available by the 64-bit processing of the OpenVMS Alpha operating
system. You should note that hexadecimal addresses are 16-digit numbers on
Alpha and 8-digit numbers on VAX. For example,

DBG> EVALUATE/ADDRESS/HEX %hex 000004A0

00000000000004A0

DBG>
*

The following conventions are also used in this manual:

Ctrl/x A sequence such as Ctrl/x indicates that you must hold down
the key labeled Ctrl while you press another key or a pointing
device button.

PFl«x A sequence such as PF1 x indicates that you must first press
and release the key labeled PF1 and then press and release
another key or a pointing device button.

GOLD x A sequence such as GOLD x indicates that you must first
press and release the key defined as GOLD and then press
and release another key. GOLD key sequences can also have
a slash (/), dash (-), or underscore (_) as a delimiter in EVE

commands.
The GOLD key definition is often mapped to the PF1 key on
the keypad. ,

In examples, a key name enclosed in a box indicates that

you press a key on the keyboard. (In text, a key name is not
enclosed in a box.)

Horizontal ellipsis points in examples indicate one of the
following possibilities:

e Additional optional arguments in a statement have been
omitted.

¢ The preceding item or items can be repeated one or more
times.

e Additional parameters, values, or other information can be
entered.

Vertical ellipsis points indicate the omission of items from
a code example or command format; the items are omitted
because they are not important to the topic being discussed.

O) In command format descriptions, parentheses indicate that, if
you choose more than one option, you must enclose the choices
in parentheses.

[1 In command format descriptions, brackets indicate optional
elements. You can choose one, none, or all of the options.
(Brackets are not optional, however, in the syntax of a directory
name in an OpenVMS file specification or in the syntax of a
substring specification in an assignment statement.)

{1 In command format descriptions, braces surround a required
choice of options; you must choose one of the options listed.
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boldface text

italic text

UPPERCASE TEXT

struct

numbers

Boldface text represents the introduction of a new term or the
name of an argument, an attribute, or a reason (user action
that triggers a callback).

Boldface text is also used to show user input in Bookreader
versions of the manual.

Italic text emphasizes important information and indicates
complete titles of manuals and variables. Variables include
information that varies in system messages (Internal error
number), in command lines (/PRODUCER=name), and in
command parameters in text (where device-name contains up
to five alphanumeric characters).

Uppercase text indicates a command, the name of a routine,
the name of a file, or the abbreviation for a system privilege.

Monospace type in text identifies the following C programming
language elements: keywords, the names of independently
compiled external functions and files, syntax summaries, and
references to variables or identifiers introduced in an example.

A hyphen at the end of a command format description,
command line, or code line indicates that the command or
statement continues on the following line.

All numbers in text are assumed to be decimal unless
otherwise noted. Nondecimal radixes—binary, octal, or
hexadecimal—are explicitly indicated.



Partl

DECwindows Interface

This part describes the debugger’s DECwindows Motif interface.

For information about the debugger’s command interface, see Part II.






1

Introduction to the Debugger: DECwindows
Motif Interface

This chapter introduces the debugger’s DECwindows Motif interface. For
information about the command interface, see Part IIL.

This chapter provides the following information:

e A functional overview of the OpenVMS Debugger, including its user interface
options—DECwindows Motif and command (Section 1.1)

¢ An orientation to the debugger’s DECwindows Motif screen features, such as
windows, menus, and so on (Section 1.2)

¢ Instructions for entering debugger commands at the command-entry prompt
(Section 1.3)

e Instructions for accessing online help (Section 1.4)

For information about starting a debugging session, see Chapter 2. For
information about using the debugger, see Chapter 3. For the source code
of program EIGHTQUEENS.EXE, shown in the figures of this chapter, see
Appendix D.

1.1 Overview of the Debugger

The OpenVMS Debugger helps you locate run-time programming or logic errors,
also known as bugs. You use the debugger with a program that has been compiled
and linked successfully, but does not run correctly. For example, the program
might give incorrect output, go into an infinite loop, or terminate prematurely.

Note

You cannot use the DECwindows Motif interface to the debugger to debug
detached processes such as print symbionts that run without a Command
line interpreter (CLI). See Section 5.3.8.5 for details about debugging
detached processes that do not have a CLI.

You can locate errors with the debugger by observing and manipulating your
program interactively as it executes. The debugger enables you to:

e Display the program’s source code and, optionally, your program’s machine-
level instruction code, as the program executes that code

e Browse through the source code to identify potential bugs
e Set breakpoints to suspend program execution at such pbints

e Execute the program, one routine at a time, one source line at a time, one
machine instruction at a time, or from breakpoint to breakpoint
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¢ Display the current value of a program variable or register
® DMonitor changes in variables or registers during program execution

* Change the value of a variable or register and, in some cases, test the
modification without having to edit and recompile the source code

As you find errors in the program, you can edit the source code and compile, link,
and execute the corrected version.

These are basic debugging techniques. As you use the debugger and its
documentation, you will discover variations on the basic techniques. You
can also customize the debugger to your own needs.

The debugger is a symbolic debugger. You can specify variable names, routine
names, and symbols precisely as they appear in the source code. or you can
specify memory addresses and registers when referring to program locations, as
is most convenient.

You can use the debugger with programs written in any of the source languages
listed in the Preface. The debugger recognizes the syntax, data types, operators,
expressions, scoping rules, and other constructs of the supported languages.
You can change the debugging context from one language to another during a
debugging session. ’

1.1.1 User Interface Options

The OpenVMS Debugger has the following user interface options to accommodate
different needs and debugging styles:

¢ The debugger has a character-cell (screen-mode) command interface for
terminals and workstations. When using this interface, you enter debugger
commands at a prompt. In addition to general-purpose debugging features,
the command interface provides special features not available through the
default DECwindows Motif interface (for example, commands for multiprocess
debugging).

¢ The debugger has a DECwindows Motif interface for workstations. This
interface is an enhancement to the screen-mode command interface that
accepts mouse input to choose items from menus and to activate or deactivate
push buttons, to drag the pointer to select text in windows, and so on. The
debugger’s DECwindows Motif interface menus and push buttons provide the
features for most basic debugging tasks.
The DECwindows Motif interface is layered on the screen-mode command
interface and has a command-entry prompt on the command line (in the
command view). From the DECwindows Motif interface command line, you
can enter debugger commands for the following purposes:

— As an alternative to using the DECwindows Motif interface menus and
push buttons for certain operations

— To do debugging tasks not available through the DECwindows Motif
interface menus and push buttons

You can customize the DECwindows Motif interface to associate other
debugger commands with new or existing pushbuttons.
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Note

The DECwindows Motif interface does not recognize the HELP command
at its command-entry prompt. Choose the On Commands item in the
Help menu for online help on debugger commands.

'1.1.2 Convenience Features

The following paragraphs highlight some of the convenience features of the
debugger’s default DECwindows Motif interface. Section 1.2 gives visual details.
(Convenience features of the debugger’s command interface are described in detail
in Section 5.1.2.)

Source-Code Display

The OpenVMS Debugger is a source-level debugger. The debugger displays in
the source view the source code that surrounds the instruction where program
execution is paused currently. You can enable and disable the display of compiler-
generated line numbers.

A source browser lets you:

¢ List the images, modules, and routines of your program

¢ Display source code from selected modules or routines

¢ Display the underlying hierarchy of modules and routines
e Set breakpoints by double-clicking on selected routines

Call-Stack Navigation

The call-stack menu on the main window lists the sequence of routine calls
currently on the call stack. Click on a routine name in the call-stack menu to set
(to that routine) the context (scope) for

e Source code display (in the source view)

¢ Register display (in the register view)

¢ Instruction display (in the instruction view
¢  Symbol searches

Breakpoints

You set, activate, and deactivate breakpoints by clicking on buttons next to the
source lines in the source view or the instruction view. Optionally, you can set,
deactivate, or activate breakpoints by selecting items in window pull-down menus,
pop-up menus, context-sensitive menus, or dialog boxes. You can set conditional
breakpoints, which suspend program execution if the specified condition is true.
You can set action breakpoints, which execute one or more debugger commands
when the breakpoint suspends program execution. The main window push
buttons, the instruction view push buttons, and the breakpoint view give a
visual indication of activated, deactivated, and conditional breakpoints.

Push Buttons

Push buttons in the push button view control common operations: by clicking
on a push button, you can start execution, step to the next source line, display
the value of a variable selected in a window, interrupt execution, and so on.

You can modify, add, remove, and resequence push buttons and the associated
debugger commands.

1-3



Introduction to the Debugger: DECwindows Motif Interface
1.1 Overview of the Debugger

1-4

Context-Sensitive Pop-Up Menus

Context-sensitive pop-up menus list common operations associated with your
view (source view, command view, and so on.) When you click MB3, the pop-up
menu lists actions for the text you have selected, the source line at which you are
pointing, or the view in which you are working.

Displaying and Manipulating Data

To display the value of a variable or expression, select the variable or expression
in the source view and click on a push button, such as EVAL (evaluate expression)
or EX (examine variable). You can also display selected values by choosing items
from window pull-down menus (such as Examine, in the Commands pull-down
menu), context-sensitive menus, or dialog boxes. You can dlsplay values in
different type or radix formats.

To change the value of a variable, edit the currently displayed value in the
monitor view. You can also change values by selecting items in window pull-down
menus (such as Deposit, in the Commands pull-down menu), context-sensitive
pop-up menus, or dialog boxes.

The monitor view displays the updated values of specified variables whenever the
debugger regains control from your program.

Kept Debugger RERUN Command

You can run the debugger in a state known as the kept debugger from which
you can rerun the same program or run another program without exiting the
debugger. When rerunning a program, you can choose to save the current state
of breakpoints, tracepoints, and static watchpoints. The kept debugger is
also available in the screen mode debugger. See Section 2.1 for information on
starting the kept debugger.

Instruction and Register Views

The instruction view shows the decoded instruction stream (the code that is
actually executing) of your program. This view is useful if the program you
are debugging has been optimized by the compiler, in which case the source
code in the source view may not reflect the code that is executing. You can set
breakpoints on instructions and display the memory addresses and source-code
line numbers associated with each instruction.

The register view displays the current contents of all machine registers. You can
edit the displayed values to deposit other values into the registers.

Tasking Program Support

The tasking view displays information about the current state of all tasks of
a tasking program (also called a multithread program). You can modify task
characteristics to control task execution, priority, state transitions, and so on.

Integration with Command Interface

The debugger’s DECwindows Motif interface is an enhancement to the screen
mode debugger. It is layered on, and closely integrated with, the command-driven
screen mode debugger:

¢  When you use the DECwindows Motif interface menus and push buttons, the
debugger echoes your commands in the command view to provide a record of
your actions.

e When you enter commands at the prompt, the debugger updates the
DECwindows Motif views accordingly.
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Integration with Source-Level Editor

You can edit program source code without exiting from the debugger. In the editor
view, you can display the source code, search and replace text, or add additional
text. Editor view text buffers allow you to move quickly back and forth between
new or existing files, and copy, cut, and paste text from buffer to buffer.

The text editor available through the debugger’s DECwindows Motif menu
interface is a simple convenience feature, not intended to replace sophisticated
text editors such as the Language-Sensitive Editor (LSE). To use a different
editor, enter the Edit command at the DBG> prompt in the command view (see
EDIT.

Customization

You can modify the following and other aspects of the debugger’s DECwindows
Motif interface and save the current settings in a resource file to customize your
debugger startup environment:

* Configuration of windows and views (for example, size, screen location, order)

e Push button order, labels, and associated debugger commands (this includes
adding and removing push buttons)

e Character fonts for displayed text

Online Help ‘
Online help is available for the debugger’s DECwindows Motif interface (context-

sensitive help) and for its command interface.
1.2 Debugger Windows and Menus

The following sections describe the debugger windows, menus, views, and other
features of the OpenVMS Debugger DECwindows Motif interface.

1.2.1 Default Window Configuration
By default, the debugger starts up in the main window, as shown in Figure 1-1.

When you start the debugger as explained in Section 2.1, the source view is
initially empty. Figure 1-1 shows the source view after a program has been
brought under debugger control (by directing the debugger to run a specific
image, in this example, EIGHTQUEENS). ' ‘

You can customize the startup configuration to your preference as described in
Section 3.10.1.

1.2.2 Main Window
The main window (see Figure 1-1) includes:
e Title bar (see Section 1.2.2.1)
* Source view (see Section 1.2.2.2)
¢ Pull-down menus (see Section 1.2.2.3)
e (Call Stack view (see Section 1.2.2.4)
¢ Push button view (see Section 1.2.2.5)

e Command view (see Section 1.2.2.6)
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Figure 1-1 Default Window Configuration
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Language: C, Module: EIGHTQUEENS
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No source line for address: 0000C4E7

DBG> |
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1.2.2.1 Title Bar
The title bar, at the top of the main window, displays (by default) the name of the
debugger, the name of the program being debugged, and the name of the source
code module that is currently displayed in the source view.

1.2.2.2 Source View
The source view shows the following:

* Source code of the program you are debugging and, by default, the compiler-
generated line numbers (to the left of the source code). To choose not to
display line numbers, see Section 3.1.

¢ Breakpoint toggle push buttons.

e Current-location pointer (a triangle to the left of breakpoint push buttons),
which points to the line of source code that will be executed when program
execution resumes.

For more information about displaying source code, see Section 1.2.2.3 and
Section 3.1.

1.2.2.3 Menus on Main Window
Figure 1-2 and Table 1-1 describe the menus on the main window.
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Figure 1-2 Menus on Main Window
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Table 1-1 Menus on Main Window
Menu Item Description
File Run Image... Bring a program under debugger control by specifying
an executable image.
Run Foreign Bring a program under debugger control by specifying
Command... a symbol for a foreign command.
Rerun Same... Rerun the same program under debugger control.
Browse Sources... Display the source code in any module of your program.
Set breakpoints on routines.
Display Line Display or hide line numbers in the source view.
Numbers
Exit Debugger End the debugging session, terminating the debugger.
Edit Cut Cut selected text and copy it to the clipboard. You can
cut text only from fields or regions that accept input
(although, in most cases, Cut copies the selected text to
the clipboard).
Copy Copy selected text from the window to the clipboard
without deleting the text.
Paste Paste text from the clipboard to a text-entry field or
region.
Break On Exception Break on any exception signaled during program

Activate All
Deactivate All
Cancel All

execution.
Activate any previously set breakpoints.
Deactivate any previously set breakpoints.

Remove all breakpoints from the debugger’s breakpoint
list and from the breakpoint view.

(continued on next page)
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Table 1-1 (Cont.) Menus on Main Window

Menu Item Description
Set... Set a new breakpoint, optionally associated with a
particular condition or action, at a specified location.
Commands Examine... Examine the current value of a variable or expression.
The output value may be typecast or changed in radix.
Deposit... Deposit a value to a variable. The input value may be
changed in radix.
Edit File Edit the source code of your file in the debugger’s
editor.

Options Views... Display one or more of the following:

Breakpoint view
Monitor view
Register view
Tasking view
Instruction view

Customize Modify, add, remove, or resequence a push button in

Buttons... the push button view and the associated debugger
command.

Save Options Save the current settings of all DECwindows Motif

features of the debugger that you can customize
interactively, such as the configuration of windows
and views, and push button definitions. This preserves
the current debugger configuration for the next time
you run the debugger.

Restore Default Copy the system default debugger resource file

Options DECW$SYSTEM_DEFAULTS:VMSDEBUG.DAT
to the user-specific resource file DECW$USER_
DEFAULTS:VMSDEBUG.DAT. The default options
take effect when you next start the debugger.

Edit Options File Load and display the user-specific resource file
DECW$USER_DEFAULTS:VMSDEBUG.DAT in the
debug editor for review and modification.

Help On Context Enable the display of context-sensitive online help.
On Window Display information about the debugger.
On Help Display information about the online help system.
On Version Display information about this version of the debugger.
On Commands Display information about debugger commands.

1.2.2.4 Call Stack Menu

The Call Stack menu, between the source view and the push button view, shows
the name of the routine whose source code is displayed in the source view. This
menu lists the sequence of routine calls currently on the stack and lets you set
the scope of source code display and symbol searches to any routine on the stack
(see Section 3.6.2).
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1.2.2.5 Push Button View

Figure 1-3 and Table 1-2 describe the default push buttons in the main window.
You can modify, add, remove, and resequence buttons and their associated
commands as explained in Section 3.10.3.

Figure 1-3 Default Buttons in the Push Button View
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Table 1-2 Default Buttons in the Push Button View

Button Description .

Stop Interrupt program execution or a debugger operation without ending the
debugging session.

Go Start or resume execution from the current program location.

STEP Execute the program one step unit of execution. By default, this is one

executable line of source code.

S/in When execution is suspended at a routine call statement, move execution
into the called routine just past the start of the routine. This is the same
behavior as STEP if not at a routine call statement.

S/ret Execute the program directly to the end of the current routine.
S/eall Execute the program directly to the next Call or Return instruction.
EX Display, in the command view, the current value of a variable whose name

you have selected in a window.

E/az Display, in the command view, the current value of a variable whose
: name you have selected in a window. The variable is interpreted as a
zero-terminated ASCII string.

E/ac Display, in the command view, the current value of a variable whose name
you have selected in a window. The variable is interpreted as a counted
ASCII string preceded by a one-byte count field that contains the length of
the string.

EVAL Display, in the command view, the value of a language expression in the
current language (by default, the language of the module containing the
main program).

MON Display, in the monitor view, a variable name that you have selected in a
window and the current value of that variable. Whenever the debugger
regains control from your program, it automatically checks the value and
updates the displayed value accordingly.

1.2.2.6 Command View
The command view, located directly under the push button view in the main
window, accepts typed command input on the command line (see Section 1.3),
and displays debugger output other than that displayed in the optional views.
Examples of such output are:

¢ The result of an Examine operation.

¢ Diagnostic messages. For online help on debugger diagnostic messages, see
Section 1.4.4.
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e Command echo. The debugger translates your DECwindows Motif menu and
push button input into debugger commands and displays those commands
on the command line in the command view, providing a record of your most
recent commands. This enables you to correlate your input with debugger
actions.

You can clear the entire command view, leaving only the current command-line
prompt, by choosing Clear Command Window from the pop-up menu.

You can clear the current command line by choosing Clear Command Line from
the pop-up menu.

1.2.3 Optional Views Window

Table 1-3 lists the optional views. They are accessible by choosing Views... from
the Options menu on the main window.

Table 1-3 Optional Views
View Description

Breakpoint view  List all breakpoints that are currently set and identify those which
are activated, deactivated, or qualified as conditional breakpoints. The
breakpoint view also allows you to modify the state of each breakpoint.

Monitor view List variables whose values you want to monitor as your program
executes. The debugger updates the values whenever it regains control
from your program (for example, after a step or at a breakpoint).
Alternatively, you can set a watchpoint, causing execution to stop
whenever a particular variable has been modified. You can also change
the values of variables.

Instruction view Display the decoded instruction stream of your program and allow you
to set breakpoints on instructions. By default, the debugger displays
the corresponding memory addresses and source-code line numbers to
the left of the instructions. You can choose to suppress these.

Register view Display the current contents of all machine registers. The debugger
updates the values whenever it regains control from your program. The
register view also lets you change the values in registers.

Tasking view List all the existing (nonterminated) tasks of a tasking program.
Provides information about each task and allows you to modify the
state of each task.

Figure 1-5 shows a possible configuration of the breakpoint view, monitor view,
and register view, as a result of the selections in the View menu in Figure 1-4.

Figure 1-6 shows the instruction view, which is a separate window so that you
can position it where most convenient. Figure 1-7 shows the tasking view.

Note that the registers and instructions displayed are system-specific. Figure 1-5
and Figure 1-6 show VAX-specific registers and instructions.

You can move and resize all windows. You can also save a particular configuration
of the windows and views so that it is set up automatically when you restart the
debugger (see Section 3.10.1).
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Figure 1-4 Debugger Main Window
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Figure 1-5 Breakpoint, Monitor, and Register Views
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Figure 1-7 Tasking View
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Figure 1-8 Menus on Optional Views Window
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1.2.3.1 Menus on Optional Views Window
Figure 1-8 and Table 14 describe the menus on the optional views window.
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Table 1-4 Menus on Optional Views Window

Menu Item Description
File Close Close the optional views window.
Exit Debugger 'End the debugging session, terminating the debugger.
Break On Exception Break on any exception signaled during program
execution.

Activate All Activate any previously set breakpoints.

Deactivate All Deactivate any previously set breakpoints.

Cancel All Remove all breakpoints from the debugger’s breakpoint
list and from the breakpoint view.

Toggle Toggle a breakpoint.

Set/Modify... Set a new breakpoint, optionally associated with a
particular condition or action, at a specified location.

Cancel Cancel (delete) an individual breakp/oint.

Monitor Expand Expand monitor view output to include the values
of component parts of a selected item as well as the
aggregate value.

Collapse Collapse the monitor view output to show only the
aggregate value of a selected item, instead of the values of
each component part.

Deposit... Change the value of a monitored element.

Toggle Toggle a selected watchpoint.

Watchpoint

Typecast Use the submenu to typecast output for a selected variable
to int, long, quad, short, or char*.

Change Radix Use the submenu to change the output radix for a selected
variable to hex, octal, binary, or decimal.

Change All Radix Use the submenu to change the output radix for all
subsequent monitored elements to hex, octal, binary, or
decimal.

Remove Remove an element from the monitor view.

Register Change Radix Use the submenu to change radix for selected register to
hex, octal, binary, or decimal.

Change All Radix  Use the submenu to change radix for all registers to hex,
octal, binary, or decimal.

Tasks Abort Request that the selected task be terminated at the next
allowed opportunity. '

Activate Make the selected task the active task.

Hold Place the selected task on hold.

Nohold Release the selected task from hold.

Make Visible Make the selected task the visible task.

All Use the submenu to abort all tasks or release all tasks

1-14
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Table 1-4 (Cont.) Menus on Optional Views Window

Menu

Item

Description

Options

Help

Views...

Customize
Buttons...

Save Options

Restore Default
Options

Edit Options File

On Context
On Window
On Help

On Version

On Commands

Display one or more of the following:

Breakpoint view
Monitor view
Register view
Tasking view
Instruction view

Modify, add, remove, or resequence a push button in the
push button view and the associated debugger command.

Save the current settings of all DECwindows Motif
features of the debugger that you can customize
interactively, such as the configuration of windows and
views, and push button definitions. This preserves your
current debugger configuration for the next time you run
the debugger.

Copy the system default debugger resource file
DECW$SYSTEM_DEFAULTS:VMSDEBUG.DAT

to the user-specific resource file DECW$USER_
DEFAULTS:VMSDEBUG.DAT. The default options take
effect when you next start the debugger.

Load and display the user-specific resource file
DECW$USER_DEFAULTS:VMSDEBUG.DAT in the
debug editor for review and modification.

Enable the display of context-sensitive online help.
Display information about the debugger.

Display information about the online help system.
Display information about this version of the debugger.

Display information about debugger commands.

1.3 Entering Commands at the Prompt

The debugger’s DECwindows Motif interface is layered on the command interface.
The command line, the last line in the command view and identified by the
command-entry prompt (DBG>), lets you enter debugger commands for the

following purposes:

¢ As an alternative to using the DECwindows Motif interface menus and push
buttons for certain operations

* ' To do debugging tasks not available through the DECwindows Motif interface
pull-down menus and push buttons

Figure 1-9 shows the RUN command in the command view.
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Figure 1-9 Entering Commands at the Prompt
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OpenVMS VAX DEBUG Version V7.0-000

DBG> run eightqueens

Language: C, Module: EIGHTQUEENS
Type GO to reach MAIN program

No source line for address: 0000C4E7
DBG>

When you use the DECwindows Motif interface pull-down menus and push
buttons, the debugger translates your input into debugger commands and
echoes these commands on the command line so that you have a record of your
commands. Echoed commands are visually indistinguishable from commands
that you enter explicitly on the command line.

For information about the debugger’s command interface, see Part II. For online
help about the commands, see Section 1.4.3.

In addition to entering debugger commands interactively at the prompt, you can
also place them in debugger initialization files and command files for execution
within the DECwindows Motif environment.

You can also take advantage of the keypad support available at the command-
entry prompt. (This support is a subset of the more extensive keypad support
provided for the command interface, which is described in Appendix A.) The
commands in Table 1-5 are mapped to individual keys on your computer
keypad.

Table 1-5 Keypad Definitions in the DECwindows Motif Debugger Interface

Command Corresponding Key
Step/Line KPO

Step/Into GOLD-KP0
Step/Over BLUE-KPO
Examine KP1

Examine” GOLD-KP1

Go ' KP,

Show Calls KP5

Show Calls 3 GOLD-KP5

To enter one of these commands, press the key or keys indicated, followed by the
Enter key on the keypad. (The GOLD key is PF1; the BLUE key is PF4.)

For information on changing these key bindings, or binding commands to
unassigned keys on the keypad, see Section 3.10.4.4.
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1.3.1 Debugger Commands That Are Not Available in the DECwindows Motif
Interface

Table 1-6 lists the debugger commands that are disabled in the debugger’s
DECwindows Motif interface. Many of them are relevant only to the debugger’s
screen mode.

Table 1-6 Debugger Commands not Available in the DECwindows Motif

Interface
ATTACH SELECT
CANCEL MODE (SET,SHOW) ABORT_KEY
CANCEL WINDOW (SET,SHOW) KEY
DEFINE/KEY (SET,SHOW) MARGINS
DELETE/KEY SET MODE [NOJKEYPAD
DISPLAY SET MODE [NOJSCREEN
EXAMINE/SOURCE SET MODE [NOJSCROLL
EXPAND _ SET OUTPUT [NOJTERMINAL
EXTRACT (SET,SHOW) TERMINAL
HELP* (SET,SHOW) WINDOW
MOVE (SET,CANCEL) DISPLAY
SAVE SHOW SELECT
SCROLL SPAWN

'Help on commands is available from the Help menu in a debugger window.

The debugger issues an error message if you enter any of these commands on
the command line, or if the debugger encounters one of these commands while
executing a command procedure.

1.4 Displaying Online Help About the Debugger

The following types of online help about the debugger and debugging are
available during a debugging session:

¢ Context-sensitive help—information about an area or object in a window or
dialog box

e Task-oriented help—consists of an introductory help topic named Overview of
the Debugger and several subtopics on specific debugging tasks

¢ Help on debugger commands and various topics, such as language support
¢ Help on debugger diagnostic messages

Task-oriented topics related to context-sensitive topics are connected through the
list of additional topics in the help windows.
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1.4.1 Displaying Context-Sensitive Help

Context-sensitive help is information about an area or object in a window or a
dialog box.

To display context-sensitive help:

1. Choose On Context from the Help menu in a debugger window. The pointer
shape changes to a question mark (?).

2. Place the question mark on an object or area in a debugger window or dialog
box.

3. Click MB1. Help for that area or object is displayed in a Help window.
Additional topics provide task-oriented discussions, where applicable.

To display context-sensitive help for a dialog box, you can also click on the Help
button in the dialog box.
Note

You cannot get true context-sensitive help about any push button other
than Stop. This is because all other buttons can be modified or removed.

1.4.2 Displaying the Overview Help Topic and Subtopic

The Overview help topic (Overview of the Debugger) and its subtopics provide
task-oriented information about the debugger and debugging.

To display the Overview topic, use either of these techniques:
¢ Choose On Window from the Help menu in a debugger window.
®  Choose Go To Overview from the View menu of a debugger help window.

To display information about a particular topic, choose it from the list of
additional topics.

1.4.3 Displaying Help on Debugger Commands
To display help on debugger commands:

1. Choose On Commands from the Help menu of a debugger window.

2. Choose the command name or other topic (for example, Language_Support)
from the list of additional topics.

Note that the Help command is not available through the command view.

1.4.4 Displaying Help on Debugger Diagnostic Messages

Debugger diagnostic messages are displayed in the command view. To display
help on a particular message:

1. Choose On Commands from the Help menu of a debugger window.
2. Choose Messages from the list of additional topics.

3. Choose the message identifier from the list of additional topics.
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Starting and Ending a Debugging Session

This chapter explains how to:

Start the debuggér (Section 2.1)

Continue when your program completes execution (Section 2.2)

Rerun the same program from the current debugging session (Section 2.3)
Run another program from the current debugging session (Section 2.4)
Interrupt program execution and debugger operations (Section 2.5)

End a debugging session (Section 2.6)

Start the debugger in additional ways for specific purposes (Section 2.7)

2.1 Starting the Debugger

This section explains the most common way to start the debugger from DCL level
($) and bring your program under debugger control. Section 2.7 explains optional
ways to start the debugger.

Starting the kept debugger as explained here enables you to use the Rerun (see
Section 2.3) and Run (see Section 2.4) features.

To start the debugger and bring your program under debugger control:

1.

2.

Verify that you have compiled and linked the program as explained in
Section 5.2.

Verify that the debugging configuration (default or multiprocess)

is appropriate for the kind of program you are going to debug (see
Section 5.3.8.3). For a program that runs in only one process (the typical
case), use the default configuration.

Enter the following command line:
$ DEBUG/KEEP |

By default, the debugger starts up as shown in Figure 2-1. The main window
remains empty until you bring a program under debugger control (step 4).
Upon startup, the debugger executes any user-defined initialization file (see
Section 12.2).
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Figure 2-1 Debugger at Startup
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OpenVMS VAX DEBUG Version V7.0-000

4. Bring your program under debugger control using one of the following two
techniques:

Run a specified image (this is the most common technique):

Choose Run Image... from the File menu on the main window. The

1.

Run Image dialog box lists the executable images in your current
directory (see Figure 2-2).

2. Click on the name of the image to be debugged. The Image: field
displays the image name.

3. ' If applicable, enter arguments to be passed to the program in the
Arguments: field. If you specify a quoted string, you might have to
add quotation marks because the debugger strips quotes when parsing
the string.

4, Click on OK.

Run an image by specifying a DCL command or a symbol for a foreign

command:

1. Choose Run Foreign Command... from the File menu on the main

window. The Run Foreign Command dialog box is displayed (see
Figure 2-3).

Enter the symbol in the Foreign Command: field (such a symbol can
provide a shortcut around the directory and file selection process).
The foreign command X1, shown in Figure 2-3, has been previously
defined:

$X1 :== RUN MYDISK:[MYDIRECTORY.MYSUBDIRECTORY ]EIGHTQUEENS.EXE

Enter any arguments to be passed with the command in the
Arguments: field.
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Figure 2-2 Running a Program by Specifying an Image
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Figure 2-3 Running a Program by Specifying a Command Symbol
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4. Click on OK.

Once the debugger has control of the program, the debugger:

¢ Displays the program’s source code in the main window, as shown in
Figure 24.



Starting and Ending a Debugging Session
2.1 Starting the Debugger

2-4

¢ Suspends execution at the start of the main program. The current-location
pointer to the left of the source code, shows which line of code will be executed
next.

Figure 2-4 Source Display at Startup

OpenVMS Debug64 — EIGHTQUEENS:

File Edit Break Commands Options

V]

OpenVMS VAX DEBUG Version V7.0-000

DBG> RUN DBGD6S: [LARU.CPROGS]EIGHTQUEENS. EXE;5
Language: C, Module: EIGHTQUEENS ’
Type GO to reach MAIN program

No source line for address: 0000C4E7

DBG> |

[ —

The message displayed in the command view indicates that this debugging
session is initialized for a C program and that the name of the source module is
EIGHTQUEENS.

With certain programs, the debugger sets a temporary breakpoint to suspend -
program execution at the start of some initialization code, before the main
program, and displays the following message:

Type GO to reach MAIN program
No source line for address: nnnnnnnn

With some of these programs (for example, Ada programs), the breakpoint
enables you to debug the initialization code using full symbolic information.

The initialization sets up language-dependent debugger parameters. These
parameters control the way the debugger parses names and expressions, formats
debugger output, and so on.

You can now debug your program as explained in Chapter 3. ,
Note the following restrictions about running a program under debugger control:

* You cannot use the procedure in this section to connect the debugger to a
running program (see Section 2.7.2).

*  You cannot run a program under debugger control over a DECnet link. Both
the image to be debugged and the debugger must reside on the same node.
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2.2 When Your Program Completes Execution

When your program completes execution normally during a debugging session,
the debugger issues the following message:

‘Normal successful completion’

You then have the following opfions:

You can rerun your program from the same debugging session (see
Section 2.3).

You can run another program from the same debugging session (see
Section 2.4).

You can end the debugging session (see Section 2.6).

2.3 Rerunning the Same Program from the Current Debugging
Session

You can rerun the program currently under debugger control at any time during

a

debugging session, provided you originally started the debugger as explained in

Section 2.1.

To rerun your program:

1.

Choose Rerun Same... from the File menu on the main window. The Rerun
dialog box is displayed (see Figure 2-5).

Enter any arguments to be passed to the program, if required, in the
Arguments: field. If you specify a quoted string, you might have to add
quotation marks because the debugger strips quotes when parsing the string.

Choose whether or not to keep the current state of any breakpoints,
tracepoints, or static watchpoints that you previously set, activated, or

- deactivated (see Section 3.4 and Section 3.5.5). Nonstatic watchpoints might
or might not be saved, depending on the scope of the variable being watched
relative to the main program unit (where execution restarts).

Click on OK.

Figure 2-5 Rerunning the Same Program

Spenvars De : . =1

Eilelgdit Break Commands Options Help I

Run image... Debug: Rerun
Run Foreign Command...

Arquments:

Rerun §ame. .

[J Keep Current Breakpoints
Browse Sources...

M Display Line Numbers L] Heap Analyzer

Exit Debugger | OK | |cance|| I Help |
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When you rerun a program, it is in the same initial state as a program that is
brought under debugger control as explained in Section 2.1, except for any saved
breakpoints, tracepoints, or static watchpoints. The source display and current
location pointer are updated accordingly.

When you rerun a program, the debugger uses the same version of the image
that is currently under debugger control. To debug a different version of that
program (or a different program) from the same debugging session, choose Run
Image... or Run Foreign Command.. from the File menu on the main window
(see Section 2.1). ‘

2.4 Running Another Program from the Current Debugging Session

You can bring another program under debugger control at any time during a
debugging session, if you started the debugger as explained in Section 2.1. Follow
the procedure in that section for bringing a program under debugger control (also
note the restrictions about using that procedure).

2.5 Interrupting Program Execution and Aborting Debugger

Operations

To interrupt program execution during a debugging session, click on the Stop
button on the push button view (see Figure 1-3). This is useful if, for example,
the program is in an infinite loop.

To abort a debugger operation in progress, click on Stop. This is useful if, for
example, the debugger is displaying a long stream of data.

Clicking on Stop does not end the debugging session. Clicking on Stop has no
effect when the program is not running or when the debugger is not executing a
command.

2.6 Endmg a Debugging Session

To end a debugging session and terminate the debugger, choose Exit Debugger
from the File menu on the main window, or enter EXIT at the prompt (to avoid
confirmation dialog). This returns control to system level.

To rerun your program from the current debugging session, see Section 2.3.

To run another program from the current debugging session, see Section 2.4.

2.7 Additional Options for Starting the Debugger
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In addition to the startup procedure described in Section 2.1, the following
options are available for starting the debugger from DCL level ($):

e Start the debugger by running the program to be debugged with the DCL
RUN command (see Section 2.7.1).

¢ Interrupt a running program by pressing Ctrl/Y and then start the debugger
using the DCL DEBUG command (see Section 2.7.2).

e Establish a default or multiprocess debugging configuration to debug a
program that runs in either one or several processes, respectively (see
Chapter 16).

¢ Override the debugger’s default (DECwindows Motif) interface (see
Section 2.7.3) to achieve the following:

— Display the DECwindows Motif interface on another workstation
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— Display the command interface in a DECterm window along with any
program input/output (I/0)

— Display the command interface and program I/O in separate DECterm
windows

In all cases, before starting the debugger, verify that you have compiled and
linked the modules of your program (as explained in Section 5.2) and established
the proper debugging configuration (as explained in Section 5.3.8.3).

2.7.1 Starting the Debugger by Running a Program

You can start the debugger and also bring your program under debugger control
in one step by entering the DCL command RUN program-image (assuming the
program was compiled and linked with the /DEBUG qualifier).

However, you cannot then use the Rerun or Run features explained in Section 2.3
and Section 2.4, respectively. To rerun the same program or run a new program
under debugger control, you must first exit the debugger and start it again.

To start the debugger by running a program, enter the DCL command
RUN program-image to start the debugger. For example:

$ RUN EIGHTQUEENS

By default, the debugger starts up as shown in Figure 24, executing any user-
defined initialization file and displaying the program’s source code in the main
window. The current-location pointer shows that execution is paused at the start
of the main program. The debugger sets the language-dependent parameters to
the source language of the main program unit.

For more information about debugger startup, see Section 2.1.

2.7.2 Starting the Debugger After Interrupting a Running Program

You can bring a program that is executing freely under debugger control. This is
useful if you suspect that the program might be in an infinite loop or if you see
erroneous output. '

To bring your program under debugger control:

1. Enter the DCL command RUN/NODEBUG program-image to execute the
program without debugger control.

2. Press Ctrl/Y to interrupt the executing program. Control passes to the DCL
command interpreter.

3. Enter the DCL command DEBUG to start the debugger.
For example:

$ RUN/NODEBUG EIGHTQUEENS

Interrupt
$ DEBUG
[starts debugger]

At startup, the debugger displays the main window and executes any user-defined
initialization file, and sets the language-dependent parameters to the source
language of the module in which execution was interrupted.

2-7
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To help you determine where execution was interrupted:
1. Look at the main window.
2. Enter the SET MODULES/CALLS command at the command-entry prompt.

3. Display the Call Stack menu on that window to identify the sequence of
routine calls on the call stack. The routine at level 0 is the routine in which
execution is currently paused (see Section 3.3.1).

When you start the debugger in this manner, you cannot then use the Rerun or
Run features explained in Section 2.3 and Section 2.4, respectively. To rerun the
same program or run a new program under debugger control, you must first exit
the debugger and start it again.

For more information about debugger startup, see Section 2.1.

- 2.7.3 Overriding the Debugger’s Default Interface

By default, if your workstation is running DECwindows Motif, the debugger
starts up in the DECwindows Motif interface, which is displayed on the
workstation specified by the DECwindows Motif applicationwide logical name
DECW$DISPLAY.

This section explains how to override the debugger’s default DECwindows Motif
interface to achieve the following:

¢ Display the debugger’s DECwindows Motif interface on another workstation

¢ Display the debugger’s command interface in a DECterm window along with
any program I/O :

¢ Display the debugger’s command interface and program I/O in separate
DECterm windows

The logical name DBG$DECWS$DISPLAY enables you to override the
default interface of the debugger. In most cases, there is no need to define
DBG$DECWS$DISPLAY because the default is appropriate.

Section 2.7.3.4 provides more information about the logical names
DBG$DECW$DISPLAY and DECW$DISPLAY.

2.7.3.1 Displaying the Debugger’s DECwindows Motif Interface on Another Workstation
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If you are debugging a DECwindows Motif application that uses most of the
screen (or if you are debugging pop-ups in a Motif application), you might find
it useful to run the program on one workstation and display the debugger’s
DECwindows Motif interface on another. To do so:

1. Enter a logical definition with the following syntax in the DECterm window
from which you plan to run the program:

DEFINE/JOB DBG$DECWS$DISPLAY workstation_pathname

The path name for the workstation where the debugger’s DECwindows Motif
interface is to be displayed is workstation_pathname. See the description of

the SET DISPLAY command in the OpenVMS DCL Dictionary for the syntax
of this path name.

It is recommended that you use a job definition. If you use a process
definition, it must not have the CONFINE attribute.
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2. Run the program from that DECterm window. The debugger’s DECwindows
Motif interface is now displayed on the workstation specified by
DBG$DECWS$DISPLAY. The application’s windowing interface is displayed on
the workstation where it is normally displayed.

2.7.3.2 Displaying the Debugger’s Command Interface in a DECterm Window
To display the debugger’s command interface in a DECterm window, along with
any program 1/O:

1. Enter the following definition in the DECterm window from which you plan
to start the debugger:

$ DEFINE/JOB DBG$DECWSDISPLAY " "

You can specify one or more spaces between the quotation marks. It is
recommended that you use a job definition for the logical name. If you use a
process definition, it must not have the CONFINE attribute.

2. Start the debugger from that DECterm window (see Section 2.1). The
debugger’s command interface is displayed in the same window.

For example:

$ DEFINE/JOB DBG$DECW$DISPLAY " ™
$ DEBUG/KEEP

Debugger Banner and Version Number

DBG>

You can now bring your program under debugger control as explained in
Section 2.1.

2.7.3.3 Displaying the Command Interface and Program Input/Output in Separate DECterm
Windows '

This section describes how to display the debugger’s command interface in a
DECterm window other than the DECterm window in which you start the
debugger. This separate window is useful when using the command interface to
debug a screen-oriented program as follows:

e The program’s input/output (I/O) is displayed in the window from which you
start the debugger.

e The debugger’s I/O, including any screen-mode display, is displayed in the
separate window.

The effect is the same as entering the SET MODE SEPARATE command at the
DBG> prompt on a workstation running VWS rather than DECwindows Motif.
(The SET MODE SEPARATE command is not valid when used in a DECterm
window.)

The following example shows how to display the debugger’s command interface in
a separate debugger window titled Debugger.

1. Create the command procedure SEPARATE_WINDOW.COM/shown in
Example 2-1.
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Example 2-1 Command Procedure SEPARATE_WINDOW.COM

$ | Simulates effect of SET MODE SEPARATE from a DECterm window
$!
$ CREATE/TERMINAL/NOPROCESS - }
/WINDOW_ATTRIBUTES=(TITLE="Debugger",-
ICON_NAME="Debugger",ROWS=40)-
/DEFINE LOGICAL=(TABLE=LNM$JOB,DBGSINPUT,DBGSOUTPUT)
$ ALLOCATE DBG$OUTPUT

§ EXIT

$ !

$ | The command CREATE/TERMINAL/NOPROCESS creates a DECterm

$ ! window without a process.

§ !

$ ! The /WINDOW ATTRIBUTES qualifier specifies the window’s

$ ! title (Debugger), icon name (Debugger), and the number

$ ! of rows in the window (40).

st

$ ! The /DEFINE LOGICAL qualifier assigns the logical names

$ | DBGSINPUT and DBGSOUTPUT to the window, so that it becomes
$ ! the debugger input and output device.

$ !

$ ! The command ALLOCATE DBG$OUTPUT causes the separate window
$ ! to remain open when you end the debugging session.

2. Execute the command procedure as follows:

$ @SEPARATE WINDOW
$DCL-I-ALLOC, _MYNODE$TWA8: allocated

A new DECterm window is created with the attributes specified in
SEPARATE_WINDOW.COM.

3. Follow the steps in Section 2.7.3.2 to display the debugger’s command
interface. The interface is displayed in the new window.

4. You can now enter debugger commands in the debugger window. Program I/O
is displayed in the DECterm window from which you started the debugger.

5. When you end the debugging session with the EXIT command, control returns
to the DCL prompt in the program I/O window but the debugger window
remains open.

6. To display the debugger’s command interface in the same window as the
program’s I/O (as in Section 2.7.3.2), enter the following commands:

$ DEASSIGN/JOB DBG$INPUT
$ DEASSIGN/JOB DBG$OUTPUT

The debugger window remains open until you close it explicitly.

2.7.3.4 Explanation of DBGSDECWS$DISPLAY and DECW$DISPLAY
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By default, if your workstation is running DECwindows Motif, the debugger

_ starts up in the DECwindows Motif interface, which is displayed on the

workstation specified by the DECwindows Motif applicationwide logical name
DECW$DISPLAY. DECW$DISPLAY is defined in the job table by FileView or
DECterm and points to the display device for the workstation.

For information about DECW$DISPLAY, see the description of the DCL
commands SET DISPLAY and SHOW DISPLAY in the OpenVMS DCL Dictionary.
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The logical name DBG$DECW$DISPLAY is the debugger-specific equivalent

of DECW$DISPLAY. DBG$DECW$DISPLAY is similar to the debugger-specific
logical names DBG$INPUT and DBG3OUTPUT. These logical names enable you
to reassign SYS$INPUT and SYS$OUTPUT, respectively, to specify the device on
which debugger input and output are to appear.

The default user interface of the debugger results when DBG$DECW$DISPLAY
is undefined or has the same translation as DECW$DISPLAY. By default,
DBG$DECWS$DISPLAY is undefined.

The algorithm that the debugger follows when using the logical definitions of
DECW$DISPLAY and DBG$DECW$DISPLAY is as follows:

1. If the logical name DBG$DECW$DISPLAY is defined, then use it. Otherwise,
use the logical name DECW$DISPLAY.

2. Translate the logical name. If its value is not null (if the string contains
characters other than spaces), the DECwindows Motif interface is displayed
on the specified workstation. If the value is null (if the string consists only of
spaces), the command interface is displayed in the DECterm window.

To enable the OpenVMS debugger to startup in the DECwindows Motif interface,
first enter one of the following DCL commands:

$DEFINE DBGSDECW$DISPLAY "WSNAME::0"
$SET DISPLAY/CREATE/NODE=WSNAME

where WSNAME is the nodename of your workstation.

' 211






3

Using the Debugger

- This chapter explains how to:
* Display the source code of your program (Section 3.1)
¢ Edit your program under debugger control (Section 3.2)
e Execute your program under debugger control (Section 3.3)
e Suspend execution with breakpoints (Section 3.4)
e Examine and manipulate program variables (Section 3.5)
o Access program variables (Section 3.6)
¢ Display and modify values stored in registers (Section 3.7)
¢ Display the decoded instruction stream of your program (Section 3.8)
¢ Debug tasking programs (Section 3.9)
e (Customize the debugger’s DECwindows Motif interface (Sectioﬁ 3.10)

The chapter describes window actions and window menu choices, but you can
perform most common debugger operations by choosing items from context-
sensitive pop-up menus. To access these menus, click MB3 while the mouse
pointer is in the window area.

You can also enter commands at the DECwindows Motif command prompt. For
information about entering debugger commands, see Section 1.3.

For the source code of programs EIGHTQUEENS.EXE and SQUEENS EXE,
shown in the figures of this chapter, see Appendix D.

3.1 Displaying the Source Code of Your Program

The debugger displays the source code of your program in the main window (see
Figure 3-1).

‘Whenever execution is suspended (for example, at a breakpoint), the debugger
updates the source display by displaying the code surrounding the point at which
execution is paused. The current-location pointer, to the left of the source code,
marks which line of code will execute next. (A source line corresponds to one or
more programming-language statements, depending on the language and coding
style.)

By default, the debugger displays compiler-generated line numbers to the left
of the source code. These numbers help you identify breakpoints that are listed
in the breakpoint view (see Section 3.4.4). You can choose not to display line
numbers so that more of the source code can show in the window. To hide or

3-1
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Figure 3—-1 Source Display

eV Bebips - BGHTQUEENS: EIGATGUEENS |1

File Edit Break Commands Options Help
9
10 /* Solve eight-queens problem */ O
11 main()
p0O 12 {
13 int i;
O 14 for (i=0; i <=7; i++)

Call Stack:

display line numbers, choose Display Line Numbers from the File menu on the
main window.

The Call Stack menu, between the source view and the push button view, shows
the name of the routine whose source code is displayed.

The current-location pointer is normally filled in as shown in Figure 3-1. It
is cleared if the displayed code is not that of the routine in which execution is
paused (see Section 3.1.3 and Section 3.6.2).

You can use the scroll bars to show more of the source code. However, you can
scroll vertically through only one module of your program at a time. (A module
corresponds generally to a compilation unit. With many programming languages,
a module corresponds to the contents of a source file. With some languages, such
as Ada, a source file might contain one or more modules.)

The following sections explain how to display source code for other parts of
your program so that you can set breakpoints in various modules, and so on.
Section 3.1.3 explains what to do if the debugger cannot find source code for
display. Section 3.6.2 explains how to display the source code associated with
routines that are currently active on the call stack.

After navigating the main window, you can redisplay the location at which
execution is paused by clicking on the Call Stack menu.

If your program was optimized during compilation, the source code displayed.
might not reflect the actual contents of some program locations (see Section 5.2).

3.1.1 Displaying Source Code of Another Routine
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To display source code of another routine:

1. Choose Browse Sources... from the File menu on the main window (see
Figure 3-2). The Source Browser dialog box displays the name of your
executable image, which is highlighted, and all the shareable images linked
with it (for example, DEBUG and LIBRTL). The name of a linked image is
dimmed if no symbolic information is available for that image.

2. Double click on the name of your executable image. The names of the
modules in that image are displayed (indented) under the image name.

3. Double click on the name of the module containing the routine of interest.
The names of the routines in that module are displayed (indented) under the
module name, and the Display Source button is now highlighted.
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4. Click on the name of the routine whose source code you want to display.

5. Click on the Display Source push button. The debugger displays in the source
view the source code of the target routine, along with an empty breakpoint
button to the left of the source code. If instruction view is open, this display

is updated to show machine code of the target routine.

Section 3.6.2 describes an alternative way to display routine source code for

routines currently active on the call stack.

Figure 3-2 Displaying Source Code of Another Routine

oV e e =1

File | Edit Break Commands Options : Help
Run Image... 1;
Run Foreign Command... |t <=14; i++)
Rerun Same... 1i

olved eight-queens problem!
main */

Browse Sources...

'Debug: SOURCE BROWSER | I

Image/Module/Routine

H Display Line Numbers

Exit Debugger 8QUEENS

8QUEENS
main
8QUEENS_SUB
print
removequeen

setaueen
P i :

. | o —————————— |5

DBG> step
stepped to 8QUEENS\main\3LINE 14
DBG>

Ok — B0

File Edit Break Commands Options

8 . int x[81]1; : i
9 1
10 | void trycol( j )

011 int j;
12 {
13 int m;
14 int safe;

Call Stack:

DBG> step
stepped to 8QUEENS\main\2LINE 14
DBG>
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3.1.2 Displaying Source Code of Another Module

To display source code of another module:

1. Choose Browse Sources... from the File menu on the main window. The
Source Browser dialog box displays the name of your executable image, which
is highlighted, and all the shareable images linked with it (for example,
DEBUG and LIBRTL). The names of the shareable images are dimmed if no
symbolic information is available for them.

2. Double click on the name of your executable image. The names of the
modules in that image are displayed (indented) under the image name.

3. Click on the name of the module whose source code you want to display. The
Display Source button is now highlighted.

4. Click on Display Source. The source display in the main window now shows
the routine’s source code. (If the instruction display in the instruction view is
open, this display is updated to show the routine’s instruction code.)

3.1.3 Making Source Code Available for Display

In certain cases, the debugger cannot display source code. Possible causes are:

e Ezxecution might be paused within a module of your program that was
compiled or linked without the debug option (see Section 5.2).

e Execution might be paused within a system or library routine for which
no symbolic information is intended to be available. In such cases you can
quickly return execution to the calling routine by clicking one or more times
on the S/ret button in the push button view (see Section 3.3.5).

® The source file might have been moved to a different directory after it was
compiled. Section 3.1.4 explains how to tell the debugger where to look for
source files.

If the debugger cannot find source code for display, it tries to display the source
code for the next routine down on the call stack for which source code is available.
If the debugger can display source code for such a routine, the current-location
pointer is cleared and marks the source line to which execution returns in the
calling routine.

3.1.4 Specifying the Location of Source Files

Information about the characteristics and the location of source files is embedded
in the debug symbol table of your program. If a source file has been moved to a
different directory since compile time, the debugger might not find the file. To
direct the debugger to your source files, use the SET SOURCE command at the
DBG> prompt (see Section 10.2).

3.2 Editing Your Program
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The debugger provides a simple text editor you can use to edit your source files
while debugging your program (see Figure 3-3).

The text editor available through the debugger’s DECwindows Motif menu
interface is a simple convenience feature, not intended to replace sophisticated
text editors such as the Language-Sensitive Editor (LSE). You cannot substitute
a more sophisticated editor for the text editor invoked with the Edit File item in
the Commands menu. To use a different editor, enter the Edit command at the
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DBG> prompt in the command view (see the description of the EDIT command in
Part III of this manual).

Figure 3-3 Editor Window

Editor OpenvMS Debug64

File Edit Help

MYDISK:[MYDIRECTORY]S8QUEENS_SUB.C;1 =3 I

int x[8];

void trycol{ j)
int j;

int m;

int safe;
m=-1;

while (Im++ < 7)

Find | l E [ Replace with | |
| Read 966 bytes from MYDISK:[MYDIRECTORY]SQUEENS_SUB.C;1 | I

To invoke the editor, choose the Edit File item in the Commands menu on the
main window. By default, the editor opens a buffer and displays the module
currently displayed in the source view. The buffer is named with the file
specification of the file in the buffer. If no file is displayed in the source view, the
editor displays an empty text buffer, called main_buffer. The buffer name appears
in the buffer menu, which is just under the menu bar of the editor view.

The editor allows you to create any number of text buffers by choosing New (for
empty text buffers) or Open (for existing files) from the File menu. The name of
each text buffer appears in the buffer menu. You can cut, copy, and paste text
from buffer to buffer by choosing items from the Edit menu and selecting buffers
from the buffer menu.

You can perform forward and backward search and replace operations by entering
strings in the Find and Replace with fields and clicking on a directional arrow.
You can perform a repeated search for the string by continuing to press the
Return key. You can also continue a search by choosing the Find/Replace Next or
Find/Replace Previous items in the Edit menu.

To save the file, choose the Save or Save As... items from the File menu. If you do
not save your corrections before closing a modified buffer or exiting the debugger,
the debugger displays a warning message.

To test any changes to the source code:

1. Select a DECterm window separate from that in which the debugger is
running.

2. Recompile the program.
Relink the program.
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4. Return to the debugging session.

5. Choose the Run Image... item in the File menu on the main window.

3.3 Executing Your Program
This section explains how to: -
e Determine where execution is currently paused within your program
e Start or resume program execution
e Execute the program one source line at a time, step by step
For information about rerunning your program or running another program from
the current debugging session, see Section 2.3 and Section 2.4.
3.3.1 Determining Where Execution Is Currently Paused

To determine where execution is currently paused within your program;

1. If the current-location pointer is not visible in the main window, click on the
Call Stack menu of that window to display the pointer (see Figure 3-1).

2. Look at the current-location pointer:

e If the pointer is filled in, it marks the source line whose code will execute
next (see Section 3.1). The Call Stack menu always shows the routine at
scope level 0 (where execution is paused) when the pointer is filled in.

e If the pointer is cleared, the source code displayed is that of a calling
routine, and the pointer marks the source line to which execution returns
in that routine:

~ If the Call Stack menu shows level 0, source code is not available for
display for the routine in which execution is paused (see Section 3.1.3).

— If the Call Stack menu shows a level other than 0, you are displaying
the source code for a calling routine (see Section 3.6.2).

To list the sequence of routine calls that are currently active on the call stack,
click on the Call Stack menu. Level 0 denotes the routine in which execution is
paused, level 1 denotes the calling routine, and so on.

3.3.2 Starting or Resuming Program Execution ‘/

To start program execution or resume execution from the current location, click
on the Go button in the push button view (see Figure 1-3).

Letting your program run freely without debugger intervention is useful in
situations such as the following:

e To test for an infinite loop. In this case, you start execution; then, if your
program does not terminate and you suspect that it is looping, click on the
Stop button. The main window will show where you interrupted program
execution, and the Call Stack menu will identify the sequence of routine calls
at that point (see Section 3.3.1).

e To execute your program directly to a particular location. In this case,
you first set a breakpoint at the location (see Section 3.4) and then start
execution.
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Once started, program execution continues until one of the following events
occurs:

e The program completes execution.

J A‘breakpoint is reached (including a conditional breakpoint whose condition
is true).

e A watchpoint is triggered.
* An exception is signaled.
* You click on the Stop button on the push button view.

Whenever the debugger suspends execution of the program, the main window
display is updated and the current-location pointer marks which line of code will
execute next.

3.3.3 Executing Your Program One Source Line at a Time

To execute one source line of your program, click on the STEP button in the push
button view or enter the STEP command in the command view. This debugging
technique (called stepping) is one of the most commonly used.

After the line executes, the source view is updated and the current-location
pointer marks which line of code will execute next.

Note the following points about source lines and the stepping behavior:

e A source line can consist of one or more programming language elements
depending on the language and coding style used.

e  When you click on the STEP button, the debugger executes one executable
line and suspends execution at the start of the next executable line, skipping
over any intervening nonexecutable lines.

e Executable lines are those for which instructions were generated by the
compiler (for example, lines with routine call or assignment statements).
Executable lines have a button to their left in the main window.

e Examples of nonexecutable lines are comment lines or lines with variable
declarations without value assignments. Nonexecutable lines do not have a
button to their left in the main window.

Keep in mind that if you optimized your code at compilation time, the source code
displayed might not reflect the code that is actually executing (see Section 5.2).

3.3.4 Stepping into a Called Routine

When program execution is paused at a routine call statement, clicking on the
STEP button typically executes the called routine in one step (depending on
the coding style used), and the debugger suspends execution at the next source
line in the calling routine (assuming no breakpoint was set within the called
routine). This enables you to step through the code quickly without having to
trace execution through any called routines (some of which might be system or
library routines). This is called stepping over called routines.

To step into a called routine so that you can execute it one line at a time:

1. Suspend execution at the routine call statement, for example, by setting a
breakpoint (see Section 3.4) and then clicking on the Go button in the push
button view.
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2. When execution is paused at the call statement, click on the S/in button
in the push button view, or enter the STEP/INTO command at the DBG>
prompt. This moves execution just past the start of the called routine.

Once execution is within the called routine, click on the STEP button to execute
the routine line by line.

Clicking on the S/in button when execution is not paused at a routine call
statement is the same as clicking on the STEP button.

3.3.5 Returning from a Called Routine

When execution is suspended within a called routine, you can execute your
program directly to the end of that routine by clicking on the S/ret button in the
push button view, or enter the STEP/RETURN command at the DBG> prompt.

The debugger suspends execution just before the routine’s return instruction
executes. At that point, the routine’s call frame has not been deleted from the call
stack, so you can still get the values of variables local to that routine, and so on.

You can also use the S/call button in the push button view (or enter the STEP
/CALL command at the DBG> prompt) to execute the program directly to the
next Return or Call instruction.

The S/ret button is particularly useful if you have inadvertently stepped into a
system or library routine (see Section 3.1.3). '

3.4 Suspending Execution by Setting Breakpoints

A breakpoint is a location in your program at which you want execution to stop so
that you can check the current value of a variable, step into a routine, and so on.

When using the debugger’s DECwindows Motif interface, you can set breakpoints
on:

e Specific source lines

e Specific routines (functions, subprograms, and so on)

¢ Exceptions signaled during the execution of your program
The debugger provides two ways to qualify breakpoints:

* You can set a conditional breakpoint. It triggers only when a specified
relational expression is evaluated as true.

* You can set an action breakpoint. It executes one or more specified
system-specific commands when the breakpoint triggers.

You can set a breakpoint that is both a conditional and action breakpoint.

The following sections explain these breakpoint options.

3.4.1 Setting Breakpoints on Source Lines

You can set a breakpoint on any source line that has a button to its left in
the source display. These are the lines for which the compiler has generated
executable code (routine declarations, assignment statements, and so on).

To set a breakpoint on a source line:

1. Find the source line on which you want to set a breakpoint (see Section 3.1).
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2. Click on the button to the left of that line. (The breakpoint is set when the
button is filled in.) The breakpoint is set at the start of the source line—that
is, on the first machine-code instruction associated with that line.

Figure 3—4 shows that a breakpoint has been set on the start of line 37.

Figure 3—4 Setting a Breakpoint on a Source Line

~| OpenvMS Debug64 — EIGHTQUEENS: EIGHT_QUEENS

File Edit Break Commands Options Help

p0O 32 if (safe) i
O 33 {
[ 34 setqueen(m, j);
O 35 x[3] = m + 1; []
0 36 if (3 < 7)
[ 37 trycol{(j + 1});
O 38 else
V]

Call Stack: }0 : trycol =3

DBG> examine j
§| EIGHTQUEENS\trycol\j: 4

DBG> SET BREAK EIGHTQUEENS\SLINE 37
DBG>

3.4.2 Setting Breakpoints on Routines with Source Browser

Setting a breakpoint on a routine enables you to move execution directly to the
routine and inspect the local environment.

To set a breakpoint on a routine:

1. Choose Browse Sources... from the File menu on the main window (see
Figure 3-2). The Source Browser dialog box displays the name of your
executable image, which is highlighted, and all the shareable images linked
with it (for example, DEBUG and LIBRTL). The name of a linked image is
dimmed if no symbolic information is available for that image.

2. Double click on the name of the executable image. The names of the modules
in that image are displayed (indented) under the image name.

3. Double click on the name of the target module. The names of the routines
in that module are displayed (indented) under the module name (see
Figure 3-5).

4. Double click on the name of the routine on which to set a breakpoint. The
debugger echoes the results of your SET BREAKPOINT command on the
command line in the command view.

Alternatively, click once on the name of the routine, then click the Set

Breakpoint button in the Source Browser view. The debugger echoes the
results of your SET BREAKPOINT command on the command line in the

command view.

3-9



Using the Debugger
3.4 Suspending Execution by Setting Breakpoints

Figure 3-5 Setting a Breakpoint on a Routine

Ellelgdit Break Commands Options

|

Help

Run Image... -
’

Run Foreigh Command... i <=14; i++)

N Display Line Numbers

1;
Rerun Same...
olved eight-queens problem!
i *
Browse Sources... main */

Debug: SOURCE BROWSER

image/Module/Routine

DBG> step
stepped to 8QUEENS\main\SLINE 14
DBG>

EXit Debugger )
= 39 Cal QTsouEEns
_— 8QUEENS
m STEP S/call |E/ azfl sQUEENS_sup
———————— print

removequeen

setqueen
"m‘..&_ﬂv

[ | 2 I . = 1

[Display Source| [set Breakpoint| [cancel| | Help |

(T 0 0 i 2 B 0 O

DBG> step
stepped to S8QUEENS\main\3LINE 14

DBG> SET BREAK 2NAME"8QUEENS_SUB"\trycol
DBG>

3.4.3 Setting an Exception Breakpoint

An exception breakpoint suspends execution when an exception is signaled and
before any exception handler declared by your program executes. This enables
you to step into the exception handler (if one is available) to check the flow of

control.

To set an exception breakpoint, choose On Exception from the Break menu on the
main window or the optional views window. The exception breakpoint triggers

whenever any exception is signaled.

3.4.4 Identifying the Currently Set Breakpoints

There are three ways to determine which breakpoints are currently set:
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e Scroll through your source code and note the lines whose breakpoint button is
filled in. This method can be time consuming and also does not show which
breakpoints were set and then deactivated (see Section 3.4.5).

® Choose the Views... item from the Options menu on the main window or
the optional views window. 'When the Views dialog box appears, click on
breakpoint view to display the breakpoint view (see Figure 1-4).

The breakpoint view lists a module name and line number for each breakpoint
(see Section 3.1). A filled-in button next to the breakpoint identification
indicates that the breakpoint is activated. A cleared button indicates that the

breakpoint is deactivated.
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¢ Enter the SHOW BREAK command at the DBG> prompt in the command
view. The debugger list all the breakpoints that are currently set, including
trigger conditions for conditional breakpoints, and commands to be executed
by action breakpoints.

3.4.5 Deactivating, Activating, and Canceling Breakpoints
After a breakpoint is set, you can deactivate, activate, or delete it.

Deactivating a breakpoint causes the debugger to ignore the breakpoint during
program execution. However, the debugger keeps the breakpoint listed in the
breakpoint view so that you can activate it at a later time, for example, when you
rerun the program (see Section 2.3). Note the following points:

¢ To deactivate a specific breakpoint, clear the button for that breakpoint in the
main window or in the breakpoint view.

In the breakpoint view, you can also choose Toggle from the Break menu, if
the breakpoint is currently activated.

® To deactivate all breakpoints, choose Deactivate All from the Break menu.
Activating a breakpoint causes it to take effect during program execution:

¢ To activate a breakpoint, fill in the button for that breakpoint in the main
window or in the breakpoint view.

In the breakpoint view, you can also choose Toggle from the Break menu, if
the breakpoint is currently deactivated.

® To activate all breakpoints, choose Activate All from the Break menu.

When you cancel a breakpoint, it is no longer listed in the breakpoint view so
that later you cannot activate it from that list. You have to reset the breakpoint
as explained in Section 3.4.1 and Section 3.4.2. Note the following points:

¢ To cancel a specific breakpoint, choose Cancel from the Break menu on the
optional views window.

e To cancel all breakpoints, choose Cancel All from the Break menu.

3.4.6 Setting a Conditional Breakpoint

A conditional breakpoint suspends execution only when a specified expression
is evaluated as true. For example, you can specify that a breakpoint take effect
when the value of a variable in your program is 4. The breakpoint is ignored if
the value is other than 4.

The debugger evaluates the conditional expression when the breakpoint triggers
during execution of your program.

The following procedure sets a conditional breakpoint, whether or not a
breakpoint was previously set at that location:

1. Display the source line on which you want to set the conditional breakpoint
(see Section 3.1).

2. Do one of the following:

¢ Press Ctr/MB1 on the button to the left of the source line. This displays
the Set/Modify Breakpoint dialog box, showing the source line you selected
in the Location: field (see Figure 3-6).
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3.

¢  Choose the Set or Set/Modify item from the Break menu. When the
Set/Modify Breakpoint dialog box displays, enter the source line in the
Location field. ‘

Enter a relational expression in the Condition: field of the dialog box. The
expression must be valid in the source language. For example, a[3] ==0isa
valid relational expression in the C language.

Click on OK. The conditional breakpoint is now set. The debugger indicates
that a breakpoint is conditional by changing the shape of the breakpoint’s
button from a square to a diamond.

Figure 3-6 Setting a Conditional Breakpoint

File Edit Break Commands Options

44

48 | {

45 | void setqueen(m, j)

int m;

int

al[m]
bm

i

= 0; Debug: Set/Modify Breakpoint
+ 3] = 0;

Location: | gJGHTQUEENS\%LINE 49

DBG>

stepped to EIGHTQUEENS\tryco [ Activate/Deactivate Breakpoint

DBG> step .

stepped to EIGHTQUEENS\tryco

Db eten L ok | |[apply|| [pelete Breakpoint] |cancel| [ Help |

stepped to EIGHTQUEENS\tryco
DBG> SET BREAK EIGHTQUEENS\SLINE 49 WHEN (a[m] =

Condition: | gm] ==
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The following procedure modifies a conditional breakpoint; that is, it can be

used to change the location or condition associated with an existing conditional
breakpoint, or to change an unqualified breakpoint into a conditional breakpoint:

1.

Choose the Views... item from the Options menu on the main window
or optional views window. When the Views dialog box appears, click on
breakpoint view to display the breakpoint view. '

From the breakpoint view, do one of the following:
¢ Press Ctrl/MBI1 on the button to the left of the listed breakpoint.

e Click on a breakpoint listed in the view, and choose the Set/Modify item
from the Break menu.

Follow steps 3 and 4 of the previous procedure, as appropriate.
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3.4.7 Setting an Action Breakpoint

When an action breakpoint triggers, the debugger suspends execution and then
executes a specified list of commands.

To set an action breakpoint, whether or not a breakpoint was previously set at
that location: ’

1. Display the source line on which you want to set the action breakpoint (see
Section 3.1).

2. Do one of the following:

e Press Ctrl/MB1 on the button to the left of the source line. This displays
the Set/Modify Breakpoint dialog box, showing the source line you selected
in the Location: field (see Figure 3-6).

¢  Choose the Set or Set/Modify item from the Break menu. When the
Set/Modify Breakpoint dialog box displays, enter the source line in the
Location: field.

3. Enter one or more debugger commands in the Action: field of the dialog box.
For example: DEPOSIT x[j] = 3; STEP; EXAMINE a

4. Click on OK. The action breakpoint is now set (see Figure 3-7.)

Figure 3-7 Setting an Action Breakpoint

OpenVMS Debug64 ~ EIGHTQUEENS:

File Edit Break Commands Options Help

@ 46 int m;
47 int j;
48 {

O 49 a[m] = 0; - -
[l 50 blm + 31 = 0; Debug: Set/Modify Breakpoint
O 51 clm = 3§ + 7] = 0;

@ 52 } /* End setqueen */ Location:

IEIGHTQUEENS\%LINE 52

Condition: | ;¢ 2

L

o loe bbbl

DBG> go

break at routine EIGHTQUEENS\main
DBG> SET BREAK EIGHTQUEENS\setqueen
DBG> go

break at routine EIGHTQUEENS\setqueen
DBG> ISl'i'].‘ BREAK EIGHTQUEENS\SLINE 52 WHEN {(m < 2) DO {ex b; ex c¢)
DBG>

Action: ex b; exd

O Activate/Deactivate Breakpoint

|Delete Breakpointl |Cance|| | Help |

Lok |

[Apply |

The following procedure modifies an action breakpoint; that is, it can be used to
change the location or command associated with an existing action breakpoint, or
to change an unqualified breakpoint into an action breakpoint:
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Choose the Views... item from the Options menu on the main window or
optional views window, then click on Breakpoints when the Views dialog box
appears.

From the breakpoint view, do one of the following:
e Press Ctrl/MB1 on the button to the left of the listed breakpoint.

¢ Click on a breakpoint listed in the view, and choose the Set/Modify item
in the Break menu.

Follow steps 3 and 4 of the previous procedure, as appropriate.

3.5 Examining and Manipulating Variables

This section explains how to:

Select variable names from windows
Display the value of a variable
Monitor a variable

Watch a variable

Change the value of a variable

See Section 3.6, which also applies to all operations on variables.

3.5.1 Selecting Variable Names from Windows

Use the following techniques to select variable names from windows for the
operations described in the sections that follow (see Section 3.5.2 for examples).
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When selecting names, follow the syntax of the source programming language:

To specify a scalar (nonaggregate) variable, such as an integer, real, Boolean,
or enumeration type, select the variable’s name.

To specify an entire aggregate, such as array or structure (record), select the
variable’s name.

To specify a single element of an aggregate variable, select the entity using
the language syntax. For example:

— The string arr2[7] specifies element 7 of array arr2 in the C language.

— The string employee.address specifies component address of record
(structure) employee in the Pascal language.

To specify the object designated by a pointer variable, select the entity
following the language syntax. For example, in the C language, the string
*int point specifies the object designated by pointer int_point.

Select character strings from windows as follows:

In any window, to select a string delimited by blank spaces, use the standard
DECwindows Motif word selection technique: position the pointer on that
string and then double click MB1.

In any window, to select an arbitrary character string, use the standard
DECwindows Motif text-selection technique: position the pointer on the first
character, press and hold MB1 while dragging the pointer over the string and
then release MB1. '
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® In the debugger source display, you also have the option of using language-
sensitive text selection. To select a string delimited by language-dependent
identifier boundaries, position the pointer on that string and press
Ctrl/MB1.

For example, suppose the source display contains the character string
arr2[m], then:

— To select arr2, position the pointer on arr2 and press Ctrl/MB1.

— To select m, position the pointer on m and press Ctrl/MB1.
You can change the key sequence for language-sensitive text selection as
explained in Section 3.10.4.2.
3.5.2 Displaying the Current Value of a Variable
To display the current value of a variable:
1. Find and select the variable name in a window as explained in Section 3.5.1.

2. Click on the EX button in the push button view. The debugger displays the
variable and its current value in the command view. The debugger displays
the value of a variable in the current scope, which might not be the same as
the source location you were intending.

Figure 3-8, Figure 3-9, and Figure 3-10 show how to display the value of an
integer variable, array aggregate, and array element, respectively.

Figure 3-8 Displaying the Value of an Integer Variable

File Edit Break Commands Options

O 29 while (m++ < 7)

O 30 {

O 31 safe = {a[m] ==1) && (blm + j] ==
b E 32 if (safe)

O 33 {

34 setqueen{m, j);

[ 35 <[l =m + 1;

Wi

Call Stack: |o : trycol &3 |

break at EIGHTQUEENS\trycol\trycol_ 1\%LINE 32
DBG> examine j

EIGHTQUEENS\trycol\j: 4

DBG>

To display the current value in a different type or radix, use the following
alternative method:

1. Find and select the variable name in a window as explained in Section 3.5.1.
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Figure 3-9 Displaying the Value of an Array Aggregate

0
—| - OpenvMS Debug64 — EIGHTQUEENS: EIGHTQUEENS .

File Edit Break Commands Options Help
a 29 while (m++ < 7) [
O 30 { ’

O 31 safe = (B[m] ==1) && (b[m + j] ==

> 32 if (safe) 1
O 33 {

O 34 setqueen{m, j);
O 35 x[3] = m + 1;

Call Stack:
osofoo el Joalio]

DBG> EXAMINE a -
EIGHTQUEENS\a[0:7]

[1]:
[2]:
[3]:
[4]1:
[5]:
[6]:
[7]:

DBG>

[ 1)

ORPORORC

3 | —

Figure 3-10 Displaying the Value of an Array Element

OpenVMS Debug64 — EIGHTQUEENS: EIGHTQUEENS

File Edit Break Commands Options " Help

A

0 29 while (m++ < 7)

O 30 {

31 safe = ([JENl ==1) && (b[m + j] ==
p-m 32 if (safe) n

O 33 { :

O 34 setqueen{m, j);

0O 35 x[§j] = m + 1;

v

Call Stack: |0 : trycol =3

[7]: 0
DBG> examine a[m]
EIGHTQUEENS\a[0]: 0
DBG>

2. Choose the Examine... item in the Commands menu in the main window. The
Examine dialog box appears with the name selected in the

Variable/Expression field.

3. Choose the default, int, long, quad, short, or char* item from the Typecast

menu within the dialog box.
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4. Choose the default, hex, octal, decimal, or binary item from the Output Radix
menu within the dialog box.

5. Click on OK.

The value, altered to your specification, appears in the command view.

Figure 3-11 shows that the variable,j has been typecast as long.

Figure 3-11 Typecasting the Value of a Variable

2" Debug: EXAMINE - -

Variable/Expression |j

Output Radix | default =

I OK | I Apply | |Cancel| | Help ]

3.5.3 Changing the Current Value of a Variable

To change the current value of a variable:

¢ Find and select the variable name in a window as explained in Section 3.5.1.

¢ Choose the Deposit... item from the Commands menu in the main window.
The Deposit dialog box appears with the name selected in the Variable field.

¢ Enter the new value in the Value field.

e Choose the default, hex, octal, decimal, or binary item from the Input Radix

menu within the dialog box.

e (Click on OK.

The new value, altered to your specification, appears in the command view and is

assigned to the variable.

Figure 3-12 shows a new value for the variable safe.

. Figure 3-12 Changing the Value of a Variable

' :Debug: DEPOSIT

Variable Value
safe | = |—1
Input Radix
| ok | |lapply] [cancel| | Heip |
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3.5.4 Monitoring a Variable

When you monitor a variable, the debugger displays the value in the monitor
view and checks and updates the displayed value whenever the debugger regains
control from your program (for example, after a step or at a breakpoint).

Note

You can monitor only a variable, including an aggregate such as an array
or structure (record). You cannot monitor a composite expression or
memory address.

To monitor a variable (see Figure 3—-13):
1. Find and select the variable name in a window as explained in Section 3.5.1.
2. Click on the MON button in the push button view. The debugger:

e Displays the monitor view (if it is not displayed)

¢ Puts the selected variable’s name, along with its qualifying path name, in
the Monitor Expression column

e Puts the value of the variable in the Value/Deposit column
¢ Puts a cleared button in the Watched column (see Section 3.5.5).

You can typecast the output value when monitoring variables by choosing the
Typecast item in the Monitor menu.

You can change the output radix when monitoring variables as follows:

¢  Choose the Charige Radix item in the Monitor menu to change the output
radix for a selected monitored element.

® Choose the Change All Radix in the Monitor menu to change the output radix
for all subsquently monitored elements.

To remove a monitored element from the monitor view, choose the Remove item
from the Monitor menu.

3.5.4.1 Monitoring an Aggregate (Array or Structure) Variable

If you select the name of an aggregate variable, such as an array or structure
(record) and click on the MON button, the debugger displays the word Aggregate
in the Value/Deposit column of the Monitor View. To display the values of all
elements (components) of an aggregate variable, double click on the variable
name in the Monitor Expression column (or choose the Expand item in the
Monitor menu). The displayed element names are indented relative to the parent
name (see Figure 3-14). If an element is also an aggregate, you can double click
on its name to display its elements, and so on.
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Figure 3-13 Monitoring a Variable

OpenvVMS Debug64 — EIGHTQUEENS:

File Edit Break Commands Options Help

25 {
26 int m;
27 int B,
L 28 m= -1;

O 29 while (m++ < 7)

30 {

O 31 safe = {a[m] ==1) && (b[m + j] == 1) && {(c[m - j -

OpenvVMS Debug64 — EIGHTQUEENS:

File Break Monitor Register Tasks Options

Monitor View
watched Monitor Expression
O EIGHTQUEENS\trycol\safe
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Monitor View
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To collapse an expanded display so that only the aggregate parent name is shown
in the monitor view, double click on the name in the Monitor Expression column
(or choose the Collapse item from the Monitor menu).

If you have selected a component of an aggregate variable, and the component
expression is itself a variable, the debugger monitors the component that

was active when you made the selection. For example, if you select the array
component arr[i] and the current value of i is 9, the debugger monitors arr[9]
even if the value of i subsequently changes to 10.
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3.5.4.2 Monitoring a Pointer (Access) Variable
If you select the name of a pointer (access) variable and click on the MON button,
the debugger displays the address of the referenced object in the
Value/Deposit column of the monitor view (see the top entry in Figure 3—15).

To monitor the value of the referenced object (to dereference the pointer variable),
double click on the pointer name in the Monitor Expression column. This adds
an entry for the referenced object in the monitor view, indented under the pointer
entry (see the bottom entry in Figure 3—-15). If a referenced object is an aggregate,
you can double click on its name tc display its elements, and so on.

Figure 3-15 Pointer Variable and Referenced Object in Monitor View

Monitor View

watched Monitor Expression Value/Deposit

EB STR POINTstreatss 2147376705
g *STR_POINT\strcat\s

3.5.5 Watching a Variable

Whenever the program changes the value of a watched variable, the debugger
suspends execution and displays the old and new values in the command view.

To watch a variable (also known as setting a watchpoint on a variable):

* Monitor the variable as explained in Section 3.5.4. The debugger puts a
button in the Watched column of the monitor view whenever you monitor a
variable. See Figure 3-16.

¢ Click on the button in the Watched column. A filled-in button indicates that
the watchpoint is set.

Figure 3-16 Watched Variable in Monitor View

Monitor View

Watched Monitor Expression Value/Deposit

® " EIGHTQUEENS\trycol\safe |1 =]
) |
M|

To deactivate a watchpoint, clear its Watched button in the monitor view (by
clicking on the button) or choose the Toggle Watchpoint item in the Monitor
menu. To activate a watchpoint, fill in its Watched button or choose the Toggle
Watchpoint item in the Monitor menu.
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Section 3.6.1 explains static and nonstatic (automatic) variables and how to
access them. The debugger deactivates a nonstatic watchpoint when execution
moves out of (returns from) the variable’s defining routine. When a nonstatic
variable is no longer active, its entry is dimmed in the monitor view and its
Watched button is cleared.

The debugger does not automatically reactivate nonstatic watchpoints if execution
later returns to the variable’s defining routine. You must reactivate nonstatic
watchpoints explicitly.

3.5.6 Changing the Value of a Monitored Scalar Variable

To change the value of a scalar (nonaggregate) variable, such as an integer or
Boolean type (see Figure 3—-17):

1. Monitor the variable as explained in Section 3.5.4.

2. Click on the variable’s value in the Value/Deposit column of the monitor view.
A small dialog box is displayed over that value, which you can now edit.

Enter the new value in the dialog box.

Click on the check mark (OK) in the dialog box. The dialog box is removed
and replaced by the new value, indicating that the variable now has

that value. The debugger notifies you if you try to enter a value that is
incompatible with the variable’s type, range, and so on.

Figure 3—-17 Changing the Value of a Monitored Scalar Variable

Monitor View

Watched Monitor Expression Value/Deposit

EB ecHrqueensstrycovsafe

To cancel a text entry and dismiss the dialog box, click on X (Cancel).

You can change the value of only one component of an aggregate variable (such
as an array or structure) at a time. To change the value of an aggregate-variable
component (see Figure 3—-18):

1. Display the value of the component as explained in Section 3.5.4.1.

2. Follow the previous procedure for changing the value of a scalar variable.

3.6 Accessing Pi'ogram Variables

This section provides some general information about accessing program variables
while debugging.

If your program was optimized during compilation, you might not have access to
certain variables while debugging. When you compile a program for debugging, it
is best to disable optimization, if possible (see Section 5.2).
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Figure 3-18 Changing the Value of a Component of an Aggregate Variable
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Before you check on the value of a variable, always execute the program beyond
the point where the variable is declared and initialized. The value contained in
any uninitialized variable should be considered invalid.

3.6.1 Accessing Static and Nonstatic (Automatic) Variables
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Note

The generic term nonstatic variable is used here to denote what is
called an automatic variable in some languages.

A static variable is associated with the same memory address throughout
execution of the program. You can always access a static variable.

A nonstatic variable is allocated on the stack or in a register and has a value
only when its defining routine or block is active (on the call stack). Therefore, you
can access a nonstatic variable only when program execution is paused within
the scope of its defining routine or block (which includes any routine called by the
defining routine).

A common technique for accessing a nonstatic variable is first to set a breakpoint
on the defining routine and then to execute the program to the breakpoint.

Whenever the execution of your program makes a nonstatic variable inaccessible,
the debugger notifies you as follows:

¢ If you try to display the value of the variable or monitor the variable (as
explained in Section 3.5.2 and Section 3.5.4, respectively), the debugger issues
a message that the variable is not active or not in scope.

e If the variable (or an expression that includes the variable) is currently being
monitored, its entry becomes dimmed in the monitor view. When the entry
is dimmed, the debugger does not check or update the variable’s displayed
value; also, you cannot change that value as explained in Section 3.5.3. The
entry is fully displayed whenever the variable becomes accessible again.

e If the variable is currently being watched (as explained in Section 3.5.5),
the watchpoint is deactivated (its Watched button is cleared) and its entry
is dimmed in the monitor view. However, note that the watchpoint is not
reactivated automatically when the variable becomes accessible again.
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3.6.2 Setting the Current Scope Relative to the Call Stack

While debugging a routine in your program, you can set the current scope to a
calling routine (a routine down the stack from the routine in which execution is
currently paused). This enables you to:

¢ Determine where the current routine call originated
e Determine the value of a variable declared in a calling routine

e Determine the value of a variable during a particular invocation of a routine
that is called recursively

o Change the vélue of a variable in the context of a routine call

The Call Stack menu on the main window lists the names of the routines (and,
under certain conditions, the images and modules) of your program that are
currently active on the stack, up to the maximum number of lines that can be
displayed on your screen (see Figure 3—19). The numbers on the left side of the
menu indicate the level of each routine on the stack relative to level 0, which
denotes the routine in which execution is paused.

To set the current scope to a particular routine on the stack, choose the routine’s
name from the Call Stack menu (see Figure 3-19). This causes the following to
oceur:

e The Call Stack menu, when released, shows the name and relative level of
‘the routine that is now the current scope.

* The main window shows that routine’s source code.
* The instruction view (if displayed) shows that routine’s decoded instructions.

¢ The register view (if displayed) shows the register values associated with that
routine call.

e If the scope is set to a calling routine (a call-stack level other than 0), the
debugger clears the current-location pointer, as shown in Figure 3-19.

* The debugger sets the scope for symbol searches to the chosen routine, so that
you can examine variables, and so on, in the context of that scope.

When you set the scope to a calling routine, the current-location pointer (which
is cleared) marks the source line to which execution will return in that routine.
Depending on the source language and coding style used, this might be the line
that contains the call statement or some subsequent line.

3.6.3 How the Debugger Searches for Variables and Other Symbols

Symbol ambiguities can occur when a symbol (for example, a variable name X) is
defined in more than one routine or other program unit.

In most cases, the debugger automatically resolves symbol ambiguities. First,

it uses the scope and visibility rules of the currently set language. In addition,
because the debugger permits you to specify symbols in arbitrary modules (to set
breakpoints and so on), the debugger uses the ordering of routine calls on the call
stack to resolve symbol ambiguities.
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Figure 3-19 Current Scope Set to a Calling Routine

Ope De Q
File Edit Break Commands Qptions Help
Al
[ 35 x[J] =m + 1;
0 36 if (3 < 7)
O 37 trycol(j + 1);
0O 38 else .
E 39 print();
40 removequeen{(m, j); 0 : trvcol
0O a -1y
1: trycol J
2 : trycol =
Call Stack: §3 : trycol =
4 : main
.S"“’STEP b/callfe]eadeadfe] ;. LIBSINITIALIZE
break at routine EIGHTQUEENS\main
DBG> go
break at routine EIGHTQUEENS\trycol
DBG> go .
break at routine EIGHTQUEENS\trycol
DBG> go
break at routine EIGHTQUEENS\trycol
DBG> go
break at routine EIGHTQUEENS\trycol
DBG> SET SCOPE/CURRENT 2DEC 3 —
DBG>
\vi
>

In some cases, however, the debugger might respond as follows when you specify

a symbol that is defined multiple times:

e It might issue a "symbol not unique" message because it is not able to
determine the particular declaration of the symbol that you intended.

e It might reference the symbol declaration that is visible in the current scope,

not the one you want.

To resolve such problems, you must specify a scope where the debugger should

search for the particular declaration of the symbol:

o If the different declarations of the symbol are within routines that are
currently active on the call stack, use the Call Stack menu on the main

window to reset the current scope (see Section 3.6.2).

e Otherwise, enter the appropriate command at the command prompt
(EXAMINE or MONITOR, for example), specifying a path-name prefix
with the symbol. For example, if the variable X is defined in two modules
named COUNTER and SWAP, the following command uses the path name
SWAP\ X to specify the declaration of X that is in module SWAP:

DBG> EXAMINE SWAP\X
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3.7 Displaying and Modifying Values Stored in Registers

The register view displays the current contents of all machine registers (see
Figure 3-20).

To display the register view, choose the Views... item from the Options menu on
the main window or the optional views window, then click on Registers when the
Views dialog box appears.

By default the register view automatically displays the register values associated
with the routine in which execution is currently paused. Any values that change
as your program executes are highlighted whenever the debugger regains control
from your program. «

To display the register values associated with any routine on the call stack, choose
its name from the Call Stack menu on the main window (see Section 3.6.2).

To change the value stored in a register:

1. Click on the register value in the register view. A small dialog box is
displayed over the current value, which you can now edit.

2. Enter the new value in the dialog box.

Click on the check mark (OK) in the dialog box. The debugger removes

the dialog box and displays the new value, indicating that the register now
contains that value. To dismiss the dialog box without changing the value in
the register, click on X (Cancel).

To change the radix used to display register values:

® Choose the Change Radix item in the Register menu to change the radix in
current and subsequent output for a selected register.

® Choose the Change All Radix item in the Register menu to change the radix
in current and subsequent output for all registers.

Figure 3-20 Register View
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3.8 Displaying the Decoded Instruction Stream of Your Program

The instruction view displays the decoded instruction stream of your program:
the code that is actually executing (see Figure 3—21). This is useful if the
program you are debugging has been optimized by the compiler so that the
information in the main window does not exactly reflect the code that is executing
(see Section 5.2).

Figure 3-21 Instruction View
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To display the instruction view, choose the Views... item from the Options menu
on the main window or the optional views window, then click on Instructions
when the Views dialog box appears.

By default, the instruction view automatically displays the decoded instruction
stream of the routine in which execution is currently paused. The current-
location pointer, to the left of the instructions, marks the instruction that will
execute next.

By default, the debugger displays source code line numbers to the left of the
instructions with which they are associated. To hide or display line numbers,
toggle Display Line Numbers from the File menu in the instruction view.

By default, the debugger displays memory addresses to the left of the
instructions. To hide or display addresses, toggle Show Instruction Addresses
from the File menu in the instruction view.

After navigating the instruction view, click on the Call Stack menu to redisplay
the location at which execution is paused.

To display the instruction stream of any routine on the call stack, choose the
routine’s name from the Call Stack menu on the main window (see Section 3.6.2).

3.9 Debugging Tasking Programs
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Tasking programs have multiple threads of execution within a process and
include the following:

* Programs in any language that uses DECthreads or POSIX 1003.1b services.

* Programs that use language-specific tasking services (services provided
directly by the language). Currently, Ada is the only language with built-in
tasking services that the debugger supports.
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Within the debugger, the term task denotes such a flow of control, regafdless of
the language or implementation. The debugger’s tasking support applies to all
such programs.

The debugger enables you to display task information and modify task
characteristics to control task execution, priority, state transitions, and so
on.

The following. sections summarize the tasking features of the debugger’s
DECwindows Motif interface. For more information about the debugger’s tasking
support, see Chapter 16.

3.9.1 Displaying Information About Tasks

To display information about one or more tasks of your program, choose the
Views... item from the Options menu on the main window or the optional views
window, then click on Tasking when the Views dialog box appears.

The tasking view gives information about all currently existing (nonterminated)
tasks of your program. The information is updated whenever the debugger
regains control from the program, as shown in Figure 3-22.

Figure 3-22 Tasking View

Tasking View- - )

Task ID  Priority Hold State  Substate Object
D 1 7 smmmnwmml
2 7 I/0 or AST XTASK.FATHER
3 6 XTASK. MOTHER
4 7 Entry call XTASK. FATHER, TY!EST

The displayed information includes:

¢ The task ID. The arrow in the left column marks the active task: the task
that runs when you click on the Go or Step button. '

o The task priority.
e  Whether the task has been put on hold as explained in Section 3.9.2.

e The current state of the task. The task in the RUN (running) state is the
active task.

¢ The current substate of the task. The substate helps indicate the possible
cause of a task’s state.

¢ A debugger path name for the task (thread) object or the address of the task
object if the debugger cannot symbolize the task object.
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3.9.2 Changing Task Characteristics

To modify a task’s characteristics or the tasking environment while debugging,
choose one of the following items from the Tasks menu.

Tasks Menu ltem Description

Abort Request that the selected task be terminated at the next
allowed opportunity. The exact effect depends on the current
event facility (language dependent). For Ada tasks, this is
equivalent to executing an abort statement.

Activate Make the selected task the active task.

Hold Place the selected task on hold.

Nohold Release the selected task from hold.

Make Visible Make the selected task the visible task.

All Esl?i the submenu to abort all tasks or release all tasks from
old.

3.10 Customizing the Debugger’s DECwindows Motif Interface
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The debugger is installed on your system with a default debugger resource
file (DECW$SYSTEM_DEFAULTS:VMSDEBUG.DAT) that defines the startup
defaults for the following customizable parameters:

* Configuration of windows and views

e  Whether to show or hide line numbers in the main window

¢ Button names and associated debugger commands

¢ Key sequence to display the dialog box for conditional and action breakpoints

¢ Key sequence for language-sensitive text selection in the source view and
instruction view

e Character fonts for text in the views
¢ Character font for text displayed in specific windows and views

¢ Color of the text foreground and background colors in the source view,
instruction view, and editor view

¢ Display of program, module, and routine names in the main window title bar

¢  Whether or not the debugger requires confirmation before exiting

A copy of the system default debugger resource file with explanatory comments is

included in Example 3-1.

You can modify the first three of these display attributes interactively from the

DECwindows Motif interface, as explained in Section 3.10.1, Section 3.10.2, and
Section 3.10.3. In each case, you can save the modified display configuration for
future debugging sessions by choosing Save Options from the Options menu.

In addition, you can modify all the listed attributes of the debugger display
configuration by editing and saving the debugger resource file, as explained in
Section 3.10.4.



Using the Debugger
3.10 Customlzmg the Debugger’s DECwindows Motif Interface

When you choose Save Options from the Options menu or you edit and save

the local debugger resource file, the debugger creates a new version of the

local debugger resource file DECW$USER_DEFAULTS:VMSDEBUG.DAT that
contains the definitions of the display configuration attributes. When you next
start the debugger, it uses the attributes defined in the most recent local resource
file to configure the output display. You can fall back to previous debugger display
configurations with appropriate use of the DCL DELETE, RENAME, and COPY
commands.

To fall back to the system default display configuration, select Restore Default
Options from the OpenVMS debugger Options menu.

3.10.1 Defining the Startup Configuration of Debugger Views
To define the startup configuration of the debugger views:

1. While using the debugger, set up your preferred configuration of views.

2. Choose Save Options from the Options menu to creates a new version of the
debugger resource file.

When you next start the debugger, the debugger uses the most recent resource
file to create the new display configuration.

You can also define the startup display configuration by editing the definition of
these views in the resource file (see Section 3.10.4).

3.10.2 Displaying or Hiding Line Numbers in Source View and Instruction View

The source view and instruction views display source line numbers by default at
debugger startup. To hide (or display) line numbers at debugger startup:

1. While using the debugger, choose Display Line Numbers from the File menu
on the main (or instruction) window. Line numbers are displayed when a
filled-in button appears next to that menu item.

2. Choose Save Options from the Options menu to create a new version of the
debugger’s local resource file.

When you next start the debugger, the debugger uses the most recent resource
file to create the new display configuration.

You can also set the startup default for line numbers by setting the following
resources to either True or False in the resource file (see Section 3.10.4).

DebugSource.StartupShowSourceLineno: True
DebugInstruction.StartupShowInstLineno: True

3.10.3 Modifying, Adding, Removing, and Resequencing Push Buttons

The buttons on the push button view are associated with debugger commands.
You can:

¢ (Change a button’s label or associated command
¢ Add a new button
¢ Remove a button

¢ Resequence a button
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Note

You cannot modify or remove the Stop button.

To save these modifications for future debugger sessions, choose Save Options
from the Options menu.

Sections Section 3.10.3.1, Section 3.10.3.2, and Section 3.10.3.3 explain how
to customize push buttons interactively through the DECwindows Motif
interface. You can also customize push buttons by editing the resource file.
Button definitions in the resource file begin with:

DebugControl.Button
(See Example 3-1.)

3.10.3.1 Changing a Button’s Label or Associated Command
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To change a button’s label or associated command:

1. Choose Customize Buttons... from the Options menu on the main window or
the optional views window. The Customize Buttons dialog box is displayed
(see Figure 3-23). ~

2. Within the dialog box, click on the button you are modifying. This fills the

Command and Label fields with the parameters for that button. The example

in Figure 3-23 shows that the Step button was selected.

3. To change the button icon, pull down the Icon menu within the dialog box and
select one of the predefined icons. As Figure 3-23 shows, the Label field dims

and is filled with the debugger’s internal name for the predefined icon. The
icon itself appears in the dialog box’s push button display.

To change the button label, verify that the Icon menu is set to None and enter

a new label in the Label field.

4. To change the command associated with the button, then enter the new
command in the Command field. For online help about the commands, see
Section 1.4.3.

If the command is to operate on a name or language expression selected in
a window, specify $S as the command parameter. For example, the following
command displays the current value of the language expression that is
currently selected:

EVALUATE $%s

If the command is to operate on a debugger built-in symbol or any other name
that has a a percent sign (%) as the first character, specify two percent signs.

For example:
EXAMINE %$NEXTLOC

5. Click on Modify. The button’s label or associated command is changed within
the dialog box push button display.

6. Click on Apply. The button’s label or associated command is changed within
the debugger’s push button view.
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Figure 3-23 Changing the Step-Button Label to an Icon
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To save these modifications for future debugger sessions, choose Save Options
from the Options menu.

3.10.3.2 Adding a New Button and Associated Command

To add a new button to the push button view and assign a debugger command to
that button:

1. Choose Customize Buttons... from the Options menu. The Customize Buttons
dialog box is displayed (see Figure 3-24). :

2. Enter the debugger command for the new button in the Command field (see
Section 3.10.3.1). Figure 3—24 shows that the command RUN CP:X was
~ chosen. This command runs a program called X.EXE.

3. Enter a label for that button in the Label field or choose a predefined icon
from the Icon menu. Figure 3—-24 shows that the Run-X label was chosen.

4. Click on Add. The button is added to the dialog box push button display.
5. Click on Apply. The button is added to the debugger’s push button view.

To save these modifications for future debugger sessions, choose Save Options
from the Options menu. ‘

3.10.3.3 Removing a Button
To remove a button:

1. Choose Customize Buttons... from the Options menu on the main or optional
views window. The Customize Buttons dialog box is displayed.

2. Within the dialog box, click on the button you are removing. This fills the
Command and Label fields with the parameters for that button.

3. Click on Remove. The button is removed from the dialog box push button
display.

4. Click on Apply. The button is removed from the debugger’s push button view.

To save these modifications for future debugger sessions, choose Save Options
from the Options menu. : '
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Figure 3-24 Adding a Button for the EXAMINE/ASCIZ Command
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3.10.3.4 Resequencing a Button

To resequence a button:

1. Choose Customize Buttons... from the Options menu on the main or optional
views window. The Customize Buttons dialog box is displayed.

2. Within the dialog box, click on the button you are resequencing. This fills the
Command and Label fields with the parameters for that button.

3. Click on the left or right arrow to move the button one position to the left or
right. Continue to click until the button has moved, one position at a time, to
its final position.

4. Click on Apply to transfer this position to the debugger’s push button view.

To save these modifications for future debugger sessions, choose Save Options
from the Options menu.

3.10.4 Editing the Debugger Resource File
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The debugger is installed on your system with a default debugger resource

file (DECW$SYSTEM_DEFAULTS:VMSDEBUG.DAT) that defines the default
display configuration for the debugger. When you modify the display attributes as
described in Section 3.10 and then save the modifications with the Save Options
command in the Options menu, the debugger creates a local debugger resource
file, DECW$USER_DEFAULTS:VMSDEBUG.DAT. You can edit this file to further
modify the debugger display configuration.

If you do not have a local debugger resource file, you can create one with
the Restore Default Options item in the Options menu. Whenever you start
the debugger, it creates the debugger display configuration as defined in

the most recent version of the local debugger resource file if there is one,
otherwise, the debugger uses the definitions in the system debugger resource
file, DECW$SYSTEM_DEFAULTS:VMSDEBUG.DAT.

You cannot edit the system resourcé file. You can modify the debugger display
configuration only by following the procedures in Section 3.10.1; Section 3.10.2,
and Section 3.10.3, or by editing and saving your local debugger resource file.
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Example 3-1 contains a copy of the system default debugger resource file. Most
entries are annotated within the file or are self-explanatory. Section 3.10.4.1,
Section 3.10.4.2, Section 3.10.4.3, and Section 3.10.4.4 contain additional
information about modifying certain key sequences. For complete information
about specifying key sequences, see the translation table syntax in the X Toolkit
Intrinsics documentation.

Note

The line in. Example 3-1 that begins with DebugControl.ButtonList
does not completely fit in this example. This line identifies the button
definitions contained in the file. The full line in the file also contains
the following button names: StepReturnButton, StepCallButton,
ExamineButton, ExamineASCIZButton, ExamineASCICButton,
EvalButton, MonitorButton

Example 3-1 System Default Debugger Resource File (DECW$SYSTEM_
DEFAULTS:VMSDEBUG.DAT)

! OpenVMS 64bit Debugger Resource File
1

DebugVersion: 7
]

! GEOMETRY RESOURCES: Automatically created/saved when a user executes
! "SAVE OPTIONS" from the Options menu.

!

DebugSource.x: 11

DebugSource.y: 30

DebugSource.width: 620

DebugSource.height: 700

|

DebugControl.x: 650
DebugControl.y: 30
DebugControl.width: 600
DebugControl.height: 700
1

DebugEditor.x: 650
DebugEditor.y: 30
DebugEditor.width: 600
DebugEditor.height: 700
|

DebugInstruction.x: 11
DebugInstruction.y: 769
DebugInstruction.width: 620
DebugInstruction.height: 243
!

;DebugBrowser.x: 650
*DebugBrowser.y: 30
*DebugBrowser.width: 600

*DebugBrowser .height: 350
!

(continued on next page)

3-33



* Using the Debugger
3.10 Customizing the Debugger’s DECwindows Motif Interface

Example 3-1 (Cont.) System Default Debugger Resource File (DECW$SYSTEM_
DEFAULTS:VMSDEBUG.DAT)

! LINE NUMBER DISPLAY RESOURCES:

! Create the line or address number display in views at startup?
!

DebugSource.StartupShowSourceLineno: True
DebugInstruction.StartupShowInstLineno: True
DebugInstruction.StartupShowInstAddrno: False

1

! WINDOW PANE RESOURCES: Relative size of panes in main window.
! Main window height is derived from sum of panes.

!

DebugSource*SrcView.height: 460
DebugSource*PushbuttonPanel.height: 36
DebugSource*MessageOutputPanel.height: 145

!

DebugControl.BreakpointView.height: 175
DebugControl.MonitorView.height: 150
DebugControl.TaskView.height: 130
DebugControl.RegisterView.height: 250

1

The following resources determine which buttons to put in the button panel.

!

! Buttons will show in the order they are listed here.

! For each button there MUST be a set of associated resources.

! EXAMPLE:

! ButtonCommand - Associates a command with the button.

! ButtonlLegend - Button Label or pixmap name if pixmap flag is True.
! ButtonPixmapFlag - If True uses ButtonLegend as predefined pixmap name.
1

DebugControl.ButtonList: \ GoButton, StepButton, StepInButton, ...
1

DebugControl.ButtonCommand.GoButton: go
DebugControl.ButtonLegend.GoButton: go_pixmap
DebugControl.ButtonPixmapFlag.GoButton: True
X ‘

DebugControl.ButtonCommand.StepButton: step
DebugControl.ButtonLegend.StepButton: STEP
DebugControl.ButtonPixmapFlag.StepButton: False
1

DebugControl.ButtonCommand.StepInButton: step/in
DebugControl.ButtonLegend.StepInButton: S/in
DebugControl.ButtonPixmapFlag.StepInButton: False
!

DebugControl.ButtonCommand.StepReturnButton: step/return
DebugControl.ButtonLegend.StepReturnButton: S/ret
DebugControl.ButtonPixmapFlag.StepReturnButton: False

|

DebugContfol.ButtonCommand.StepCallButton: step/call
DebugControl.ButtonLegend.StepCallButton: S/call
DebugControl.ButtonPixmapFlag.StepCallButton: False
|

DebugControl.ButtonCommand.ExamineButton: examine $%s
DebugControl.ButtonLegend.ExamineButton: EX
DebugControl.ButtonPixmapFlag.ExamineButton: False

|

DebugControl.ButtonCommand.ExamineASCIZButton: examine/asciz %s
DebugControl.Buttonlegend.ExamineASCIZButton: E/az
DebugControl.ButtonPixmapFlag.ExamineASCIZButton: False

!

DebugControl.ButtonCommand.ExamineASCICButton: examine/ascic %s
DebugControl.ButtonLegend.ExamineASCICButton: E/ac

(continued on next page)
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Example 3-1 (Cont.) System Default Debugger Resource File (DECW$SYSTEM_
DEFAULTS:VMSDEBUG.DAT)

DebugControl.ButtonPixmapFlag.ExamineASCICButton: False
!

DebugControl.ButtonCommand.EvalButton: evaluate %s
DebugControl.ButtonLegend.EvalButton: EVAL
DebugControl.ButtonPixmapFlag.EvalButton: False

|

DebugControl.ButtonCommand.MonitorButton: monitor %s
DebugControl.ButtonLegend.MonitorButton: MON
DebugControl ButtonPixmapFlag.MonitorButton: False

THE FOLLOWING RESOURCES CAN ONLY BE CHANGED BY EDITING THIS FILE.

Be sure to trim any trailing white-spaces.

FONT RESOURCES:

If a font is specified for a view, and the font is available on the
system, it will be used for that view.

For any views which do not explicitly specify a font, the font specified
by the resource "DebugDefault.Font" will be used if it is available on the
system.

If no font resources are specified at all, the debugger will use the
systems own default font specification.

The "DebugOptions.Font" applies to all optional views. We suggest that
you select a font with a point size no larger than 14 in the option views
in order to preserve label alignment.

Using 132 column sources? Try this font:
-dec-terminal-medium-r-narrow--14-100-100-100-c-60-is08859-1

Gm tem G sem Gmm Gem s G = Gmm G = G S Sm Gmm Gum G S Sam bw Gem Sum G

FORMAT:  -*-FONTNAM-FACE-T-*--*-PTS~*-*_%_*-CHARSET
|

DebugDefault.Font: ~*-COURIER-BOLD-R-*-=-#*-120-*-*-*-*-1508859-1
DebugSource.Font:  -*-COURIER-BOLD-R-*--*-120-*-*-%-*_-1508859-1
DebugInstruction.Font:  -*-COURIER-BOLD-R-*--*-14(-%-%-%-%*-I1508859-1
DebugMessage.Font: -*-COURIER-BOLD-R-*--%*-120-%-*-*-%-1508859-1
DebugOptions.Font: -*-COURIER-BOLD-R-#--%*-120-%-*-%-*-T508859-1

!

| STARTUP STATE: 3=Iconified, 0=Visible
1

DebugSource.initialState: 0
DebugControl.initialState: 0
DebugEditor.initialState: 0
DebugInstruction.initialState: 0

. ‘

{ COLORS (Use any of the OSF Motif Named Colors)
! Foreground = Text Color, Background = Window Color
1

! Source View Colors

1

DebugSource*src_txt.foreground: blue
DebugSource*src_txt.background: white
DebugSource*src lineno txtw.foreground: red
DebugSource*src llneno txtw.background: white
DebugSource*cnt | _msg_ txt.foreground: black
DebugSource*cnt msg_ _txt.background: white

(continued on next page)
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Example 3-1 (Cont.) System Default Debugger Resource File (DECW$SYSTEM_
DEFAULTS:VMSDEBUG.DAT)

! Instruction View Colors

1

DebugInstruction*inst_txt.foreground: blue
DebugInstructlon*lnst txt.background: white
DebugInstructlon*lnst addrno_txtw.foreground: red
DebugInstructlon*lnst addrno txtw.background: white

' Editor Colors

1

DebugEditor*edit textw.foreground: black
DebugEdltor*edlt textw.background: white

! KEY SEQUENCES:

!

! Key sequence used to activate the dialog box for conditional and action
! breakpoints.

|

DebugSource.ModifyBreakpointToggleSequence: Ctrl <BtnlDown>, Ctrl <BtnlUp>
|

! GENERAL KEYPAD FUNCTIONS:

1

|<Key>0xFFB0=KP0, <Key>0xFF91,<Key>0xFFB0=GOLD-KP0,

1<Key>0xFF94 ,<Key>0xXFFB0=BLUE-KP0, <Key>0xFFB1=KP1,

I<Key>0xFF91,<Key>0xFFB1=GOLD-KP1, <Key>0xFFAC=KP,

DebugSource. *XmText.translations:$override\n\
<Key>0xFFB0: EnterCmdOnCmdLine("step/line") \n\
<Key>0xFFBl: EnterCmdOnCmdLine("examine") \n\
<Key>0xFFAC: EnterCmdOnCmdLine("go") \n\
<Key>0xFF91,<Key>0xFFB0: EnterCmdOnCmdLine("step/into") \n\
<Key>0xFF94,<Key>0xFFB0: EnterCmdOnCmdLine("step/over") \n\
<Key>0xFF91,<Key>0xFFBl: EnterCmdOnCmdLine("examine"") \n\
<Key>0xFFB5: EnterCmdOnCmdLine("show calls") \n\
<Key>0xFF91,<Key>0xFFB5: EnterCmenCmdLlne("show calls 3") \n\
<Key>0xFF8D: activate()\n

]

! IDENTIFIER WORD SELECTION: (language-based delimiters)

! NOTE: DO NOT use any double click combinitation for the following resource

! otherwise normal text selection in the source window will not work.

L

DebugSource.IdentifierSelectionSequence: Ctrl<BtnlDown>

1

! EXIT CONFIRMATION:
!

DebugDisplayExitConfirmDB: True
! v

! COMMAND ECHO:

|

DebugEchoCommands: True
!

TITLE FORMAT: Main window and optional view window.
The following title format directives are supported:
%t - The title of the debugger application.
$p - The name of the user program being debugged.
$f - The name of the current file displayed in the source window.

ebugControl TitleFormat: %t - %p: %f

o= U em s o= s e om e o o

(continued on next page)
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Example 3-1 (Cont.) System Default Debugger Resource File (DECW$SYSTEM_
DEFAULTS:VMSDEBUG.DAT)

! DRAG AND DROP MESSAGE SUPRESSION:
!

*.dragInitiatorProtocolStyle: DRAG_NONE
*.dragReceiverProtocolStyle: DRAG NONE

3.10.4.1 Defining the Key Sequence to Display the Breakpoint Dialog Box

By default, the key sequence for displaying the dialog box for conditional and
action breakpoints is Ctrl/MB1 (see Section 3.4.6 and Section 3.4.7). To define
another key sequence, edit the current definition of the following resource in the
resource file. For example:

DebugSource.ModifyBreakpointToggleSequence:  Ctrl<BtnlDown>(2)

3.10.4.2 Defining the Key Sequence for Language-Sensitive Text Selection

By default, the key sequence for language-sensitive text selection in the main
window and instruction view is Ctrl/MB1 (see Section 3.5.1). To define another
key sequence, edit the current definition of the following resource in the resource
file. For example:

DebugSource.IdentifierSelectionSequence: Ctrl<BtnlDown>

To avoid conflict with standard DECwindows Motif word selection, do not use a
double-click combination, such as Ctrl<Btn1Down>(2).

3.10.4.3 Defining the Font for Displayed Text

To define another font for the text displayed in various debugger windows and
views, edit the current definition of the following resources in the resource file.
For example:

DebugDefault.Font: -*-COURIER-BOLD-R-*--*-120-*-*-%-%-1508859-1

3.10.4.4 Defining the Key Bindings on the Keypad

To bind a different command to a key that is already associated with a commana,
edit the current definition of the following resources in the resource file. For
example:

<Key>0xFFB0: EnterCmdonCmdLine("step/line 3") \n\

To bind a command to a key that is not currently associated with a command,
refer to the Keysym Encoding chapter of the X and Motif Quick Reference Guide
for key designations.

3.11 Debugging Detached Processes

You cannot use the DECwindows Motif interface to the debugger to debug
detached processes, such as print symbionts, which run without a command line
interpreter (CLI).

To debug a detached process that runs without a CLI, use the character-cell
(screen mode) interface to the debugger (see Section 5.3.8.5).
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Using the Heap Analyzer

The Heap Analyzer, available on both OpenVMS Alpha and OpenVMS VAX
systems, is a feature of the debugger that provides a graphical representation of
memory use in real time. By studying this representation, you can identify areas
in your application where memory usage and performance can be improved. For
example, you might notice allocations that are made too often, memory blocks
that are too large, evidence of fragmentation, or memory leaks.

After you locate an area of interest, you can request an enlarged, more detailed,
or altered view. You can also request additional information on the size, contents,
or address of the allocations shown.

After you narrow your interest to an individual allocation, you can request
traceback information. The analyzer allows you to correlate the traceback entry
for an allocation with source code in your application program. By scrolling
through the source code display, you can then identify problematic code and
decide how to correct it.

This chapter describes the following:

e Starting a Heap Analyzer session (Section 4.1)

e  Working with the default display (Section 4.2)

* Adjusting type determination and display (Section 4.3)
o Exiting the Heap Analyzer (Section 4.4)

e Sample session (Section 4.5)

4.1 Starting a Heap Analyzer Session

The following sections describe how to invoke the Heap Analyzer and run your
application.
4.1.1 Invoking the Heap Analyzer

You can invoke the Heap Analyzer during a debugging session in one of the
following ways:

1. In the debugger main window, choose the Run Image or Rerun Same items
from the File menu. When a dialog box appears, select the program you wish
to execute and click the Heap Analyzer toggle button.

2. At the debugger command entry prompt, enter the RUN/HEAP_ANALYZER
or RERUN/HEAP_ANALYZER program-name command.

3. At the DCL prompt ($) in a DECterm window outside the debugger, enter
the following command and then execute your program:

$ DEFINE/USER LIBRTL SYS$LIBRARY:LIBRTL INSTRUMENTED
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(You can invoke the Heap Analyzer outside a debugging session by entering the
DEFINE/USER command detailed above, and then the DCL command RUN
/NODEBUG.)

Note that the Heap Analyzer does not work on programs linked with the
/NODEBUG qualifier on OpenVMS Alpha systems. On OpenVMS VAX systems,
the Heap Analyzer does work on programs linked with the /NODEBUG qualifier,
although the traceback information displayed will be minimal.

After you successfully invoke the Heap Analyzer, the Heap Analyzer startup
screen appears.

4.1.2 Viewing Heap Analyzer Windows
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The Heap Analyzer contains a main window, six subsidiary windows, and a
control panel (see Figure 4-1.)

The Memory Map, the most important window, displays a representation of
your application’s dynamic memory use. At startup, the Memory Map shows the
images that comprise your application. As your application executes, you can

see the relative location and size of individual memory blocks, images, program
regions, memory zones, and dynamic strings as they are allocated and deallocated
in memory space.

The Message window displays information on your Heap Analyzer session. At
startup, the Message window contains the message 'Heap Analyzer initialization
complete. Press Start button to begin program.” As your application executes,
informational and error messages appear in this window.

The Push Button Control Panel contains buttons that allow you to control the
speed of the Memory Map display. At startup, you click on the Start button to
begin executing your application. As your application executes, you can click
on other buttons in the panel to pause, slow, or otherwise affect the continuous
display.

The Information window displays information on Memory Map segments. As

your application executes, you can pause execution at any time to request specific
information.

The Source window displays the application source code associated with a
segment in the Memory Map.

The Do-not-use Type List allows you to adjust the Memory Map display by
redetermining a segment’s type, or group name.

The Views-and-Types Display allows you to adjust the Memory Map display by
selectively viewing certain segment types.

The Type Histogram displays summary and statistical information on segment
types. '
As you use the Heap Analyzer, you may need to increase or decrease the size of

the window in which you are working. To do this, pull the window pane sashes
between windows or resize the screen as a whole.
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Figure 4-1 Heap Analyzer Windows

Heap Analyzer !
File Display Zoom Options p

segments: 1: 00139200

IHeap fnalyzer initialization complete. Press Start button to begin program. Q- ] 1 Pause {1 Slow {1 Sync o
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1. Memory Map Shows the graphical representation of memory, that
is, the part of PO-space that is in use. Each allocation
appears as a colored strip, or segment.

2. Message window Displays Heap Analyzer informational and error
messages and one-line segment descriptions.

3. Information window Shows additional information on segments and
segment types that appear in the Memory Map.

4, Source window Shows application source code.

5. Do-not-use Type List Lists routines not used as segment types, the name

that characterizes segments. :

6. Views-and-Types Display Lists all segment types known to the Heap Analyzer
and allows you to alter the segment display.

7. Push Button Control Panel Provides Start/Step, Pause, Slow, and Sync buttons
that allow you to control the speed of Memory Map
display.

8. Type Histogram Shows statistics on segment size and use.
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4.1.3 Viewing Heap Analyzer Pull-Down Menus

The Heap Analyzer provides five pull-down menus that are grouped over the
Memory Map (see Figure 4-2). This figure is adjusted slightly so that all menu
items can be seen.

Figure 4-2 Heap Analyzer Pull-Down Menus

Heap Analyzer
File| iDisplay Zoom Options Help
Exit] | Text Visible Extraordinarily Close Set Source... On Context
o [ ] Auto Scroll Extremely Close Add to Do-not-use Type List... On Einduw
Reduce Scroll Region Very Close Save Do-not-use Type List On Version
Display All Segments @ Close Restore Do-not-use Type List On Help
Clear Information Window Medium ° °

© o

Very Far

1. File Menu Allows you to exit from the Heap Analyzer.

2. Display Menu  Allows you to adjust the Memory Map display and to clear the
Information window.

3. Zoom Menu Provides a closer or further view of the Memory Map.

4. Options Menu  Allows you to indicate a search directory list or to adjust the Do-not-
use Type List.

5. Help Menu Provides context-sensitive or task-oriented online help.
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4.1.4 Viewing Heap Analyzer Context-Sensitive Menus

Most operations in the Heap Analyzer, however, are accomplished through
context-sensitive pop-up menus. Most Heap Analyzer windows contain a pop-up
menu listing available tasks (see Figure 4-3). To access a window’s pop-up menu,
position your mouse pointer in the window and click MB3.

Figure 4-3 Heap Analyzer Context-Sensitive Pop-Up Menus

File Display Zoom Options

o Traceback of Allocation
Display Segment
Display Contents

Display Address

Display Type
Go to Type

Do Not Use Type

© Y

1. Memory Map Pop-Up

2. Information Window Pop-Up

3. Do-not-use Type List Pop-Up

4, Views-and-Types Display Pop-Up

5. Type Histogram Pop-Up

° Display Type

Go to Type

Do Not Use Type

Display Type Expand |iSave
Go to Type Collapse |} Remove
Do Not Use Type Reset|: Reset Reset

Provides additional information on segments
displayed in the Memory Map, allows you to
jump to a segment’s type in the Views-and-
Types Display, or adds a segment’s type to the
Do-not-Use Type List.

Allows you to jump from a line of traceback
displayed in the Information window to the
related source code in the Source window.

Deletes a segment’s type from the Do-not-Use
Type List.

Left side: Provides additional information on
segment types listed, highlights a segment type
within the Views-and-Types Display, or adds a
segment type to the Do-not-Use Type List.

Right side: Allows you to adjust display
characteristics for the segment type highlighted
in the left side of the Views-and-Types Display.

Provides additional information on segment types
listed, highlights a segment type in the Type
Histogram, or adds the segment type to the
Do-not-Use Type List.
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4.1.5 Setting a Source Directory

If you are invoking the Heap Analyzer from a directory other than the one that
stores your application source code, you can set a source directory for the Heap
Analyzer as soon as the startup screen appears.

To set a source directory:

1. Choose the Set Source... menu item from the Options menu on the Heap
Analyzer screen.

The Set Source dialog box appears.

2. Enter the directory specification for your source directory as you would for the
OpenVMS Debugger SET SOURCE command.

For more information on this command, see the debugger online help.
3. Click on OK.

The Heap Analyzer can now access your application.

4.1.6 Starting Your Application

If you invoked the Heap Analyzer from within a debugging session, start your
application by performing the following steps: ’

1. Click on the Start button in the Push Button Control Panel.

The Message window displays an "application starting" message, and the
Start button label changes to Step. The OpenVMS Debugger main window
pops forward.

2. Click on the Go button in the OpenVMS Debugger’s control panel, and iconize
the OpenVMS Debugger window.

Memory events associated with your application begin showing in the Memory
Map.

(If you invoked the Heap Analyzer outside a debugging session, start your
application by performing only step 1 above.)

After your application is running, the Memory Map (and other parts of the Heap
Analyzer display) are continuously updated to reflect the state of your application.

Unless you intervene (see Section 4.1.7), this updating continues until an
occurrence causes memory events to stop. For example, your application might
prompt for input, the debugger might prompt for input, or your application might
finish execution.

4.1.7 Controlling the Speed of Display

To examine events in the Memory Map as your application is executing, you can
use the Heap Analyzer’s push buttons to slow, pause, and otherwise affect the
speed of the display. Figure 4—4 shows these push buttons on the Heap Analyzer
window just after the Start button was pushed.

The Slow and Pause push buttons allow you to slow or pause the display.
The Step push button allows you to single-step through memory events.

The Sync histogram (not shown) to the right of the Sync button indicates how far
behind your application the Heap Analyzer is running. For performance reasons,
the Heap Analyzer displays memory events a few seconds after their occurrence
in your application. '
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Figure 4-4 Heap Analyzer Control Panel

10050205 0 52050100

application starting

Information window

1. Start Button

2. Step Button
3. Pause Button

4, Slow Button
. Sync Button

[

f:;mp {0 Pause {1 Slow {1 Sync

Source window || Do-not-use Type L|f views : exp B

LIBRTL) LIBSVMV* Blocks
LIBRTL LTBsmALLOC]|  Tmages

Regions
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Click to start executing your application and enable the Memory Map
display. Once you do so, the Start button changes to a Step button,
which is initially dimmed (inaccessible).

Click to single-step through memory events in the Memory Map
display. This button is dimmed until you click on the Pause button.

Click to stop (or restart) execution of your application and the dynamic
Memory Map display.

Click to slow the dynamic Memory Map display.

Click to force concurrent execution of your application program and
display of memory events in the Memory Map.

The Sync push button allows you to synchronize Heap Analyzer display and
application execution, if this is important to you. Your application runs more
slowly when you request synchronization.
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On OpenVMS Alpha systems, anything that uses system service interception,
like the debugger or the Heap Analyzer, is unable to intercept system service call
images activated by shared linkage. The image activator, therefore, avoids shared
linkage for images linked or run with /DEBUG, and instead activates private
image copies. This affects performance of applications under Heap Analyzer
control, as images activated by shared linkage run faster. ¢

4.2 Working with the Default Display

The following sections describe how to use the Heap Analyzer when memory
problems are clearly visible in the default Memory Map display.

Visible problems include allocations that are larger than you expect, that repeat
numerous times, that increment at each allocation, and that could occur in a
more efficient way.

In such cases, your Heap Analyzer session consists of the following steps:
1. Examine the Memory Map display.

Set display characteristics in the Memory Map (optional).

Request additional information on individual segments (optional}.

Request traceback information on individual segments.

oo b

Correlate traceback entries with source code routines.

4.2.1 Memory Map Display

Depending on the size of your application, you may wish to examine the Memory
Map display as your application is running (by using the push buttons to slow,
pause, or step through events) or after your application completes running (by
using the Memory Map’s vertical scroll bar to scroll back through the display).

You can identify segments whose size or location are not what you expect by
remembering that a segment’s location in the Memory Map corresponds to

its location in dynamic memory. Lower addresses in dynamic memory are
represented in the upper left of the Memory Map display. Addresses increase to
the right and wrap at each line of the display.

4.2.2 Options for Memory Map Display
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As you examine the Memory Map, you may wish to select display options that
allow you to see more clearly those parts of the display you are most interested
in.

The Display Menu allows you to control whether you see segment type names
within the Memory Map display, whether the display automatically scrolls to
show the most recent activity, and whether you can compress the display.

The Zoom Menu allows you to control the degree of magnification with which you
see segments in the Memory Map. Choosing the Far menu item, for example,
shows an overview of memory. Choosing Extremely Close shows a more detailed
view of memory.

Figure 4-5 shows the display options that appear in the Display pull-down menu.
The figure then lists all the display options available in the Memory Map.
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Figure 4-5 Heap Analyzer Display Menu
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1. Display Menu Text Visible: (Default.) Labels each segment in the Memory Map
with a segment name, provided that the segment is large enough
to carry a name label.

Auto Scroll: (Default.) Automatically scrolls the Memory Map to
the highest memory addresses (lower right) whenever the display
is expanded.

Reduce Scroll Region: When you request a limited or partial
Memory Map display (see Section 4.3.3.2), compresses the display
so that you can see as many segments as possible without scrolling
to their location in the original display.

Display All Segments: Displays segment definitions for all
segments in the Memory Map.

Clear Information Window: Clears text and messages from the
Information window.

2. Zoom Menu Options provide a closer or more distant view of the Memory Map.
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4.2.3 Options for Further Information
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As you examine the Memory Map display, you may find that you need more
information on those segments that interest you. The Memory Map pop-up menu
allows you to request segment, contents, address, and type definitions for an
individual segment.

A segment definition has the following form:
cursor-address n:init-address + length = end-address name ( view )

cursor-address The address beneath your cursor when you click MB3.

n The number of your segment within the sequence of total segments.
init-address The initial address of your segment.

length The length (in bytes) of your segment.

end-address The last address of your segment.

name The segment type name of your segment.

view The view of your segment: block, image, region, or zone. (See

Section 4.3.3.2 for more information on views.)

For example, the following segment definition describes the 15th segment in your
Memory Map display, which is a segment of type LIBRTL:

0004ECA5 15: 00040000+0001CA00=0005CA00 LIBRTL (Image)

A contents definition consists of a partial segment definition (a segment definition
without a cursor-address) and an ASCII representation of the contents of segment
addresses. For example:

contents of: 38: 001C7000+000000C0=001C70C0O
LIBTRL\LIB$VM\LIB$GET_VM (Block)

[ASCII representation]

An address definition takes the form of a statement describing user access to a
stated address. For example:

001C710B is read and write accessible by the user

A type definition takes the form of a statement summarizing the total number of
segments and total number of bytes devoted to a segment type. For example:

LIBRTL\LIB$VM\LIB$GET VM (Block) has 39 segments
using 00002160 bytes

Figure 4-6 shows the Memory Map context-sensitive pop-up menu. The figure
then lists all the mouse and pop-up menu item choices available in the Memory
Map.
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Figure 4-6 Heap Analyzer Memory Map Context-Sensitive Pop-Up Menu
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Click MB1: Displays the segment definition in the Message window.

LIBRTL LIBSVITV X Blocks
LIBRTLALTBSMALLOC]|  Images

Traceback of Allocation: Displays the traceback information associated
with a segment in the Information window (see Section 4.2.4).

Display Segment: Displays the segment definition in the Information
window.

Display Contents: Displays the segment definition and contents of each
address in the Information window.

Display Address: Displays the position (address) under your cursor and
the type of user access in the Information window.

Display Type: Displays the segment type definition in the Information
window.

Go to Type: Allows you to jump from a segment type listed in the Type
Histogram to the same segment type listed in the Views-and-Types
Display.

Do Not Use Type: Adds a segment type to the Do-not-use Type List.
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4.2.4 Requesting Traceback Information

After you identify an individual segment of interest, choose the Traceback of
Allocation menu item in the Memory Map pop-up menu. Traceback information
can help you understand why your segment was created. Viewing traceback is
also a preliminary step to displaying application code.

Traceback information consists of a partial segment definition (a segment
definition without a cursor address) and the list of elements on the callstack at
the moment your segment was created. The element naming convention is image
name\ module name\ routine name \line number. For example:

traceback: 8:000BA800+00065C00=00120400 DECCS$SHR (Image)
00066EDE DBG$HA_KERNEL
00005864  CRL$MAIN DB\CRL LIBRARY\crl initialize libraries\$LINE 5592

4.2.5 Correlating Traceback Information with Source Code
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When the traceback display appears, you identify the traceback entry most closely
associated with the segment you are investigating. Most often, you can do this by
comparing segment type names and traceback routine names.

When you double click MB1 on this traceback entry, the source code associated
with the entry appears (highlighted) in the Source window. You can then scroll
through the source code display, identify problematic code, and decide how to
correct it.

If you cannot identify any problems in the displayed source code, return to the
Information window and double click MB1 on the routine immediately above or
below your previous choice.

If you double click MB1 on a traceback entry, and ’Source Not Available’ messages
appear in the Source window, you may have forgotten to set a source directory at
the beginning of your Heap Analyzer session. See Section 4.1.5 for information on
setting a search directory.

Figure 4-7 shows the source code that appears when you double click MB1 on
the traceback entry highlighted in the Information window. The figure then lists
all the mouse and menu item choices available for the Source and Information
windows.




Using the Heap Analyzer
4.2 Working with the Default Display

Figure 4-7 Heap Analyzer Information and Source Windows
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000197F8 CRL$MATN_DB\ EFI.INITIALIZE\EFI_INITIALIZE\XLINE 209 134; INITIAL(.def_dis_ct. P
00005633 CRL$MAIN_DB\CRL-LIBRARY\create_library\¥LINE 5497 135: |
00005864 CRL$MAIN_DB\CRL-LIBRARYACTl__initialize_ libraries\¥LINE 5592 136: ENABLE b
00005504 CRL$MAIN_DB\CRL_DEFINE\crl__initialize\¥LINE 4027 137: sca__message_handler{ local_display_routi
00005565  CRL$MAIN._DB\CRL_DEFINE\crl_initialize\¥LINE 4044
(10015406 * -CRLSMAIN_DORSCRLINIT_LIBRARYLCRL__INITIALTZE WRAPERVELINE 138 | 139: return sca$.normal R
00003C58 CRL$MAIN.DB\SCA-_SETUP_VAX_YMS\sca__setup\%LINE 3919 140: END; e
00003A6E CRL$MAIN_DB\SCA__SCA_UNIX\sca__sca.unix\%LINE 1907 ° 141: S
00003A1A CRL$MAIN_DB\CRL__MAIN_VAX_VMS\mair\%LINE 324 142: END ! End of module e
00139446 DEBUG 143: ELUDOM t
1. Information Window Double click MB1: Allows you to jump from a line of

traceback displayed in the Information window to the
related source code in the Source window.

2. Information Window Pop-Up Go to Source: Allows you to jump from a line of
traceback displayed in the Information window to the
related source code in the Source window.

3. Display Menu Clear Information window: Clears text and messages
from the Information window.
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4.3 Adjusting Type Determination and Display

The following sections describe the steps to perform when the memory events’
represented in the default Memory Map are not clear; that is, you cannot tell
whether a problem exists or not.

This circumstance can occur when the segment type names chosen by the Heap
Analyzer are too broad to be useful for your application, or when the Memory
Map is so full that you cannot easily see the segment of interest.

In such cases, you can choose one c: both of the following strategies:

* Review the type summary in the Type Histogram (to see a summary, in total
segments and total bytes, of each segment type’s use)

®  Adjust the type determination in the Memory Map (directing the Heap
’Analyzer to select type names that are more meaningful to you)

® Adjust the type display in the Memory Map (directing the Heap Analyzer to
suppress some types and highlight others)

If, by adjusting the type determination or display, you then identify visible
problems, you can resolve them in the same way you would if you were working
with the default Memory Map display. (For more information, see Section 4.2.)

4.3.1 Options for Further Information
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As you examine the Memory Map, you may wish to see a summary of Memory
Map activity in the Type Histogram. The Type Histogram, which is two
histograms back-to-back, shows the percentage of total segments and the
percentage of total bytes devoted to each segment type in the Memory Map.

To see these graphical representations in numeric form, click MB1 on the segment
type of interest.

To see the total number of segments or total number of bytes, check the top of
each histogram.

Figure 4-8 shows the types listed in the Type Histogram. (This window has been
resized so all types appear.) The figure then lists all the mouse and menu item
choices available in the Type Histogram.
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Figure 4-8 Heap Analyzer Type Histogram

ile Display Zoom Options Help ||

: o % S gnents: 90 bytes: 00217800
[CRLSMATH_DB :
ISYSSEXPREG]

LIBSE
Hean Analyz
VAXCRTL:
DECCSSHR

MTHRTL :
CMASTISZSHR
CRL$PROZSHAR
LIBRTL2: :
SHGSHR
[SECURESHR

LIBRTL :
DBGSHA_KER
DBGSSISHR

CRLSMESSAGES
SHRTHGHSG
VAXCHSG:

50_100

traceback: 67: 00108128+00000210=001D8338 LIBRTL\LIBS$ l% local_display_routine : REF _procedure
00055FE?  LIBRTL\LIB$YM\LIBSGET.WM E INITIAL(,def_dis_g
00016288 CRLS$MATN_DB\SCA__MEM_MANAGER\SCA__MEM_GET_VM\L J8] local_user_argument : REF _unspecified
000197F8 CRL$MAIN_DB\EFI_INITIALIZE\EFI-INITIALTZE\XLINE [P

1. Type Histogram Click MB1: Displays the percentage of total segments
and the percentage of total bytes represented by a
segment.

2. Type Histogram Pop-Up Display Type: Displays a type definition in the

Information window.

Go To Type: Allows you to jump from a segment type
listed in the Type Histogram to the same segment type
listed in the Views-and-Types Display.

Do Not Use Type: Adds a segment type to the Do-not-
use Type List.

4-15



Using the Heap Analyzer |
4.3 Adjusting Type Determination and Display

4.3.2 Altering Type Determination
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As you examine the Memory Map, you may find that some segment type names
are not meaningful to you. By adding these names to the Do-not-use Type List,
you direct the Heap Analyzer to rename segments and, if necessary, regenerate
the Memory Map display.

By default, the analyzer assigns segment type names at the creation of a segment.
In some cases, the analyzer assigns an element name (for example, LIBRTL). In
most cases, however, the analyzer searches down the callstack to find a routine
name that then serves as a segment type name.

The analyzer chooses the first routine name on the callstack that is not prohibited
by the Do-not-use Type List. If the first routine is prohibited, the analyzer
examines the next routine down, and so on.

This default behavior can cause the following Memory Map problems:

¢ The same few type names appear repeatediy in the Memory Map display.

This occurs when the first routines on the callstack are low-level memory
management or utility routines. Since most of the allocation events in your
application use these routines, you see unrelated allocations grouped together
with the same type name.

To prevent this problem, add any application-specific memory management
or utility routine names to the Do-not-use Type List before you run your
application.

¢ The type names assigned provide a higher level of abstraction than you
require.

This can occur when the first routine on the callstack is less application-
bound than your level of examination. If you need to see type names that
reflect application functions, it is not helpful to see type names derived from
intermediary memory management routines instead.

This can also occur when the first routine on the callstack focuses on a part of
your application you are not interested in examining. If you need to see type
names that reflect subsystem functions (for example, initialize_death_star),

it is not helpful to see only one type name for all subsystem functions (for
example, initialize_star).

To correct this problem, add the current type name to the Do-not-use Type
List until the Memory Map display reflects the level of abstraction you desire.

To add a segment type name to the Do-not-use Type List, you can select the
Add to Do-not-use Type List pull-down menu item in the Options menu, or you
can choose the Do Not Use Type pop-up menu item in the Memory Map, Type
Histogram, or Views-and-Types Display. To delete a segment type from this list,
choose the Use Type pop-up menu item in the Do-not-use Type List.

To save the contents of a Do-not-use Type List, you can choose the Save Do-not-
use Type List menu item in the Options menu. This saves the list for future Heap
Analyzer sessions. The Restore Do-not-use Type List menu item removes recent
additions to the list since the last time the list was saved.

Figure 4-9 shows a LIBRTL\ *\ * entry in the Add to Do-not-use Type List dialog
box you can choose from the Options menu. The figure then lists all the mouse
and menu item choices available for the Do-not-Use Type List.
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Figure 4-9 Heap Analyzer Do-Not-Use Type List

File Display Zoom jOptions

{ Set Source... gments: 00217800

Add to Do-not-use Type Lis

{ Save Do-not-use Type List

¥ Restore Do-not-use Type List

dd_to do not use hox

Entry to add to Do-not-use Type List:
| LIBRTL\*\“;\ }

! OK I ¥Cancel| i Help |

% El| 1060205 0 5205000

Information window Source window || po-not-use Type L[ views

LIBRTLALIBSYMY * Blocks
LIBRTLALIBSMALLOC]|  Images

o Regions 9

Zones

1. Do-not-use Type List Pop-Up Use Type: Deletes a segment type from the Do-not-use
Type List.

2. Options Menu Add to Do-not-use Type List: Adds a segment type to
the Do-not-use Type List.

Save Do-not-use Type List: Allows you to save the
segment types listed in your Do-not-use Type List
between Heap Analyzer sessions.

Restore Do-not-use Type List: Deletes additions to the
Do-not-use Type List since the list was last saved.

3. Memory Map Pop-Up Do Not Use Type: Adds a segment type to the Do-not-
Histogram Pop-Up use Type List.
Views-and-Types Display Pop-Up
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4.3.3 Altering the Views-and-Types Display

As you examine the Memory Map, you may find that you need to adjust the
type display to focus more clearly on your area of interest. The Views-and-Types
Display allows you to specify changes to multiple or individual segments of the
same type.

The Views-and-Types Display is actually two windows separated by a window
sash. You can expand the left window to show all the known types in your
application. The right window contains the display options (color, show status,
expand status, and save status).

4.3.3.1 Selecting the Scope of Your Change
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The Heap Analyzer receives information about segments from four OpenVMS
memory managers that perform allocations and deallocations in memory space.
Each memory manager has a slightly different view, or overall picture, of dynamic
memory.

Each memory manager recognizes a different set of segment types. This means
that, within the Heap Analyzer, where views from the memory managers are
layered on each other, a single memory location can be associated with one or
more segment types.

The left window of the Views-and-Types Display contains a hierarchy that reflects
this integration:

e Views (integrates all four views)

¢ Blocks (block view from LIB$VM memory manager)

¢ Images (image view from SYS$IMAGE memory manager)

* Regions (system services view from SYS$SERVICES memory manager)
e Zones (zone view from LIB§VM_ZONE memory manager)

To see the individual segment types recognized by each memory manager, expand
the default display by double clicking MB1 on Blocks, Images, Regions, or Zones
keywords. To collapse an individual listing, click MB3 on the keyword you
previously selected.

This hierarchy offers you the following choices in scope:

e To affect all segment types in all views:
Click MB1 on the Views keyword.

¢ To affect all segment types in one view:
Click MB1 on the Blocks, Images, Regions, or Zones keywords.

e To affect individual segment types:
Double click MB1 on the view of your choice, and click MB1 on one or more
single segment types.

Figure 4-10 shows the Block hierarchy item that is highlighted when you click
MBI to choose all blocks. The figure then lists all the mouse and menu item
choices available in the hierarchy side of the Views-and-Types Display.
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Figure 4-10 Heap Analyzer Views-and-Types Hierarchy

Gh B

File Display Zoom Options

gnents: 00217800

{|Block view has 10 types with 57 segments using 0000360C bytes : a

Infornation window Source window || Do-not-use Ty || Views
LIBRTL\LIB$Y
LIBRTL\LIBSMA CREATE_ENTRY
DBG$HA_KERNEL
DECC$SHR
LIBRTL
o PSE_VLIST_CREATH
PSE_VLIST_CREATH
SCA__MEM_CREATE ]
SCA__MEM_GET_VM
SMGSHR
STR$COPY_R_R8
Inages
Regions

Zones

1. Double click MB1 Allows you to expand (or collapse) the Views-and-Types
hierarchy.
2. Views Hierarchy Pop-Up Display Type: Displays a type definition in the

Information window.

Go to Type: Highlights the type you have selected in
the Views-and-Types Display.

Do Not Use Type: Adds a segment type to the Do-not-
use Type List.
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4.3.3.2 Choosing a Display Option

The right window of the Views-and-Types Display shows the display options
available, as follows:

4-20

Color

To change the color of all segment types, all segment types in a particular
view, or individual segment types, click MB3 on the color button in the
display. When the vertical color strip appears, click MB1 on the color of your
choice. Then, click the Apply button to apply your change.

Show (or hide) status

To suppress (or restore) the display of all segment types, all segment types
in a particular view, or individual segment types, toggle the Show button to
the Hide (or Show) setting and click MB1. (Alternatively, you can choose the
appropriate menu item from the Show pop-up menu.) Then, click the Apply
button to apply your change.

Use this option to clear the Memory Map of segments you are not examining,
You can also use this option to find all segments of a particular type (by
hiding every other segment).

Expand (or collapse) status

To collapse (or expand) the display of segment types contained within all
segment types, all segment types in a particular view, or individual segment
types, toggle the Expand button to the Collapse (or Expand) setting and click
MB1. (Alternatively, you can choose the appropriate menu item from the
Expand pop-up menu.) Then, click the Apply button to apply your change.

Use this option to clear the Memory Map of nested segments you are not
examining. Depending on your application, Heap Analyzer performance may
also improve.

Save (or remove) status

To destroy (or save) information on all segment types, all segment types in
a particular view, or individual segment types, toggle the Save button to the
Remove (or Save) setting and click MB1. (Alternatively, you can choose the
appropriate menu item from the Save pop-up menu.) Then, click the Apply
button to apply your change.

Use this option to clear the Memory Map completely, and then resume
Memory Map display. See Section 4.5 to see how this can be valuable when
you examine interactive commands.

To cancel a choice, click the Reset button, or choose the Reset menu item from the
Show, Expand, or Save pop-up menus.

Figure 4-11 shows the Show pop-up menu that appears when you click MB3 on
the options side of the Views-and-Types Display (the scope of your change, Blocks,
has been previously highlighted). The figure then lists the mouse and menu item
choices available in the options side of the Views-and-Types Display.
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Figure 4-11 Heap Analyzer Views-and-Types Display Options

_Heap Analyzer

gnents: 00217800

B rerereeem———————————————————————————————rehd L | 1050205 0 5205100

Block view has 10 types with 57 segments using 0000360C bytes {d Pause {JSlow { Sync

Information window

1. Click MB1
2. Color Pop-Up
3. Show Pop-Up

4, Expand Pop-Up

5. Save Pop-Up

6. Apply Button
7. Reset Button

Source window [] Do-not-use Ty || Vieus % show expand s B

_Lfmt [stov | show fos
LIBRTLA LIB$MA CREATE_ENTRY show Hide
DBG$HA_KERNEL
DECC$SHR :
LIBRTL expand
PSE_VLIST_CREATH expand
PSE_VLIST_CREATH| i expand say|
SCA__MEM_CREATE. | expand
SCA__MEM_GET_¥M expand
SMGSHR expand
STR$COPY_R-R8 : expand
Images expand
Regions expand
Zones

Reset

Toggles the Show, Expand, and Save toggle buttons.
Controls the color display for individual types or groups of types.

Controls the display of segment types you have chosen. Show and
Hide menu items allow you to restore or suppress display; Reset
cancels your choice.

Controls the display of segments within segment types you have
chosen. Expand and Collapse menu items allow you to restore or
suppress display; Reset cancels your choice.

Controls the Heap Analyzer’s ability to show and store information
on the segment types you have selected. The Remove menu item
destroys all information; Save restores the ability to show and
store information; and Reset cancels your choice.

Applies your selections to the Memory Map display.

Cancels your selections.
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4.4 Exiting the Heap Analyzer

To exit the Heap Analyzer, choose the Exit item from the File menu on the Heap
Analyzer screen.

4.5 Sample Session

This section contains an example that shows how to combine information from
Heap Analyzer windows and menus to locate a particular memory leak in your
application.

The example assumes that you have invoked the Heap Analyzer and run your
application. As you scroll back through the Memory Map display, you focus your
attention on segments that appear when your application calls for an interactive
command.

4.5.1 Isolating Display of Interactive Command
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You suspect that the leak occurs when you enter an interactive SHOW UNITS
command, so your first step is to clear the Memory Map and reenter the
command.

To clear the Memory Map and reenter the command:

1. Click on the Remove option for the Views item within the Views-and-Types
Display. Then click on the Apply button.

The Heap Analyzer clears all previous output from the Memory Map.
2. Click on the Save option for the Views item. Then click on the Apply button.
The Heap Analyzer will save all subsequent output to the Memory Map.

3. In another DECterm window, at your application’s prompt, enter several
SHOW UNITS commands.

The Heap Analyzer shows a small series of segments that appear to be
incrementing, but the scale is too small for you to be sure.

4. Choose the Extremely Close menu item in the Zoom menu.
The Heap Analyzer provides a closer view of the segments.
The memory space allocated to each SCA__MEM_GET_VM segment is slightly

larger with each SHOW UNITS command (see Figure 4-12). This growth in what
should be a same-size allocation indicates a memory leak.



Using the Heap Analyzer
4.5 Sample Session

Figure 4-12 Incrementing Memory Allocation Indicates a Memory Leak

File Display Zoom g_ntions

—

grents: 0009BEEC
(SMGSHR| © ¢
PSEIVLT ¢ ¢ ¢

altogether there are 4 views, 39 types, 128 segments, and 000D418C bytes {1 Pause {1 Slow {1 Sync

Information window Source window || Do-not-use Type 2%/l show Expand save

LIBRTLALIBsvmy#]|  Blocks % show expand save
LIBRTLALIB$MALL Images % show expand save

Regions % show expand save

Zones % show expand save

4.5.2 Adjusting Type Determination

The Heap Analyzer labels the segment type associated with your segments as
"SCA__MEM_GET_VM". This is a fairly low-level memory management routine
that many segments might share. Your next step is to redefine the segment type
to a more meaningful level of abstraction, perhaps one corresponding to the name
of an application routine.

To redefine the segment type:

e Position your mouse pointer over one of the segments, and click MB3.

The Heap Analyzer displays the Memory Map’s context-sensitive pop-up
menu. :

* Choose the Do Not Use Type menu item from the pop-up menu.

The segmeht type associated with your segment changes from "SCA__MEM_
GET_VM" to the more meaningful "crl_begin_unit_query" (see Figure 4-13).
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Figure 4-13 Do Not Use Type Menu Item Redefines Segment Type
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4.5.3 Requesting Traceback Information

After you determine the level of abstraction at which you want to view your
segment, the next step is to examine the state of the call stack when the segment
was allocated. Reviewing the traceback associated with a segment can reveal
when and why it was created, and why a memory problem is occurring.

To request traceback information:

1. Position your mouse pointer over your segment, and click MB3.

The Heap Analyzer displays the Memory Map’s context-sensitive pop-up
menu. '

2. Choose the Traceback of Allocation menu item from the pop-up menu.

Traceback information for your segment appears in the Information window.
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4.5.4 Correlating Traceback with Source Code

The traceback for your segment indicates that the crl_begin_unit_query routine
sets up the environment for the SHOW UNITS command. To examine this event
further, you can request to see the source code associated with it.

To request source code, double-click MB1 on the traceback line that refers to
crl_begin_unit_query.

Source code appears in the Source window. The routine call that placed crl_
begin_unit_query on the callstack is highlighted (see Figure 4-14).

Figure 4-14 Click on Traceback Entry Shows Associated Source Code

Heap Analyzer

File Display Zoom Options Help

LRI BT S (5 BT T

traceback:  411: 001C8108+00000168=001C8340 CRLSMAIN.DB\CRL_UNIT_QUERY\crl_begE$

00055FE7
00016268

Q0010E22 =

0000B2FD
00018437
00013273
00011678
0002B77C
0002921E
00015C79
00003883
00003A1A

LIBRTL\LIB$YM\ LIBSGET VM £ ! complain( language-name_list == NULL
CRL$MAIN_DBY SCA__MEM_MANAGER\ SCA__MEM_GET_VMXLINE 1054 H H "CRL-QUERY_UNITS: language
CRL#MATN_DBVERLUNIT_QUERYACIL_begin_unit_ouery\$LINE 5725 1 : complain( *unit_query = NULL,
CRL$MAIN_DB\CRL_SHOW_UNIT\crl__show_units\¥LINE 5427 : "CRL_QUERY_UNITS: query pa
CRL$MATN_DB\CRL_HANDLER\CRL_SHOW_UNITS\%LINE 263 %
CRL$MAIN_DB\SCA__NS_COMMANDS\sca..ns_show_unit\¥LINE 5679 Il 5725: hem get_em( 0, sizeaf( struct crl.g
CRL$MATN_DB\SCA__PARSE_NEUTRAL_SYNTAX\sca...nsprs.dispatch\%LINE 3504 : complain{ *unit_query == NULL, “mem.
CRL$MAIN.DB\SCA_-SUB_COMMAND_UNIX\SCA__SUB_COMMAND_UNIX\¥LINE 144 1 : memset( *unit_guery, 0, sizeof( stru
CRLS$MAIN_DB\SCA.DISPATCH-PARSE\SCA_DISPATCH_PARSE\XLINE 165 H

CRL$MATN_DB\SCA__DO_COMMAND\SCA._BO_COMMANDAXLINE 172 i : mem_create_vm_zone( &vn_zone,
CRLSMAIN_DB\SCA__SCA_UNIX\sca__sca_unix\¥LINE 1981 ’

CRL$MAIN._DB\CRL__MATN_VAX_YMS\maln\¥LINE 324
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4.5.5 Locating an Allocation Error in Source Code

After you connect a traceback entry to a routine in your application source code,
you can enlarge the Source window and search for allocation errors in that source
code location.

For example, the highlighted line 5725 in Figure 4—-15 makes an allocation
to unit_query. This allocation is not deallocated before line 5740, where an
additional allocation occurs. This coding error is the cause of your memory leak.

Figure 4-15 Review of Source Code Shows Double Allocation

File Display Zoom Options . Help
gments: 0009BEEC

B eerre——————————————————————————ehl, L | 105 @05 0 52100

Information window 5719: "CRL_QUERY_UNITS: name expression parameter is required” ); |§
traceback: 411: 001C8108+000001 5720: complain{ language_name_list == NULL, E
00055FE7 LIBRTL\LIBSYM\LIBSGET VM| 5721: "CRL-QUERY_UNITS: language expression parameter is required" );
000162BB  CRL$MAIN_DBY\SCA__MEM_MAN 5722: complain( *unit_query i= NULL,
010 R 0B 0 5723: "CRL_QUERY_UNITS: query parameter must be zeroed" );
0000B2FD CRL$MAIN_DBY\CRL_SHOW_UNI 5724:
00018437 CRL$MAIN_DBY\CRL.HANDLER\ A
00013273 CRL$MAIN_DBY\SCA__NS_COMM 5726: complain( *unit_oguery == NULL, “mem_get_vm failure creating crl_query” ); p
00011678 CRL$MAIN_DB\SCA__PARSE_N 5727: memset( *unit_query, 0, sizeof( struct crl_guery ) ): p
0002877C CRL$MAIN_DB\SCA__SUB_COM| 5728 1
0002921E CRL$MAIN_DB\SCA_.DISPATCY] 5729: mem_create_vm_zone( &vm_zone, b
00015C79  CRL$MAIN_DB\SCA__DO_COMM 5730: 1, /* 1ibsk_vm_first_fit */
00003883 CRL$MAIN_DBYSCA-_SCA_UNI 5731: 0,
00003A1A CRL$MAIN_DB\CRL__MAIN_VA 5732: 0,
001394A6 DEBUG 5733: 16,
5734: 32,
5735: 8,
5736: 8,
5737: 0,
5738: 0);
5739:
5740: mem_get_vn( 0, sizeof( crl.unit_query ), unit_guery, &wm_zone );
5741 complain{ *unit_guery==NULL, "mem_get_vm failure creating CRL_UNIT_QUERY" ): R
5742: .
5743: pse_list_create_with.zone( &(*unit_query)->units, e
5744: pse.c-list_type_tree, s
5745: sca__mem.get._vm_zone.id( &ym_zone ) ); el
5746 tE
§747: pse_list.set_user_compare( (*unit_query)->units, compare_units );
5748: pse_list_set_user_create( (*unit_query)-s>units, create_unit );
5749: pse_list._set_user_data( (*unit_query)-sunits, ﬂ
5750: (pse_list_user_data) *unit_query ); -
5751: £
5752: (*unit_query)->vm_zone = vm_zone; M|
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Command Interface

This part describes the debugger’s command interface.

For information about the debugger’s DECwindows Motif interface, see Part 1.
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Introduction to the Debugger: Command

Interface

This chapter introduces the OpenVMS Debugger’s command interface. The
chapter provides the following information:

An overview of debugger features
Instructions to compile and link your program for debugging
‘Instructions to start and end a debugging session

A list of the debugger commands grouped by function

For a tutorial introduction to the basic debugging tasks, see Chapter 6.

5.1 Overview of the Debugger

The debugger helps you locate run-time programming or logic errors, also known
as bugs. You use the debugger with a program that has been compiled and linked
successfully but does not run correctly. For example, the program might give
incorrect output, go into an infinite loop, or terminate prematurely.

You locate errors with the debugger by observing and manipulating your program
interactively as it executes. By entering debugger commands at the terminal, you
can:

Display your program’s source code, identifying where execution is currently
paused

Browse through the source code to locate points of interest where you might
test for certain conditions

Set breakpoints to suspend program execution at such points

Execute your program, including stepping one source line at a time and
restarting from the beginning of the program

Trace the execution path of the program

Display the current value of a program variable

Monitor changes in variables and other program entities during program
execution ‘

Change the value of a variable and, in some cases, test the modification
without having to edit the source code, recompile, and relink

Monitor exception conditions and language-specific events, and force events to
occur

These are the basic debugging techniques. After you are satisfied that you have
found the error in the program, you can edit the source code and compile, link,
and execute the corrected version.

5-1



Introduction to the Debugger: Command Interface
5.1 Overview of the Debugger

As you use the debugger and its documentation, you will discover variations on
the basic techniques. You can also customize the debugger for your own needs.
The next section summarizes the debugger features.

5.1.1 Functional Features

>
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Programming Language Support

On VAX processors, you can use the debugger with programs written in the
following VAX languages:

Ada BASIC BLISS C

C++ COBOL DIBOL FORTRAN
MACRO-32 Pascal PL/I RPGII
SCAN ¢

INote that C++ functionality is minimal in this release.

On Alpha processors, you can use the debugger with programs written in the
following DEC languages:

Ada BASIC BLISS c
C++! COBOL Fortran MACRO-322
MACRO-64 Pascal PL/ ¢

INote that C++ functionality is minimal in this release.
2Note that MACRO-32 must be compiled with the AMACRO compiler.

The debugger recognizes the syntax, data types, operators, expressions, scoping
rules, and other constructs of a given language. You can change the debugging
context from one language to another during a debugging session with the SET
LANGUAGE command.

Symbolic Debugging

The OpenVMS Debugger is a symbolic debugger. You can refer to program
locations by the symbols you used for them in your program—the names of
variables, routines, labels, and so on. You do not need to specify memory
addresses or machine registers when referring to program locations, although
you can if you want.

Support for All Data Types

The debugger understands all compiler-generated data types, such as integer,
floating-point, enumeration, record, array, and so on. It displays the values of
program variables according to their declared type.

Flexible Data Format

The debugger permits a variety of data forms and types for entry and display. By
default, the source language of the program determines the format used for the
entry and display of data. You can also impose other formats. For example, by
using a type or radix qualifier with the EXAMINE command, you can display the
contents of a program location in ASCII, word-integer, or floating-point format.

Starting or Resuming Program Execution

You start or resume program execution with the GO or STEP commands. The
GO command causes the program to execute until a breakpoint is reached, a
watchpoint is modified, an exception is signaled, or the program terminates. The
STEP command enables you to execute a specified number of lines or instructions,
or up to the next instruction of a specified class.
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Breakpoints

By setting breakpoints with the SET BREAK command, you can suspend program
execution at specified locations and check the current status of your program.
Rather than specify a location, you can also suspend execution on certain classes
of instructions or on every source line. Also you can suspend execution on certain
kinds of events, such as exceptions and tasking (multithread) events.

Tracepoints

By setting tracepoints with the SET TRACE command, you can monitor the
path of program execution through specified locations. When a tracepoint
is triggered, the debugger reports that the tracepoint was reached and then
continues execution. As with the SET BREAK command, you can also trace
through classes of instructions and monitor events.

Watchpoints

By setting a watchpoint with the SET WATCH command, you can cause execution
to stop whenever a particular variable or other memory location has been
modified. When a watchpoint is triggered, the debugger suspends execution

at that point and reports the old and new values of the variable.

Manipulation of Variables and Program Locations

With the EXAMINE command, you can determine the value of a variable or
program location. The DEPOSIT command enables you to change that value.
You can then continue execution to see the effect of the change without having to
recompile, relink, and rerun the program.

Evaluation of Expressions

With the EVALUATE command, you can compute the value of a source-language
expression or an address expression. You specify expressions and operators in the
syntax of the language to which the debugger is currently set.

Control Structures
You can use logical control structures (FOR, IF, REPEAT, WHILE) in commands
to control the execution of other commands.

Shareable Image Debugging

You can debug shareable images (images that are not directly executable). The
SET IMAGE command enables you to access the symbols declared in a shareable
image.

Multiprocess Debugging

You can debug multiprocess programs (programs that run in more than one
process). The SHOW PROCESS and SET PROCESS commands enable you to
display process information and control the execution of images in individual
processes. \

Task Debugging

You can debug tasking programs (also known as multithread programs). These
programs use DECthreads or POSIX 1003.1b services, or use language-specific
tasking services (for example, Ada tasking programs). The SHOW TASK and SET
TASK commands enable you to display task information and control the execution
of individual tasks.
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Vector Debugging

On VAX processors, you can debug vectorized programs, that is, programs that
use VAX vector instructions. You can control and monitor execution at the
vector instruction level, examine and deposit vector instructions, manipulate the
contents of vector registers, use a mask to display specific vector elements, and
control synchronization between the scalar and vector processors. ¢

Terminal and Workstation Support
The debugger supports all VI-series terminals and MicroVAX workstations.

5.1.2 Convenience Features

Online Help

Online help is always available during a debugging session. Online help contains
information about all debugger commands and selected topics.

Source Code Display

You can display source code for all supported languages during a debugging
session.

Screen Mode

In screen mode, you can display and capture various kinds of information

in scrollable windows that can be moved around the screen and resized.
Automatically updated source, instruction, and register displays are available:
You can selectively direct debugger input, output, and diagnostic messages to
displays. You can also create DO displays that capture the output of specific
command sequences.

Running and Rerunning a Program

With the RUN and RERUN commands, you can run a new program or rerun
the same program from the current debugging session without having to first
exit and restart the debugger. When you rerun a program, you can choose to
either activate or deactivate any previously set breakpoints, tracepoints, and
watchpoints.

Keypad Mode

When you start the debugger, several commonly used debugger command
sequences are assigned by default to the keys of the numeric keypad (if you
have a VT52, VT100, or LK201 keyboard). Thus, you can enter these commands
with fewer keystrokes than if you were to type them at the keyboard. You can
also create your own key definitions.

Source Editing

As you find errors during a debugging session, you can use the EDIT command to
use any editor available on your system. You specify the editor you wish with the
SET EDITOR command. If you use the DEC Language-Sensitive Editor (LSE),
the editing cursor is automatically positioned within the source file whose code
appears in the screen-mode source display.

Command Procedures

You can direct the debugger to execute a command procedure (a file of debugger
commands) to re-create a debugging session, to continue a previous session, or
to avoid typing the same debugger commands many times during a debugging
session. You can pass parameters to command procedures.
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Initialization Files

You can create an initialization file containing commands to set your default
debugging modes, screen display definitions, keypad key definitions, symbol
definitions, and so on. When you start the debugger, those commands are
executed automatically to tailor your debugging environment.

Log Files

You can record in a log file the commands you enter during a debugging session
and the debugger’s responses to those commands. You can use log files to keep
track of your debugging efforts, or you can use them as command procedures in
subsequent debugging sessions.

Symbol Definitions

You can define your own symbols to represent lengthy commands, address
expressions, or values in abbreviated form.

ling and Linking Your Program for Debugging

To bring a program under debugger control and take full advantage of symbolic
debugging, you must first compile and link the program’s modules (compilation
units) as explained in this section.

The following example shows how to compile and link a C program, FORMS, that
consists of two compilation units whose source code is in the files FORMS.C and
INVENTORY.C. FORMS is the main program unit.

On VAX processors, you explicitly identify linker options files in your LINK
command:

$ CC/DEBUG/NOOPTIMIZE INVENTORY,FORMS :
$ LINK/DEBUG FORMS, INVENTORY,OPTIONS FILE/OPTIONS ¢

On Alpha processors, you do not identify linker options files:

$ CC/DEBUG/NOOPTIMIZE INVENTORY,FORMS
$ LINK/DEBUG FORMS, INVENTORY ¢

Note that the /DEBUG and /NOOPTIMIZE qualifiers are compiler command
defaults for some languages. These qualifiers are used in the example for
emphasis. (For information about compiling and linking that is specific to a
particular language, see the documentation for that language.)

ling

In the previous examples, the /DEBUG qualifier on the compiler command (CC
in this case) directs the compiler to write the symbol information associated with
INVENTORY.C and FORMS.C into the object modules, INVENTORY.OBJ and
FORMS.OBJ, respectively, in addition to the code and data for the program. This
symbol information enables you to use the names of variables, routines, and other
symbols declared in the program with debugger commands. If your program’s
source code is in several files, you must compile each file whose symbols you
want to reference with the /DEBUG qualifier. By specifying options with the
/DEBUG qualifier, you can control the level of symbolic information provided (see
Section 9.1.1). "

Some compilers optimize the object code to reduce the size of the program
or to make it run faster. In such cases you should compile your program
with the /NOOPTIMIZE command qualifier (or equivalent) when preparing
for debugging. Otherwise, the contents of some program locations might be
inconsistent with what you would expect from viewing the source code. For
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example, some optimization techniques eliminate certain variables so that you
no longer have access to them while debugging. (After the program has been
debugged, you will probably want to recompile it without the /NOOPTIMIZE
qualifier to take advantage of optimization.) Section 13.1 describes some of the
effects of optimization.

Note also another possible cause of unexpected behavior. Your program and parts
of the debugger share the same address space. In some rare cases, this can cause
the debugger to affect how your program executes.

5.2.2 Linking

>

In the previous examples, the /DEBUG qualifier on the LINK command directs
the linker to include all symbol information that is contained in the object
modules being linked (FORMS.OBJ and INVENTORY.OBJ, in this case) in the
executable image. If your program has several object modules, you need to specify
those modules in the LINK command (for most languages). See Section 9.1.3 for
more details on how the LINK command controls symbol information.

On VAX processors, the /OPTIONS qualifier indicates that OPTIONS_FILE is
a linker options file. In the previous VAX example, the file specifies a run-time
library to be linked with the program. ¢

5.2.3 Controlling Debugger Activation with the LINK and RUN Commands

In addition to passing symbol information to the executable image, the
LINK/DEBUG command causes the image activator to start the debugger if you
execute the resulting image with the DCL RUN command. (This older, ptlonal
method of starting the debugger is explained in Section 5.3.8.1.)

Even if you compile and link an image with the /DEBUG command qualifier, you
can execute that image normally, without it being under debugger control. Use
the /NODEBUG qualifier on the DCL RUN command. For example:

$ RUN/NODEBUG FORMS

This is convenient for checking your program after you think it is error free.
Note that the data required by the debugger occupies space within the executable
image. When you think your program is correct, you might want to link your
program again without the /DEBUG qualifier. This creates an image with only
traceback data in the debug symbol table which uses less disk space.

Table 5—-1 summarizes how to control debugger activation with the LINK and
RUN command qualifiers. Note that the LINK command qualifiers /[NO]DEBUG
and /[INOJTRACEBACK affect not only debugger activation but also the maximum
level of symbol information provided when debugging.



Introduction to the Debugger: Command Interface
5.2 Compiling and Linking Your Program for Debugging

Table 5-1 Controlling Debugger Activation with the LINK and RUN Commands

LINK Command To Run Program without  To Run Program with  Maximum Symbol
Qualifier Debugger Debugger Information Available’
/DEBUG RUN/NODEBUG RUN Full

None or RUN RUN/DEBUG Only traceback?®
/TRACEBACK or

/NODEBUG?

/NOTRACEBACK RUN RUN/DEBUG* None

1 The level of symbol information available while debugging is controlled both by the COMPILE command qualifier and
the LINK command qualifier (see Section 9.1).

2 LINK/TRACEBACK (or LINK/NODEBUG) is a LINK command default.

3 Traceback information includes compiler-generated line numbers and the names of routines and modules (compilation
units). This symbol information is used by the traceback condition handler to identify the PC value (where execution is
paused) and the active calls when a run-time error has occurred. The information is also used by the debugger SHOW
CALLS command (see Section 6.3.3).

4 The RUN/DEBUG command allows you to run the debugger, but if you entered the LINK/NOTRACEBACK command,
you will be unable to do symbolic debugging.

On OpenVMS Alpha systems, anything that uses system service interception
: (SSI), like the debugger or the Heap Analyzer is unable to intercept system
service call images activated by shared linkage. The image activator, therefore,
avoids shared linkage for images linked or run with /DEBUG, and instead
activates private image copies. This affects performance of user applications
under debugger or Heap Analyzer control, as images activated by shared linkage
run faster. ¢

5.3 Starting and Ending a Debugging Session
This section explains how to:
e Start the debugger and then bring a program under debugger control
¢ Rerun the same program from the current debugging session
¢ Run another program from the current debugging session
¢ End a debugging session
e Interrupt program execution and abort debugger commands
e Interrupt a debugging session and then return to the debugging session

The last part of this section describes additional ways to start the debugger for
specific purposes.

5.3.1 Starting the Debugger

This section explains the usual way to start the debugger from DCL level ($) and
bring your program under debugger control. Section 5.3.8 explains other, optional
ways.

Starting the debugger as explained here enables you to use the debugger’s
RERUN and RUN features explained in Section 5.3.3 and Section 5.3.4,
respectively.
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To start the debugger and bring your program under debugger control:

1. Verify that you have compiled and linked the program as explained in
Section 5.2,

2. Verify that the debugging configuration (default or multiprocess)
is appropriate for the kind of program you are going to debug (see
Section 5.3.8.3). For a program that runs in only one process (the typical
case), use the default configuration.

3. Enter the following command line:

$ DEBUG/KEEP
Debugger Banner and Version Number
DBG>

Upon startup, the debugger displays its banner and executes any user-defined
initialization file (see Section 12.2). The DBG> prompt indicates that you can
now enter debugger commands, as explained in Section 6.1.

4. Bring your program under debugger control with the debugger RUN
command, specifying the executable image of your program as the parameter.
For example:

DBG> RUN FORMS
$DEBUG-I-INITIAL, language is C, module set to FORMS
DBG>

The message displayed indicates that this debugging session is initialized for a C
program and that the name of the main program unit (the module containing the
image transfer address) is FORMS. The initialization sets up language-dependent
debugger parameters. These parameters control the way the debugger parses
names and expressions, formats debugger output, and so on. See Section 8.1.8
and Section 8.1.9 for more information about language-dependent parameters.

Now program execution either pauses at the start of the main program unit or,
with certain programs, at the start of some initialization code, before the main
program. In the latter case, the debugger displays the following message:

$DEBUG-I-NOTATMAIN, type GO to get to start of main program

With some of these programs (for example, Ada programs), the first breakpoint
enables you to debug the initialization code using full symbolic information. See
Section 13.3 for more information.

At this point, you can debug your program as explained in Chapter 6.

RUN and RERUN Command Options for Programs That Require Arguments

Some programs require arguments. This section explains how to execute
such programs under debugger control with the debugger’s RUN and RERUN
commands, and with the /ARGUMENTS and /COMMAND qualifiers.

Following invocation of the debugger with the DCL command DEBUG/KEEP, you
use the /ARGUMENTS qualifier with RUN to specify a list of arguments. Specify
the program in one of two ways: Either specify the image name with RUN, or use
the /COMMAND qualifier with RUN to specify a DCL foreign command. Note
that the image name and the /COMMAND qualifier are mutually exclusive.
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The different methods are shown in the following example of a debugger session.
The source program is echoargs.c, a program that echoes the input arguments to
the terminal:

#include <stdio.h>

main(int argc, char *argv[])
int i;

for (i = 0; i < argc; i++)
printf("$s\n", argv[i]);
}

The program is compiled and linked as follows:

$ cc/debug/noopt echoargs.c
$ link/debug echoargs

A DCL foreign command is defined as follows:
$ ECHO == "$§ sys$disk:[]lechoargs.exe"

The debugger is invoked. The debugger session in the example that follows shows
three ways of passing arguments:

1. RUN with /COMMAND and /ARGUMENTS

The first section of the debugger session shows the use of the debugger
RUN command with the /COMMAND and /ARGUMENTS qualifiers.

The /COMMAND qualifier uses the DCL foreign command echo. The
/ARGUMENTS qualifier specifies the actual arguments to the program,
which are fa sol la mi. There is a GO to get to the start of the main program,
and another GO to execute the program. The program correctly echoes the
arguments to the screen:

$ debug/keep
Debugger Banner and Version Number

DBG> run /command="echo"/arguments="fa sol la mi"
$DEBUG-I-INITIAL, language is C, module set to ECHOARGS
%DEBUG-I-NOTATMAIN, type GO to get to start of main program
DBG> go
break at routine ECHOARGS\main
265: {
DBG> go
_dsal:[Jjones.test]echoargs.exe;2
fa
sol
la
mi
$DEBUG-I-EXITSTATUS, is ’%SYSTEM-S-NORMAL, normal successful completion’

2. RERUN with /ARGUMENTS

The second section of the same debugger session shows the use of the RERUN
command with the /ARGUMENTS qualifier. It runs the same image again,
with the new arguments fee fii foo fum. (If you omitted the /ARGUMENTS
qualifier, the debugger would rerun the program with its previous arguments.)

" There is a GO to get to the start of the main program, and another GO to
execute the program. The program correctly echoes the arguments to the
screen:
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DBG> rerun/arg="fee fii foo fum"
$DEBUG-I-INITIAL, language is C, module set to ECHOARGS
$DEBUG-I-NOTATMAIN, type GO to get to start of main program
DBG> go
break at routine ECHOARGS\main
265: { .
DBG> go
_dsal:[jones.test]echoargs.exe;2
fee
fii
foo
fum
$DEBUG-I-EXITSTATUS, is ’'%SYSTEM-S-NORMAL, normal successful completion’

3. RUN with /ARGUMENTS and image name

The last section shows the use of the RUN command with an image name,
echoargs, and the /ARGUMENTS qualifier. This command runs a new
image, specified by the image name. This time, there is no DCL foreign
command. The actual arguments to the program, a b ¢, are specified by
the /ARGUMENTS qualifier. There is a GO to get to the start of the main
program, and another GO to execute the program. The program correctly
echoes the arguments to the screen:

DBG> run/arg="a b ¢" echoargs
$DEBUG-I-INITIAL, language is C, module set to ECHOARGS
$DEBUG-I-NOTATMAIN, type GO to get to start of main program
DBG> go
break at routine ECHOARGS\main
265: {

DBG> go

dsal:[jones.test]echoargs.exe;2

Qo w|

$DEBUG-I-EXITSTATUS, is ’'$SYSTEM-S-NORMAL, normal successful completion’
DBG> quit

RUN Command Restrictions
Note the following restrictions about the debugger RUN command:

®  You cannot use the RUN command to connect the debugger to a running
program (see Section 5.3.8.2).

*  You cannot run a program under debugger control over a DECnet link. Both
the image to be debugged and the debugger must reside on the same node.

5.3.2 When Your Program Completes Execution

When your program completes execution normally during a debugging session,
the debugger issues the following message:

$DEBUG-I-EXITSTATUS, is '$SYSTEM-S-NORMAL, normal successful completion’
You then have the following options:

¢  You can rerun your program from the same debugging session (see
Section 5.3.3).

¢  You can run another program from the same debugging session (see
Section 5.3.4).

*  You can end the debugging session (see Section 5.3.5).
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5.3.3 Rerunning the Same Program from the Current Debugging Session

You can rerun the program currently under debugger control at any time during
a debugging session, provided you originally started the debugger as explained in
Section 5.3.1. Use the RERUN command. For example:

DBG> RERUN
$DEBUG-I-INITIAL, language is C, module set to FORMS
DBG>

The RERUN command terminates the image you were debugging and then brings
a copy of that image under debugger control. Execution is paused at the start of
the main program unit, as if you had used the RUN command (see Section 5.3.1).

The RERUN command differs most notably from the RUN command in that
RERUN lets you save the current state (activated or deactivated) of any
breakpoints, tracepoints, and static watchpoints from the previous run of the
program. The state of a particular nonstatic watchpoint might or might not be
saved, depending on the scope of the variable being watched relative to the main
program unit (where execution restarts). RERUN/SAVE is the default. If you do
not want to save the current state, enter RERUN/NOSAVE instead of RERUN.

The RERUN command uses the same version of the image that is currently under
debugger control. To debug a different version of that program (or a different
program) from the same debugging session, use the RUN command. To rerun

a program with new arguments, use the /ARGUMENTS qualifier (see RUN and
RERUN Command Options for Programs That Require Arguments).

5.3.4 Running Another Program from the Current Debugging Session

You can bring another program under debugger control at any time during a
debugging session, provided you originally started the debugger as explained in
Section 5.3.1. Use the debugger RUN command. For example:

DBG> RUN TOTALS
$DEBUG-I-INITIAL, language is FORTRAN, module set to TOTALS
DBG>

After the program has been brought under debugger control, execution is paused
at the start of the main program unit.

For more information about startup conditions and restrictions see Section 5.3.1.

For information about all RUN command options, see the debugger RUN
command description.

5.3.5 Ending a Debugging Session ‘
To end a debugging session in an orderly manner and return to DCL level, enter
EXIT or QUIT or press Ctrl/Z. For example:

DBG> EXIT
$

These commands start the debugger exit handlers to close log files, restore the
screen and keypad states, and so on.

The EXIT command and Ctrl/Z have the same effect. The QUIT command is like
the EXIT command or Ctrl/Z, except that the EXIT command and Ctrl/Z also
execute any exit handlers that are declared in your program; the QUIT command
does not.
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5.3.6 Interrupting Program Execution and Aborting Debugger Commands

If your program goes into an infinite loop during a debugging session so that
the debugger prompt does not reappear, press Ctrl/C. This interrupts program
execution and returns you to the debugger prompt (pressing Ctrl/C does not end
the debugging session). For example:

DBG> GO

DBG>

You can also press Ctrl/C to abort the execution of a debugger command. This is
useful if, for example, the debugger is displaying a long stream of data.

Pressing Ctrl/C when the program is not running or when the debugger is not
performing an operation has no effect.

If your program has a Ctrl/C AST (asynchronous system trap) service routine
enabled, use the SET ABORT_KEY command to assign the debugger’s abort
function to another Ctrl/key sequence. To identify the abort key that is currently
defined, enter the SHOW ABORT_KEY command.

Pressing Ctrl/Y from within a debugging session has the same effect as pressing
Ctrl/Y during the execution of a program. Control is returned to the DCL
command interpreter ($ prompt).

5.3.7 Interrupting and Resuming a Debugging Session
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The debugger SPAWN and ATTACH commands enable you to interrupt a
debugging session from the debugger prompt, enter DCL commands, and return

to the debugger prompt. These commands function essentially like the DCL
commands SPAWN and ATTACH:

¢ Use the debugger SPAWN command to create a subprocess.

e TUse the debugger ATTACH command to attach to an existing process or
subprocess.

You can enter the SPAWN command with or without specifying a DCL command
as a parameter. If you specify a DCL command, it is executed in a subprocess
(if the DCL command invokes a utility, that utility is invoked in a subprocess).
Control returns to the debugging session when the DCL command terminates
(or when you exit the utility). The following example shows spawning the DCL
command DIRECTORY:

DBG> SPAWN DIR [JONES.PROJECT2]*.FOR

¥DEBUG-I-RETURNED, control returned to process JONES_1
DBG>

The next example‘shows spawning the DCL command MAIL, which invokes the
Mail utility:
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DBG> SPAWN MAIL
MAIL> READ/NEW

MAIL> EXIT ‘
$DEBUG-I-RETURNED, control returned to process JONES_l
DBG>

If you enter the SPAWN command without specifying a parameter, a subprocess
is created, and you can then enter DCL commands. Either logging out of the
subprocess or attaching to the parent process (with the DCL ATTACH command)
returns you to the debugging session. For example:

DBG> SPAWN
$ RUN PROG2

$ ATTACH JONES_1
%DEBUG-I-RETURNED, control returned to process JONES_1
DBG>

If you plan to go back and forth several times between your debugging session
and a spawned subprocess (which might be another debugging session), use the
debugger ATTACH command to attach to that subprocess. Use the DCL ATTACH
command to return to the parent process. Because you do not create a new
subprocess every time you leave the debugger, you use system resources more
efficiently.

If you are running two debugging sessions simultaneously, you can define a new
debugger prompt for one of the sessions with the SET PROMPT command. This
helps you differentiate the sessions.

5.3.8 Additional Options for Starting the Debugger

In addition to the startup procedure described in Section 5.3.1, the following
options are available for starting the debugger from DCL level:

e Start the debugger by running the program to be debugged with the DCL
RUN command (Section 5.3.8.1). '

¢ Interrupt a running program with Ctrl/Y and then start the debugger using
the DCL DEBUG command (Section 5.3.8.2).

e [Establish a default or multiprocess debugging configuration to debug a
program that runs in either one or several processes, respectively.

Section 5.3.8.4 explains how to display the debugger’s command interface instead
of the DECwindows Motif interface on a workstation running DECwindows Motif.

5.3.8.1 Starting the Debugger by Running a Program
You can start the debugger and also bring your program under debugger control
in one step by entering the DCL command RUN program-image (assuming the
image was linked with the /DEBUG qualifier).

However, you cannot use the debugger RERUN or RUN features explained in
Section 5.3.3 and Section 5.3.4, respectively. To rerun the same program or run
another program under debugger control, you must first exit the debugger and
start it again.
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To start the debugger by running a program:

1. Verify that you have compiled and linked the program as explained in
Section 5.2 and that you have established the proper debugging configuration
as explained in Section 5.3.8.3.

2. Enter the DCL command RUN progrdm-image to start the debugger.
For example:

$§ RUN FORMS
Debugger Banner and Version Number

$DEBUG-I-INITIAL, language is C, module set to FORMS
DBG>

Upon startup, the debugger displays its banner, executes any user-defined
initialization file, sets the language-dependent parameters to the source language
of the main program, suspends execution at the start of the main program, and
prompts for commands.

For more information about startup conditions, see Section 5.2.3 and
Section 5.3.1.

5.3.8.2 Starting the Debugger After Interrupting a Running Program
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You can bring a program that is executing freely under debugger control. This is
useful if you suspect that the program might be in an infinite loop or if you see
erroneous output.

To bring your program under debugger control:

1. Verify that you have compiled and linked the program as explained in
Section 5.2 and that you have established the proper debugging configuration
as explained in Section 5.3.8.3.

2. Enter the DCL command RUN/NODEBUG program-image to execute the
program without debugger control.

3. Press Ctrl/Y to interrupt the executing program. Control passes to the DCL
command interpreter.

4. Enter the DCL command DEBUG to start the debugger.
For example:

$ RUN/NODEBUG FORMS

Interrupt
$ DEBUG

Debugger Banner and Version Number

$DEBUG-I-INITIAL, language is C, module set to FORMS
DBG>

Upon startup, the debugger displays its banner, executes any user-defined
initialization file, sets the language-dependent parameters to the source language
of the module where execution was interrupted, and prompts for commands.
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Usually you will not know where execution was interrupted. Enter the SHOW
CALLS command to determine where execution is paused and the sequence
of routine calls on the call stack (the SHOW CALLS command is described in
Section 6.3.3).

When you start the debugger in this manner, you cannot then use the
debugger RERUN or RUN features explained in Section 5.3.3 and Section 5.3.4,
respectively. To rerun the same program or run another program under debugger
control, you must first exit the debugger and start it again.

For more information about startup conditions, see Section 5.2.3 and
Section 5.3.1.

5.3.8.3 Establishing the Debugging Configuration
You can start the debugger in either the default configuration or the
multiprocess configuration to debug programs that run in either one or several
processes, respectively. The configuration depends on the current definition of the
logical name DBG$PROCESS. Before starting the debugger, enter the DCL
command SHOW LOGICAL DBG$PROCESS to determine the definition of
DBG$PROCESS:

e If you are debugging a program that runs in only one process,
DBG$PROCESS should be either undefined, as in the following example,
or should have the value DEFAULT:

$ SHOW LOGICAL DBGSPROCESS
$SHOW-S-NOTRAN, no translation for logical name DBG$PROCESS

By default, DBG$PROCESS is undefined, and this is appropriate for
debugging a program that runs in only one process (the typical case).

e If you are debugging a program that runs in more than one process,
DBG$PROCESS should have the value MULTIPROCESS.

¢ If DBG$PROCESS has the value MULTIPROCESS, and you want to debug a
program that runs in only one process, enter the following command:

$ DEFINE DBG$PROCESS DEFAULT

For more information about multiprocess debugging, see Chapter 14.

5.3.8.4 Displaying the Debugger’s Command Interface on a Workstation Running
DECwindows Motif
If you are at a workstation running DECwindows Motif, by default the debugger
starts up in the DECwindows Motif interface, which is displayed on the

workstation specified by the DECwindows Motif application-wide logical name
DECW$DISPLAY.

The logical name DBG$DECWS$DISPLAY enables you to override the default to
display the debugger’s command interface in a DECterm window, along with any
program input/output (I/O).

To display the debugger’s command interface in a DECterm window:

1. Enter the following definition in the DECterm window from which you plan
to start the debugger:

$ DEFINE/JOB DBG$DECW$DISPLAY " "

You can specify one or more space characters between the quotation marks. It
is recommended that you use a job definition for the logical name. If you use
a process definition, it must not have the CONFINE attribute.
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2. Start the debugger in the usual way from that DECterm window (see
Section 5.3.1). The debugger’s command interface is displayed in the same
window.

For example:

$ DEFINE/JOB DBGSDECWSDISPLAY " "
$ DEBUG/KEEP

Debugger Banner and Version Number
DBG>
You can now bring your program under debugger control as explained

in Section 5.3.1. For more information about the logical names
DBG$DECWS$DISPLAY and DECW$DISPLAY, see Section 2.7.3.

5.3.8.5 Debugging Detached Processes that Run with No CLI

The design and implementation of the debugger’s DECwindows Motif interface
requires that the process being debugged have a command line interpreter (CLI).
To debug a detached process (such as a print symbiont) that does not have a CLI,
you must use the character-cell (screen mode) interface to the debugger.

To do so, direct DBG$INPUT, DBG$OUTPUT and DBG$ERROR to a terminal
port that is not logged in. This allows the image to be debugged with the
standard character-cell interface on that terminal.

For example:

$ DEFINE/TABLE=GROUP DBGSINPUT TTA3:
$ DEFINE/TABLE=GROUP DBGSOUTPUT TTA3:
$ DEFINE/TABLE=GROUP DBGSERROR TTA3:
$ START/QUEUE SYS$PRINT /PROCESSOR=dev:([dir]test program

[Debugger starts up on logged-out terminal TTA3:]

5.4 Debugger Command Summary

The following sections list all the debugger commands and any related DCL
commands in functional groupings, along with brief descriptions. During a
debugging session, you can get online help on all debugger commands and their
qualifiers by typing HELP at the debugger prompt (see Section 6.1).

5.4.1 Starting and Ending a Debugging Session
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The following commands are used to start the debugger, bring a program under
debugger control, and interrupt and end a debugging session. Except where the
DCL RUN and DEBUG commands are indicated specifically, all commands are
debugger commands.
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DEBUG/KEEP
(DCL DEBUG command)

RUN SYS$SHARE:DEBUGSHR.EXE
RUN program-image
RERUN

RUN program-image
(DCL RUN command)

EXIT, Ctrl/Z
QUIT

Ctrl/C

(SET,SHOW) ABORT_KEY

Ctrl/Y-DEBUG
(DCL DEBUG command)

ATTACH

SPAWN

5.4 Debugger Command Summary

Starts the debugger.

Starts the debugger.
Brings a program under debugger control.

Reruns the program currently under debugger
control.

If the specified image was linked using LINK
/DEBUG, starts the debugger and also brings
the image under debugger control. When

you start the debugger in this manner, you
cannot then use the debugger RUN or RERUN
commands. You can use the /[NOIDEBUG
qualifiers with the RUN command to control
whether the debugger is started when the
program is executed.

Ends a debugging session, executing all exit
handlers.

Ends a debugging session without executing
any exit handlers declared in the program.

Aborts program execution or a debugger
command without interrupting the debugging
session.

(Assigns, identifies) the default Ctrl/C abort
function to another Ctrl/key sequence,
identifies the Ctrl/key sequence currently
defined for the abort function.

Interrupts a program that is running without
debugger control and starts the debugger.

Passes control of your terminal from the
current process to another process.

Creates a subprocess, which enables you to
execute DCL commands without ending a
debugging session or losing your debugging
context.

5.4.2 Controlling and Monitoring Program Execution

The following commands are used to control and monitor program execution:

GO
STEP

(SET,SHOW) STEP

(SET,SHOW,CANCEL) BREAK
(ACTIVATE,DEACTIVATE) BREAK

(SET,SHOW,CANCEL) TRACE
(ACTIVATE,DEACTIVATE) TRACE

(SET,SHOW,CANCEL) WATCH
(ACTIVATE,DEACTIVATE) WATCH

Starts or resumes program execution.

Executes the program up to the next line,
instruction, or specified instruction.

(Establishes, displays) the default qualifiers
for the STEP command.

(Sets, displays, cancels) breakpoints.

(Activates, deactivates) previously set
breakpoints.

(Sets, displays, cancels) tracepoints.

(Activates, deactivates) previously set
tracepoints.

(Sets, displays, cancels) watchpoints.

(Activates, deactivates) previously set
watchpoints.
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5.4 Debugger Command Summary

SHOW CALLS
SHOW STACK

CALL

5.4.3 Examining and Manipulating Data

Identifies the currently active routine calls.

Gives additional information about the
currently active routine calls.

Calls a routine.

The following commands are used to examine and manipulate data:

EXAMINE

SET MODE [NOJOPERANDS

DEPOSIT

EVALUATE
MONITOR

5.4.4 Controlling Type Selection and Radix

Displays the value of a variable or the
contents of a program location.

Controls whether the address and contents of
the instruction operands are displayed when
you examine an instruction.

Changes the value of a variable or the
contents of a program location.

Evaluates a language or address expression.

(Applies only to the debugger’s DECwindows
Motif interface.) Displays the current value
of a variable or language expression in the
Monitor View of the DECwindows Motif
interface.

The following commands are used to control type selection and radix:

(SET,SHOW,CANCEL) RADIX

(SET,SHOW,CANCEL) TYPE

SET MODE [NO]G_FLOAT

(Establishes, displays, restores) the radix for
data entry and display.

(Establishes, displays, restores) the type for
program locations that are not associated with
a compiler-generated type.

Controls whether double-precision floating-
point constants are interpreted as G_FLOAT
or D_FLOAT.

5.4.5 Controlling Symbol Searches and Symbolization

The following commands are used to control symbol searches and symbolization:

SHOW SYMBOL

(SET,SHOW,CANCEL) MODULE

(SET,SHOW,CANCEL) IMAGE

SET MODE [NO]DYNAMIC

(SET,SHOW,CANCEL) SCOPE
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Displays symbols in your program.

Sets a module by loading its symbol
information into the debugger’s symbol table,
identifies, cancels a set module.

Sets a shareable image by loading data
structures into the debugger’s symbol table,
identifies, cancels a set image.

Controls whether or not modules and
shareable images are set automatically when
the debugger interrupts execution.

(Establishes, displays, restores) the scope for
symbol searches.
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SYMBOLIZE

SET MODE [NO]LINE

SET MODE [NO]JSYMBOLIC

5.4.6 Displaying Source Code

5.4 Debugger Command Summary

Converts a memory address to a symbolic
address expression.

Controls whether or not program locations
are displayed in terms of line numbers or
routine-name + byte offset.

Controls whether or not program locations are
displayed symbolically or in terms of numeric
addresses.

The following commands are used to control the display of source code:

TYPE
EXAMINE/SOURCE

SEARCH
(SET,SHOW) SEARCH

SET STEP [NOJSOURCE

(SET,SHOW) MARGINS

(SET,SHOW,CANCEL) SOURCE

5.4.7 Using Screen Mode

Displays lines of source code.

Displays the source code at the location
specified by the address expression.

Searches the source code for the specified
string.

(Establishes, displays) the default qualifiers
for the SEARCH command.

Enables/disables the display of source code
after a STEP command has been executed or
at a breakpoint, tracepoint, or watchpoint.

(Establishes, displays) the left and right
margin settings for displaying source code.

(Creates, displays, cancels) a source directory
search list.

The following commands are used to control screen mode and screen displays:

SET MODE [NOISCREEN
DISPLAY

SCROLL

EXPAND

MOVE

(SHOW,CANCEL) DISPLAY
(SET,SHOW,CANCEL) WINDOW

SELECT
SHOW SELECT

SAVE

EXTRACT

Enables/disables screen mode.
Creates or modifies a display.
Scrolls a display.

Expands or contracts a display.
Moves a display across the screen.
(Identifies, deletes) a display.

(Creates, identifies, deletes) a window
definition.

Selects a display for a display attribute.

Identifies the displays selected for each of the
display attributes.

Saves the current contents of a display into
another display.

Saves a display or the current screen state
into a file.
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(SET,SHOW) TERMINAL (Establishes, displays) the terminal screen
height and width that the debugger uses when
it formats displays and other output.

SET MODE [NO]SCROLL Controls whether an output display is updated
line by line or once per command.

CtrVYW Refreshes the screen.

DISPLAY/REFRESH

5.4.8 Editing Source Code

The following commands are used to control source editing from a debugging

session:
EDIT Starts an editor during a debugging session.
(SET,SHOW) EDITOR (Establishes, identifies) the editor started by

the EDIT command.

5.4.9 Defining Symbols

The following commands are used to define and delete symbols for addresses,
commands, or values:

DEFINE Defines a symbol as an address, command, or

value.

DELETE ' Deletes symbol definitions.

(SET,SHOW) DEFINE (Establishes, displays) the default qualifier for
the DEFINE command.

SHOW SYMBOL/DEFINED Identifies symbols that have been defined with

the DEFINE command.
5.4.10 Using Keypad Mode

The following commands are used to control keypad mode and key definitions:

SET MODE [NOIKEYPAD Enables/disables keypad mode.
DEFINE/KEY Creates key definitions.
DELETE/KEY Deletes key definitions.

SET KEY Establishes the key definition state.
SHOW KEY Displays key definitions.

5.4.11 Using Command Procedures, Log Files, and Initialization Files
The following commands are used with command procedures and log files:

@ (execute procedure) Executes a command procedure.

(SET,SHOW) ATSIGN (Establishes, displays) the default file
specification that the debugger uses to search
for command procedures.

DECLARE Defines parameters to be passed to command
procedures.

(SET,SHOW) LOG (Specifies, identifies) the debugger log file.

SET OUTPUT [NOJLOG Controls whether or not a debugging session
is logged.
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SET OUTPUT [NOJSCREEN_LOG

SET OUTPUT [NOJVERIFY

SHOW OUTPUT

5.4.12 Using Control Structures

5.4 Debugger Command Summary

Controls whether or not, in screen mode, the
screen contents are logged as the screen is
updated.

Controls whether or not debugger commands
are displayed as a command procedure is
executed.

Identifies the current output options
established by the SET OUTPUT command.

The following commands are used to establish conditional and looping structures

for debugger commands:

FOR

IF
REPEAT

WHILE

EXITLOOP

5.4.13 Debugging Multiprocess Programs

Executes a list of commands while
incrementing a variable.

Executes a list of commands conditionally.

Executes a list of commands a specified
number of times.

Executes a list of commands while a condition
is true.

Exits an enclosing WHILE, REPEAT, or FOR
loop.

The following commands are used to debug multiprocess programs. Note that
these commands are specific to multiprocess programs. Many of the commands
listed under other categories have qualifiers or parameters that are specific

to multiprocess programs (for example, SET BREAK/ACTIVATING, EXIT

process-spec, DISPLAY/PROCESS=).

CONNECT
DEFINE/PROCESS_GROUP

DO

SET MODE [NO]INTERRUPT

(SET,SHOW) PROCESS

5.4.14 Additional Commands

Brings a process under debugger control.

Assigns a symbolic name to a list of process
specifications.

Executes commands in the context of one or
more processes.

Controls whether execution is interrupted in
other processes when it is paused in some
process.

Modifies the multiprocess debugging
environment, displays process information.

The following commands are used for miscellaneous purposes:

HELP

(DISABLE,ENABLE,SHOW) AST

(SET,SHOW) EVENT_FACILITY

(SET,SHOW) LANGUAGE

Displays online help on debugger commands
and selected topics.

(Disables, enables) the delivery of ASTs in
the program, identifies whether dehvery is
enabled or disabled.

(Establishes, identifies) the current run-time
facility for Ada, DECthreads, and SCAN
events.

(Establishes, identifies) the current language.

5-21



Introduction to the Debugger: Command Interface
5.4 Debugger Command Summary

SET MODE [NOJSEPARATE Controls whether the debugger, when used
on a workstation running VWS, creates a
separate window for debugger input and

output.

SET OUTPUT [NOITERMINAL Controls whether debugger output, except
for diagnostic messages, is displayed or
suppressed.

SET PROMPT " Specifies the debugger prompt.

(SET,SHOW) TASK Modifies the tasking environment, displays
task information.

+(SET,SHOW) VECTOR_MODE Enables or disables a debugger vector mode

option, identifies the current vector mode
option (for vectorized programs).

SHOW EXIT _HANDLERS Identifies the exit handlers declared in the
program,
SHOW MODE Identifies the current debugger modes

established by the SET MODE command
(for example, screen mode, step mode).

SHOW OUTPUT Identifies the current output options
established by the SET OUTPUT command.

TSYNCHRONIZE VECTOR_MODE Forces immediate synchronization between
the scalar and vector processors (for vectorized
programs).

TVAX specific
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Getting Started with the Debugger:
Command Interface

This chapter gives a tutorial introduction to the debugger’s command interface.

The way you use the debugger depends on several factors: the kind of program
you are working on, the kinds of errors you are looking for, and your own
personal style and experience with the debugger. This chapter explains the
following basic tasks that apply to most situations:

e Entering debugger commands and getting online help
e Viewing your source code with the TYPE command and in screen mode

e Controlling program execution with the GO, STEP, and SET BREAK
commands, and monitoring execution with the SHOW CALLS, SET TRACE,
and SET WATCH commands

e Examining and manipulating data with the EXAMINE, DEPOSIT, and
EVALUATE commands

e Controlling symbol references with path names and the SET MODULE and
SET SCOPE commands

Several examples are language specific. However, the general concepts are
readily adaptable to all supported languages.

The sample debugging session in Section 6.6 shows how to use some of this
information to locate an error and correct it.

For information about starting and ending a debugging session, see Section 5.3.

6.1 Entering Debugger Commands and Accessing Online Help

After you start the debugger as explained in Section 5.3, you can enter debugger
commands whenever the debugger prompt (DBG>) is displayed. To enter a
command, type it at the keyboard and press Return. For example, the followmg
command sets a watchpoint on the variable COUNT:

DBG> SET WATCH COUNT

Detailed reference information about debugger commands is available through
the debugger’s online help:

e To list the help topics, type HELP at the prompt.
* For an explanation of the help system, type HELP HELP.
¢ For complete rules on entering commands, type HELP Command_Format.

e To display help on a particular command, type HELP command. For example,
to display HELP on the SET WATCH command, type HELP SET WATCH.
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e To list commands grouped by function, type HELP Command_Summary.
Online help is also available on the following topics:

New_Features

Release_Notes

Address_Expressions

Built_in_Symbols

Debugging_Configurations (default and multiprocess)
DECwindows_Interface

Keypad_Definitions

Language_Support

Logical_Names

Messages (diagnostic messages)

Path_Names (to qualify symbolic names)
Screen_Mode

SS$_DEBUG condition (to start debugger from program)
System_Management

VWS_Workstations

To display help about any of these topics, type HELP topic. For example, to
display information about diagnostic messages, type HELP Messages.

When you start the debugger, a few commonly used command sequences are
automatically assigned to the keys on the numeric keypad (to the right of the
main keyboard). Thus, you can perform certain functions either by entering a
command or by pressing a keypad key.

The predefined key functions are identified in Figure 6-1.

Most keypad keys have three predefined functions—DEFAULT, GOLD, and
BLUE.

e To enter a key’s DEFAULT function, press the key.

¢ To enter its GOLD function, first press and release the PF1 (GOLD) key, and
then press the key. :

e To enter its BLUE function, first press and release the PF4 (BLUE) key, and
then press the key.

In Figure 6-1, the DEFAULT, GOLD, and BLUE functions are listed within each
key’s outline, from top to bottom, respectively. For example:

e Pressing KP0 (keypad key 0) enters the STEP command.
e Pressing PF1 KPO enters the STEP/INTO command.
e Pressing PF4 KPO enters the STEP/OVER command.

Normally, keys KP2, KP4, KP6, and KP8 scroll screen displays down, left,
right, or up, respectively. By putting the keypad in the MOVE, EXPAND, or
CONTRACT state, indicated in Figure 6-1, you can also use these keys to
move, expand, or contract displays in four directions. Enter the command
HELP Keypad_Definitions to display the keypad key definitions.

You can redefine keypad key functions with the DEFINE/KEY command.
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Figure 6-1 Keypad Key Functions Predefined by the Debugger—Command Interface

(F17 \ Fi8 F19 F20 ™
DEFAULT MOVE EXPAND CONTRACT
(SCROLL) (EXPAND +) (EXPAND -)

\ J J

/PF1 PF2 PF3 PF4 )

GOLD HELP DEFAULT |SET MODE SCREEN BLUE

GOLD HELP GOLD SET MODE NOSCR BLUE

GOLD HELP BLUE DISP/GENERATE BLUE
7 /s N\ o -

DISP SRC,INST,QUT SCROLWUP DISPLAY next DISP next at FS

DISP INST,REG,OUT SCROLL/TOP SET PROC next

DISP 2 SRC, 2 INST SCROLU/UP... DISP 2 SRC DISP SRC, OUT

(s N\ s (c Y]

SCROLLLEFT EX/SOU .0\%PC SCROLL/RIGHT GO
SCROLL/ALEFT:255 SHOW CALLS SCROLL/RIGHT:255 } SEL/SOURCE next
SCROLLALEFT... SHOW CALLS 3 SCROLL/RIGHT... SEL/INST next
1 (> "\ 3 ENTER
EXAMINE SCROLL/DOWN SEL SCROLL next
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DISP 3 SRC, 3INST | SCROLL/DOWN... DISP 3 SRC
\ J ENTER
0 -
STEP RESET
STEP/NTO RESET
STEP/OVER RESET
. J/
LK201 Keyboard:
Press Keys 2,4,6,8
F17 SCROLL
F18 MOVE
F19 EXPAND
F20 CONTRACT
VT-100 Keyboard:
Type Keys 2,4,6,8
SET KEY/STATE=DEFAULT SCROLL
SET KEY/STATE=MOVE MOVE
SET KEY/STATE=EXPAND EXPAND
SET KEY/STATE=CONTRACT CONTRACT
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The debugger provides two modes for displaying information: noscreen mode
and screen mode. By default, when you start the debugger, you are in noscreen
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mode, but you might find that it is easier to view source code in screen mode.
The following sections briefly describe both modes.

6.2.1 Noscreen Mode

64

Noscreen mode is the default, line-oriented mode of displaying input and output.
The interactive examples throughout this chapter, excluding Section 6.2.2, show
noscreen mode.

In noscreen mode, use the TYPE command to display one or more source lines.
For example, the following command displays line 7 of the module in which
execution is currently paused:

DBG> TYPE 7
module SWAP_ROUTINES

1: TEMP := A;
DBG>

The display of source lines is independent of program execution. To display source
code from a module (compilation unit) other than the one in which execution is
currently paused, use the TYPE command with a path name to specify the
module. For example, the following command displays lines 16 to 21 of module
TEST:

DBG> TYPE TEST\16:21

Path names are discussed in more detail in Section 6.3.1, in conjunction with the
STEP command.

You can also use the EXAMINE/SOURCE command to display the source line for
a routine or any other program location that is associated with an instruction.

The debugger also displays source lines automatically when it suspends execution
at a breakpoint or watchpoint or after a STEP command, or when a tracepoint is
triggered (see Section 6.3).

After displaying source lines at various locations in your program, you can
redisplay the location at which execution is currently paused by pressing KP5.

If the debugger cannot locate source lines for display, it issues a diagnostic
message. Source lines might not be available for a variety of reasons. For
example:

e Execution is paused within a module that was compiled or linked without the
/MDEBUG qualifier.

¢ Execution is paused within a system or shareable image routine for which no
source code is available.

¢ The source file was moved to a different directory after it was compiled (the
location of source files is embedded in the object modules). In this case, use
the SET SOURCE command to specify the new location.

¢ The module might need to be set with the SET MODULE command. Module
setting is explained in Section 6.5.1.

To switch to noscreen mode from screen mode, press PF1 PF3 (or type SET
MODE NOSCREEN). You can use the TYPE and EXAMINE/SOURCE commands
in screen mode as well as noscreen mode.
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6.2.2 Screen Mode

Screen mode provides the easiest way to view your source code. To switch to
screen mode, press PF3 (or type SET MODE SCREEN). In screen mode, by
default the debugger splits the screen into three displays named SRC, OUT, and
PROMPT, as shown in Figure 6-2.

Figure 6-2 Default Screen Mode Display Configuration

—SRC: module SWAP_ROUTINES — scroll-source

: with Text IO; use TEXT IO; .

: package body SWAP ROUTINES is .

procedure SWAPT (A,B: in out INTEGER) is
TEMP: INTEGER;

bqu;‘i-EMP = A;
A .

.

- I
B := TEMP;
end;
11
12: procedure SWAP2 (A,B: in out COLOR) is
—OUT-output

stepped to SWAP_ROUTINES\SWAP1\$LINE 8
SWAP_ROUTINES\SWAP1\A: 35

— PROMPT — error-program-prompt
DBG> STEP

DBG> EXAMINE A

DBG>

ZK-6502-GE

The SRC display shows the source code of the module in which execution

is currently paused. An arrow in the left column points to the source line
corresponding to the current value of the program counter (PC). The PC is a
register that contains the memory address of the instruction to be executed next.
The line numbers, which are assigned by the compiler, match those.in a listing
file. As you execute the program, the arrow moves down and the source code is
scrolled vertically to center the arrow in the display.

The OUT display captures the debugger’s output in response to the commands
that you enter. The PROMPT display shows the debugger prompt, your input (the
commands that you enter), debugger diagnostic messages, and program output.

You can scroll both SRC and OUT to see whatever information might scroll
beyond the display window’s edge. Press KP3 repeatedly as needed to select the
display to be scrolled (by default, SRC is scrolled). Press KP8 to scroll up and
KP2 to scroll down. Scrolling a display does not affect program execution.

In screen mode, if the debugger cannot locate source lines for the routine in which
execution is currently paused, it tries to display source lines in the next routine
down on the call stack for which source lines are available. If the debugger can
display source lines for such a routine, it issues the following message:

$DEBUG-I-SOURCESCOPE, Source lines not available for .0\%PC.
Displaying source in a caller of the current routine.
DBG>
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In such cases, the arrow in the SRC display identifies the line that contains code
following the call statement in the calling routine.

6.3 Controlling and Monitoring Program Execution

This section explains how to perform the following tasks:

e Start and resume program execution

e Execute the program to the next source line, instruction, or other step unit
¢ Determine where execution is currently paused

e Use breakpoints to suspend program execution at points of interest

e TUse tracepoints to trace the execution path of your program through specified
locations '

e Use watchpoints to monitor changes in the values of variables

With this information you can pick program locations where you can then test
and manipulate the contents of variables as described in Section 6.4.

6.3.1 Starting or Resuming Program Execution
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Use the GO command to start or resume program execution.

After it is started with the GO command, program execution continues until one
of the following events occurs:

e The program completes execution
* A breakpoint is reached

e A watchpoint is triggered

¢ An exception is signaled

¢  You press Ctrl/C

With most programming languages, when you bring a program under debugger
control, execution is initially paused directly at the beginning of the main
program. Entering a GO command at this point quickly enables you to test for an

. infinite loop or an exception.

If an infinite loop occurs during execution, the program does not terminate, so the
debugger prompt does not reappear. To obtain the prompt, interrupt execution
by pressing Ctrl/C (see Section 5.3.6). If you are using screen mode, the pointer
in the source display indicates where execution stopped. You can also use the
SHOW CALLS command to identify the currently active routine calls on the call
stack (see Section 6.3.3).

If an exception that is not handled by your program is signaled, the debugger
interrupts execution at that point so that you can enter commands. You can then
look at the source display and a SHOW CALLS display to find where execution is
paused.

The most common use of the GO command is in conjunction with breakpoints,
tracepoints, and watchpoints, as described in Section 6.3.4, Section 6.3.5, and
Section 6.3.6, respectively. If you set a breakpoint in the path of execution and
then enter the GO command, execution is paused at that breakpoint. Similarly, if
you set a tracepoint, execution is monitored through that tracepoint. If you set a
watchpoint, execution is paused when the value of the watched variable changes.
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6.3.2 Executing the Program by Step Unit

Use the STEP command to execute the program one or more step units at a time.

By default, a step unit is one line of source code. In the following example, the
STEP command executes one line, reports the action ("stepped to ... "), and
displays the line number (27) and source code of the line to be executed next:

DBG> STEP

stepped to TEST\COUNT\SLINE 27
27: X =X+ 1;

DBG>

Execution is now paused at the first machine-code instruction for line 27 within
routine COUNT of module TEST.

When displaying a program symbol (for example, a line number, routine name, or
variable name), the debugger always uses a path name. A path name consists
of the symbol plus a prefix that identifies the symbol’s location. In the previous
example, the path name is TEST\ COUNT\ %LINE 27. The leftmost element of
a path name is the module name. Moving toward the right, the path name lists
any successively nested routines and blocks that enclose the symbol. A backslash
character (\ ) is used to separate elements (except when the language is Ada,
where a period is used to parallel Ada syntax).

A path name uniquely identifies a symbol of your program to the debugger. In
general, you need to use path names in commands only if the debugger cannot
resolve a symbol ambiguity in your program (see Section 6.5). Usually the
debugger can determine the symbol you mean from its context.

When using the STEP command, note that only those source lines for which code
instructions were generated by the compiler are recognized as executable lines by
the debugger. The debugger skips over any other lines—for example, comment
lines.

You can specify different stepping modes, such as stepping by instruction rather
than by line (SET STEP INSTRUCTION). Also, by default, the debugger steps
over called routines—execution is not paused within a called routine, although
the routine is executed. By entering the SET STEP INTO command, you direct
the debugger to suspend execution within called routines as well as within the
routine in which execution is currently paused (SET STEP OVER is the default
mode).

6.3.3 Determining Where Execution Is Paused

The SHOW CALLS command is useful when you are unsure where execution is
paused during a debugging session (for example, after a Ctrl/C interruption).

The command displays a traceback that lists the sequence of calls leading to the
routine in which execution is paused. For each routine (beginning with the one in
which execution is paused), the debugger displays the following information:

e The name of the module that contains the routine
e The name of the routine

e The line number at which the call was made (or at which execution is paused,
in the case of the current routine)

e The corresponding PC value
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L VAX

-On VAX processors, the PC value is shown as a memory address relative to
the nearest preceding symbol value (for example, a routine) and also as an
absolute address.

On Alpha processors, the PC is shown as a memory address relative to the
first code address in the module and also as an absolute address. ¢

For example:

DBG> SHOW CALLS
module name routine name line rel PC abs PC

*TEST PRODUCT 18 00000009 0000063C
*TEST COUNT 47 00000009 00000647
*MY PROG MY_PROG 21 0000000D 00000653
DBG>

This example indicates that execution is paused at line 18 of routine PRODUCT
(in module TEST), which was called from line 47 of routine COUNT (in module
TEST), which was called from line 21 of routine MY_PROG (in module MY_
PROG).

6.3.4 Suspending Program Execution with Breakpoints
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The SET BREAK command enables you to select locations at which to suspend
program execution (breakpoints). You can then enter commands to check the
call stack, examine the current values of variables, and so on. You resume
execution from a breakpoint with the GO or STEP commands.

The following example shows a typical use of the SET BREAK command:

DBG> SET BREAK COUNT
DBG> GO

break at routine PROG2\COUNT
54: procedure COUNT(X,Y:INTEGER);
DBG>

In the example, the SET BREAK command sets a breakpoint on routine COUNT
(at the beginning of the routine’s code); the GO command starts execution; when
routine COUNT is encountered, execution is paused, the debugger announces that
the breakpoint at COUNT has been reached ("break at . .. "), displays the source
line (54) at which execution is paused, and prompts for another command. At
this breakpoint, you can use the STEP command to step through routine COUNT
and then use the EXAMINE command (discussed in Section 6.4.1) to check on the
values of X and Y. '

When using the SET BREAK command, you can specify program locations using
various kinds of address expressions (for example, line numbers, routine
names, memory addresses, byte offsets). With high-level languages, you typically
use routine names, labels, or line numbers, possibly with path names to ensure
uniqueness.

Routine names and labels should be specified as they appear in the source code.
Line numbers can be derived from either a source code display or a listing file.
When specifying a line number, use the prefix %#LINE. Otherwise, the debugger
interprets the line number as a memory location. For example, the following
command sets a breakpoint at line 41 of the module in which execution is paused.
The breakpoint causes the debugger to suspend execution at the beginning of
line 41.
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DBG> SET BREAK 3LINE 41

Note that you can set breakpoints only on lines that resulted in machine-code
instructions. The debugger warns you if you try to do otherwise (for example, on
a comment line). To pick a line number in a module other than the one in which
execution is paused, you must specify the module’s name in a path name. For
example:

DBG> SET BREAK SCREEN_IO\%LINE 58

You can also use the SET BREAK command with a qualifier, but no parameter, to
break on every line, or on every CALL instruction, and so on. For example:

DBG> SET BREAK/LINE
DBG> SET BREAK/CALL

You can set breakpoints on events, such as exceptions, or state transitions in
tasking programs.

You can conditionalize a breakpoint (with a WHEN clause) or specify that a list of
commands be executed at the breakpoint (with a DO clause).

To display the current breakpoints, enter the SHOW BREAK command.

To deactivate a breakpoint, enter the DEACTIVATE BREAK command, and
specify the program location exactly as you did when setting the breakpoint.
This causes the debugger to ignore the breakpoint during program execution.
However, you can activate it at a later time, for example, when you rerun the

program (see Section 5.3.3). A deactivated breakpoint is listed as such in a
SHOW BREAK display.

To activate a breakpoint, use the ACTIVATE BREAK command. Activating a
breakpoint causes it to take effect during program execution.

The commands DEACTIVATE BREAK/ALL and ACTIVATE BREAK/ALL operate
on all breakpoints and are particularly useful when rerunning a program.

To cancel a breakpoint, use the CANCEL BREAK command. A canceled
breakpoint is no longer listed in a SHOW BREAK display.

6.3.5 Tracing Program Execution with Tracepoints

The SET TRACE command enables you to select locations for tracing the
execution of your program (tracepoints), without stopping its execution. After
setting a tracepoint, you can start execution with the GO command and then
monitor the path of execution, checking for unexpected behavior. By setting a
tracepoint on a routine, you can also monitor the number of times it is called.

As with breakpoints, every time a tracepoint is reached, the debugger issues a
message and displays the source line. But the program continues executing, and
the debugger prompt is not displayed. For example:

DBG> SET TRACE COUNT
DBG> GO
trace at routine PROG2\COUNT
54: procedure COUNT(X,Y:INTEGER);
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~ This is the only difference between a breakpoint and a tracepoint. When

using the SET TRACE command, you specify address expressions, qualifiers,
and optional clauses exactly as with the SET BREAK command. The
commands SHOW TRACE, ACTIVATE TRACE, DEACTIVATE TRACE, and
CANCEL TRACE operate on tracepoints in a manner similar to the corresponding
commands for breakpoints (see Section 6.3.4).

6.3.6 Monitoring Changes in Variables with Watchpoints
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The SET WATCH command enables you to specify program variables that the
debugger monitors as your program executes. This process is called setting
watchpoints. If the program modifies the value of a watched variable, the
debugger suspends execution and displays information. The debugger monitors
watchpoints continuously during program execution. (Note that you can also
use the SET WATCH command to monitor arbitrary program locations, not just
variables.)

The technique you use to set watchpoints depends on your system (VAX or Alpha)
and the type of variable (static or nonstatic).

On VAX processors, you can set a watchpoint on a static variable by specifying
the variable’s names with the SET WATCH command. Since a static variable
is associated with the same memory address throughout program execution, this
variable name is always meaningful. For example, the following command sets a
watchpoint on the variable TOTAL:

DBG> SET WATCH TOTAL

Subsequently, every time the program modifies the value of TOTAL, the
watchpoint is triggered.

The following example shows what happens when your program modifies the
contents of this watched variable:

DBG> SET WATCH TOTAL
DBG> GO

watch of SCREEN IO\TOTAL at SCREEN IO\$LINE 13

13:  TOTAL = TOTAL + 1;
old value: 16
new value: 17
break at SCREEN IO\SLINE 14
14:  POP(TOTAL);
DBG> .

In this example, a watchpoint is set on the variable TOTAL and execution is
started. When the value of TOTAL changes, execution is paused. The debugger
announces the event ("watch of . .. "), identifying where TOTAL changed (the
beginning of line 13) and the associated source line. The debugger then displays
the old and new values and announces that execution has been paused at the
beginning of the next line (14). Finally, the debugger prompts for another
command. When a change in a variable occurs at a point other than the
beginning of a source line, the debugger gives the line number plus the byte
offset from the beginning of the line. ¢

On VAX processors and Alpha processors, you can set a watchpoint on a nonstatic
variable by setting a tracepoint on the defining routine and specifying a DO
clause to set the watchpoint whenever execution reaches the tracepoint. Since

a nonstatic variable is allocated on the stack or in a register and exists only
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when its defining routine is active (on the call stack), the variable name is not
always meaningful in the way that a static variable name is.

In the following example, a watchpoint is set on the nonstatic variable Y in
routine ROUTS. After the tracepoint is triggered, the WPTTRACE message
indicates that the nonstatic watchpoint is set, and the watchpoint is triggered
when the value of Y changes. For example: -

DBG> SET TRACE/NOSOURCE ROUT3 DO (SET WATCH Y)
DBG> GO

trace at routine MOD4\ROUT3
$DEBUG-I-WPTTRACE, nonstatic watchpoint, tracing every
instruction

watch of MOD4\ROUT3\Y at MOD4\ROUT3\$LINE 16
16: Y := 4
old value: 3
new value: 4
break at MOD4\ROUT3\RLINE 17
17: SWAP(X,Y);
DBG>

When execution returns to the calling routine, the nonstatic variable is no
longer active, so the debugger automatically cancels the watchpoint and issues a
message to that effect.

. Alpha On Alpha processors, the debugger treats all watchpoints as nonstatic
watchpoints. ¢

The commands SHOW WATCH, ACTIVATE WATCH, DEACTIVATE WATCH,
and CANCEL WATCH operate on watchpoints in a manner similar to the
corresponding commands for breakpoints (see Section 6.3.4). However, a nonstatic
watchpoint exists only as long as execution remains within the scope of the
variable being watched.

6.4 Examining and Manipulating Program Data

This section explains how to use the EXAMINE, DEPOSIT, and EVALUATE
commands to display and modify the contents of variables and evaluate
expressions. Before you can examine or deposit into a nonstatic variable, as
defined in Section 6.3.6, its defining routine must be active.

6.4.1 Displaying the Value of a Variable

To display the current value of a variable, use the EXAMINE command. It has
the following syntax:

EXAMINE variable-name

The debugger recognizes the compiler-generated data type of the variable you
specify and retrieves and formats the data accordingly. The following examples
show some uses of the EXAMINE command.

Examine a string variable:

DBG> EXAMINE EMPLOYEE NAME
PAYROLL\EMPLOYEE NAME: "Peter C. Lombardi"
DBG>
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Examine three integer variables:

DBG> EXAMINE WIDTH, LENGTH, AREA
SIZE\WIDTH: 4

SIZE\LENGTH: 7

SIZE\AREA: 28

DBG>

Examine a two-dimensional array of real numbers (three per dimension):

DBG> EXAMINE REAL ARRAY
PROG2\REAL_ARRAY ~
(1,1): 27.01000
31.00000
12.48000
15.08000
22.30000
18.73000

Examine element 4 of a one-dimensional array of characters:

DBG> EXAMINE CHAR ARRAY(4)
PROG2\CHAR ARRAY(Z): 'm’
DBG>

Examine a record variable (COBOL example):

DBG> EXAMINE PART

INVENTORY \PART:
ITEM: "WF-1247"
PRICE: 49.95
IN_STOCK: 24

DBG>

Examine a record component (COBOL example):

DBG> EXAMINE IN_STOCK OF PART

INVENTORY\IN-STOCK of PART:
IN_STOCK: 24

DBG>

You can use the EXAMINE command with any kind of address expression (not
just a variable name) to display the contents of a program location. The debugger
associates certain default data types with untyped locations. You can override
the defaults for typed and untyped locations if you want the data interpreted and
displayed in some other data format.

6.4.2 Assigning a Value to a Variable
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To assign a new value to a variable, use the DEPOSIT command. It has the
following syntax:

DEPOSIT variable-name = value

The DEPOSIT command is like an assignment statement in most programming
languages.

In the following examples, the DEPOSIT command assigns new values to
different variables. The debugger checks that the value assigned, which can be a
language expression, is consistent with the data type and dimensional constraints
of the variable.
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Deposit a string value (it must be enclosed in quotation marks (") or apostrophes
(r):

DBG> DEPOSIT PART NUMBER = "WG-7619.3-84"

Deposit an integer expression:

DBG> DEPOSIT WIDTH = CURRENT WIDTH + 10

Deposit element 12 of an array of characters (you cannot deposit an entire array
aggregate with a single DEPOSIT command, only an element):

DBG> DEPOSIT C_ARRAY(12) := 'K’

Deposit a record component (you cannot deposit an entire record aggregate with a
single DEPOSIT command, only a component):

DBG> DEPOSIT EMPLOYEE.ZIPCODE = 02172
Deposit an out-of-bounds value (X was declared as a positive integer):

DBG> DEPOSIT X = -14
$DEBUG-I-IVALOUTBNDS, value assigned is out of bounds
at or near DEPOSIT

As with the EXAMINE command, you can specify any kind of address expression
(not just a variable name) with the DEPOSIT command. You can override the
defaults for typed and untyped locations if you want the data interpreted in some
other data format.

6.4.3 Evaluating Language Expressions

To evaluate a language expression, use the EVALUATE command. It has the
following syntax:

EVALUATE language-expression

The debugger recognizes the operators and expression syntax of the currently
set language. In the following example, the value 45 is assigned to the integer
variable WIDTH; the EVALUATE command then obtains the sum of the current
value of WIDTH and 7:

DBG> DEPOSIT WIDTH := 45
DBG> EVALUATE WIDTH + 7
52

DBG>

In the next example, the values TRUE and FALSE are assigned to the Boolean
variables WILLING and ABLE, respectively; the EVALUATE command then
obtains the logical conjunction of these values:

DBG> DEPOSIT WILLING := TRUE
DBG> DEPOSIT ABLE := FALSE
DBG> EVALUATE WILLING AND ABLE
False

DBG>
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6.5 Controlling Access to Symbols in Your Program

To have full access to the symbols that are associated with your program (variable
names, routine names, source code, line numbers, and so on), you must compile
and link the program using the /DEBUG qualifier, as explained in Section 5.2.

Under these conditions, the way in which the debugger handles these symbols is
transparent to you in most cases. However, the following two areas might require
action:

e Setting and canceling modules

¢ Resolving symbol ambiguities

6.5.1 Setting and Canceling Modules
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To facilitate symbol searches, the debugger loads symbol information from the
executable image into a run-time symbol table (RST), where that information can
be accessed efficiently. Unless symbol information is in the RST, the debugger
does not recognize or properly interpret the associated symbols.

Because the RST takes up memory, the debugger loads it dynamically,
anticipating what symbols you might want to reference in the course of program
execution. The loading process is called module setting, because all symbol
information for a given module is loaded into the RST at one time.

Initially, only the module containing the image transfer address is set.
Subsequently, whenever execution of the program is interrupted, the debugger
sets the module that contains the routine in which execution is paused. This
enables you to reference the symbols that should be visible at that location.

If you try to reference a symbol in a module that has not been set, the debugger
warns you that the symbol is not in the RST. For example:

DBG> EXAMINE K
$DEBUG-W-NOSYMBOL, symbol 'K’ is not in symbol table
DBG>

You must use the SET MODULE command to set the module containing that
symbeol explicitly. For example:

DBG> SET MODULE MOD3
DBG> EXAMINE K
MOD3\ROUT2\K: 26
DBG>

The SHOW MODULE command lists the modules of your program and identifies
which modules are set.

Dynamic module setting can slow the debugger down as more and more modules
are set. If performance becomes a problem, you can use the CANCEL MODULE
command to reduce the number of set modules, or you can disable dynamic
module setting by entering the SET MODE NODYNAMIC command (SET MODE
DYNAMIC enables dynamic module setting).
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6.5.2 Resolving Symbol Ambiguities

Symbol ambiguities can occur when a symbol (for example, a variable name X) is
defined in more than one routine or other program unit. »

In most cases, the debugger resolves symbol ambiguities automatically. First,

it uses the scope and visibility rules of the currently set language. In addition,
because the debugger permits you to specify symbols in arbitrary modules (to set
breakpoints and so on), the debugger uses the ordering of routine calls on the call
stack to resolve symbol ambiguities.

If the debugger cannot resolve a symbol ambiguity, it issues a message. For
example:

DBG> EXAMINE Y
$DEBUG-W-NOUNIQUE, symbol 'Y’ is not unique
DBG>

You can then use a path-name prefix to uniquely specify a declaration of the
given symbol. First, use the SHOW SYMBOL command to identify all path
names associated with the given symbol (corresponding to all declarations of that
symbol) that are currently loaded in the RST. Then use the desired path-name
prefix when referencing the symbol. For example:

DBG> SHOW SYMBOL Y
data MOD7\ROUT3\BLOCKI\Y
data MOD4\ROUT2\Y

DBG> EXAMINE MOD4\ROUT2\Y
MOD4\ROUT2\Y: 12

DBG>

If you need to refer to a particular declaration of Y repeatedly, use the SET
SCOPE command to establish a new default scope for symbol lookup. Then,
references to Y without a path-name prefix specify the declaration of Y that is
visible in the new scope. For example:

DBG> SET SCOPE MOD4\ROUT2
DBG> EXAMINE Y
MOD4\ROUT2\Y: 12

DBG>

To display the current scope for symbol lookup, use the SHOW SCOPE command.
To restore the default scope, use the CANCEL SCOPE command.

6.6 Sample Debugging Session

This section walks you through a debugging session with a simple FORTRAN
program that contains a logic error (see Example 6-1). Compiler-assigned line
numbers have been added in the example so that you can identify the source lines
referenced in the discussion.

The program, called SQUARES, performs the following functions:

1. Reads a sequence of integer numbers from a data file and saves these
numbers in the array INARR (lines 4 and 5).

2. Enters a loop in which it copies the square of each nonzero integer into
another array OUTARR (lines 8 through 13). :
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3. Prints the number of nonzero elements in the original sequence and the
square of each such element (lines 16 through 21).

Example 6-1 Sample Program SQUARES

1: INTEGER INARR(20), OUTARR(20)
2: C
e ---Read the input array from the data file.
4: OPEN(UNIT=8, FILE='DATAFILE.DAT’, STATUS='OLD’)
5: READ(8,*) N, (INARR(I), I=1,N)
6: C
7: C ---Square all nonzero elements and store in OUTARR.
8: K=0
9: DO10I=1, N
10: IF(INARR(I) .NE. 0) THEN
11: OUTARR(K) = INARR(I)*+2
12: ENDIF
13: 10 CONTINUE
14: C
15: C ---Print the squared output values. Then stop.
16: PRINT 20, K
17: 20 FORMAT(' Number of nonzero elements is‘,I4)
18: DO 40I=1,K
19: PRINT 30, I, OUTARR(I)

20: 30 FORMAT(' Element’,I4,’ has value’,I6)
21: 40 CONTINUE
22 END

When you run SQUARES, it produces the following output, regardless of the
number of nonzero elements in the data file:

$ RUN SQUARES
Number of nonzero elements is 0

The error in the program is that variable K, which keeps track of the current
index into OUTARR, is not incremented in the loop on lines 9 through 13. The
statement K = K + 1 should be inserted just before line 11.

Example 6-2 shows how to start the debugging session and then how to use the
debugger to find the error. Comments, keyed to the callouts, follow the example.

Example 6-2 Sample Debugging Session Using Program SQUARES

$ FORTRAN/DEBUG/NOOPTIMIZE SQUARES (1)

$ LINK/DEBUG SQUARES

$ SHOW LOGICAL DBG$PROCESS ©

$SHOW-S-NOTRAN, no translation for logical name DBG$PROCESS
$ DEBUG/KEEP @ ,

Debugger Banner and Version Number

DBG> RUN SQUARES ©
$DEBUG-I-INITIAL, language is FORTRAN, module set to SQUARES$MAIN
DBG> STEP 4
stepped to SQUARESSMAIN\SLINE 9
9: DO10I=1, N
DBG> EXAMINE N,k @
SQUARESSMATN\N: 9
SQUARESSMAIN\K: 0

(continued on next page)
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Example 6-2 (Cont.) Sample Debugging Session Using Program SQUARES

DBG> STEP 2 ©
stepped to SQUARESSMAIN\RLINE 11

11: OUTARR(K) = INARR(I)**2
DBG> EXAMINE I,K
SQUARESSMAIN\I: 1
SQUARESSMAIN\K: 0
DBG> DEPOSIT K =1 @
DBG> SET TRACE/SILENT $LINE 11 DO (DEPOSIT K = K + 1) iﬂ
DBG> GO
Number of nonzero elements is 4
Element 1 has value 16
Element 2 has value 36
Element 3 has value 9
Element 4 has value 49
$DEBUG-I-EXITSTATUS, is ’SYSTEM-S-NORMAL, normal successful completion’
DBG> SPAWN
$ EDIT SQUARES.FOR @

10: IF(INARR(I) .NE. 0) THEN
11: K=K+1

12: OUTARR(K) = INARR(I)**2
13: ENDIF

$ FORTRAN/DEBUG/NOOPTIMIZE SQUARES ®
$ LINK/DEBUG SQUARES

$ LOGOUT

DBG> RUN SQUARES (@

- $DEBUG-I-INITIAL, language is FORTRAN, module set to SQUARES$MAIN
DBG> SET BREAK $LINE 12 DO (EXAMINE I,K)
DBG> GO

SQUARESSMAIN\I: 1

SQUARESSMAIN\K: 1

DBG> GO

SQUARESSMAIN\I: 2

SQUARESSMAIN\K: 2

DBG> GO

SQUARESSMAIN\I: 4

SQUARESSMAIN\K: 3

DBG> EXIT

$

The following comments apply to the callouts in Example 6-2. Example 6-1
shows the program that is being debugged.

© The /DEBUG qualifier on the DCL FORTRAN command directs the compiler
to write the symbol information associated with SQUARES into the object
module, SQUARES.OBJ, in addition to the code and data for the program.

The /NOOPTIMIZE qualifier disables optimization by the FORTRAN
compiler, which ensures that the executable code matches the source code
of the program. Debugging optimized code can be confusing because the
contents of some program locations might be inconsistent with what you
would expect from viewing the source code.

® The /DEBUG qualifier on the DCL LINK command causes the linker to
include all symbol information that is contained in SQUARES.OBJ in the
executable image.
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© You can start the debugger in either the default configuration or the

multiprocess configuration, depending on the definition of the logical name
DBG$PROCESS. In this example, the SHOW LOGICAL DBG$PROCESS
command shows that DBG$PROCESS is undefined, indicating that the
default configuration is in effect. This is the correct configuration for a
program like SQUARES that runs in only one process.

The DCL command DEBUG/KEEP starts the debugger, which displays
its banner and the debugger prompt, DBG>. You can now enter debugger
commands.

The debugger command RUN SQUARES brings the program SQUARES
under debugger control. The informational message identifies the source
language of the program and the name of the main program unit (FORTRAN
and SQUARES, respectively, in this example).

Execution is initially paused at the start of the main program unit (line 1 of
SQUARES, in this example).

You decide to test the values of variables N and K after the READ statement
has been executed and the value 0 has been assigned to K.

The command STEP 4 executes 4 source lines of the program. Execution is
now paused at line 9. Note that the STEP command ignores source lines that -
do not result in executable code; also, by default, the debugger identifies the
source line at which execution is paused.

The command EXAMINE N, K displays the current values of N and K. Their
values are correct at this point in the execution of the program.

The command STEP 2 executes the program into the loop that copies and
squares all nonzero elements of INARR into OUTARR.

The command EXAMINE LK displays the current values of I and K.

I has the expected value 1, but K has the value 0 instead of 1, which is the
expected value. Now you can see the error in the program: K should be
incremented in the loop just before it is used in line 11.

The DEPOSIT command assigns K the value it should have now: 1.

The SET TRACE command is now used to patch the program so that the
value of K is incremented automatically in the loop. The command sets a
tracepoint that triggers every time execution reaches line 11:

e The /SILENT qualifier suppresses the "trace at" message that would
otherwise appear each time line 11 is executed.

e The DO clause issues the DEPOSIT K = K + 1 command every time the
tracepoint is triggered.

To test the patch, the GO command starts execution from the current location.

The program output shows that the patched program works properly. The
EXITSTATUS message shows that the program executed to completion.

The SPAWN command spawns a subprocess to return control temporarily to
DCL level (without ending the debugging session) so that you can correct the
source file and recompile and relink the program.

The EDIT command invokes an editor and the source file is edited to add
K = K + 1 after line 10, as shown. (Compiler-assigned line numbers have
been added to clarify the example.)
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The revised program is compiled and linked.

The LOGOUT command terminates the spawned subprocess and returns
control to the debugger.

The (debugger) command RUN SQUARES brings the revised program under
debugger control so that its correct execution can be verified.

The SET BREAK command sets a breakpoint that triggers every time line
12 is executed. The DO clause displays the values of I and K automatically
when the breakpoint triggers.

The GO command starts execution.

At the first breakpoint, the value of K is 1, indicating that the program is
running correctly so far. Each additional GO command shows the current
values of I and K. After two more GO commands, K is now 3, as expected,
but note that I is 4. The reason is that one of the INARR elements was 0 so
that lines 11 and 12 were not executed (and K was not incremented) for that
iteration of the DO loop. This confirms that the program is running correctly.:

The EXIT command ends the debugging session and returns control to DCL
level.
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Controlling and Monitoring Program Execution

This chapter describes how to control and monitor program execution while
debugging by using the following techniques:

¢ Executing the program by step unit
¢ Suspending and tracing execution with breakpoints and tracepoints

* Monitoring changes in variables and other program locations with
watchpoints

The following related functions are discussed in Chapter 6:
e Starting or resuming program execution with the GO command (Section 6.3.1)

* Monitoring where execution is currently paused with the SHOW CALLS
command (Section 6.3.3)

This chapter includes information that is common to all programs. For more
information:

* See Chapter 14 for additional information specific to multiprocess programs.
@ e See Chapter 15 for additional information specific to vectorized programs. ¢

e See Chapter 16 for additional information specific to tasking (multithread)
programs.

For information about rerunning your program or running another program from
the current debugging session, see Section 5.3.3 and Section 5.3.4.

7.1 Commands Used to Execute the Program
Only four debugger commands are directly associated with program execution:

GO

STEP

CALL

EXIT (if your program has exit handlers)

As explained in Section 6.3.1 and Section 6.3.2, GO and STEP are the basic
commands for starting and resuming program execution. The STEP command is
discussed further in Section 7.2.

During a debugging session, routines are executed as they are called during the
execution of a program. The CALL command enables you to arbitrarily call and
execute a routine that was linked with your program. This command is discussed
in Section 12.7.

The EXIT command was discussed in Section 5.3.5, in conjunction with ending a
debugging session. Because it executes any exit handlers in your program, it is
also useful for debugging exit handlers (see Section 13.6).
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When using any of these four commands, note that program execution can be
interrupted or stopped by any of the following events:

¢ The program terminates
¢ A breakpoint is reached
e A watchpoint is triggered
* An exception is signaled
*  You press Ctrl/C

7.2 Executing the Program by Step Unit

The STEP command (probably the most frequently used debugger command)
enables you to execute your program in small increments called step units.

By default, a step unit is an executable line of source code. In the following
example, the STEP command executes one line, reports the action ("stepped

to ... "), and displays the line number (27) and source code of the next line to be
executed:

DBG> STEP

stepped to TEST\COUNT\SLINE 27
27: X =X+ 1;

DBG>

Execution is now paused at the first machine-code instruction for line 27 of
module TEST. Line 27 is in COUNT, a routine within module TEST.

The STEP command can also execute several source lines at a time. If you specify
a positive integer as a parameter, the STEP command executes that number of
lines. In the following example, the STEP command executes the next three lines:

DBG> STEP 3

stepped to TEST\COUNT\RLINE 34
34:  SWAP(X,Y);

DBG>

Note that only those source lines for which code instructions were generated by
the compiler are recognized as executable lines by the debugger. The debugger

skips over any other lines—for example, comment lines. Also, if a line has more
than one statement on it, the debugger executes all the statements on that line
as part of the single step.

Source lines are displayed by default after stepping if they are available for the
module being debugged. Source lines are not available if you are stepping in code
that has not been compiled or linked with the /DEBUG qualifier (for example,

a shareable image routine). If source lines are available, you can control their
display with the SET STEP [NOJSOURCE command and the /[NO][SOURCE
qualifier of the STEP command. For information about how to control the display
of source code in general and in particular after stepping, see Chapter 10.

7.2.1 Changing the STEP Command Behavior

You can change the default behavior of the STEP command in two ways:
¢ By specifying a STEP command qualifier—for example, STEP/INTO

® By establishing a new default qualifier with the SET STEP command—for
example, SET STEP INTO
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In the following example, the STEP/INTO command steps into a called routine
when the program counter (PC) is at a call statement. The debugger displays
the source line identifying the routine PRODUCT, which is called from routine
COUNT of module TEST:

DBG> STEP/INTO
stepped to routine TEST\PRODUCT

6: function PRODUCT(X,Y : INTEGER) return INTEGER is
DBG>

After the STEP/INTO command executes, subsequent STEP commands revert to
the default behavior.

In contrast, the SET STEP command enables you to establish new defaults

for the STEP command. These defaults remain in effect until another SET
STEP command is entered. For example, the SET STEP INTO command causes
subsequent STEP commands to behave like STEP/INTO (SET STEP LINE causes
subsequent STEP commands to behave like STEP/LINE).

There is a SET STEP command parameter for each STEP command qualifier.

You can override the current STEP command defaults for the duration of a single
STEP command by specifying other qualifiers. Use the SHOW STEP command to
identify the current STEP command defaults.

7.2.2 Stepping Into and Over Routines

By default, when the PC is at a call statement and you enter the STEP command,
the debugger steps over the called routine. Although the routine is executed,
execution is not paused within the routine but, rather, on the beginning of the
line that follows the call statement. When stepping by instruction, execution is
paused on the instruction that follows a called routine’s return instruction.

To step into a called routine when the PC is at a call statement, enter the
STEP/INTO command. The following example shows how to step into the routine
PRODUCT, which is called from routine COUNT of module TEST:

DBG> STEP
stepped to TEST\COUNT\%LINE 18
18: AREA := PRODUCT(LENGTH, WIDTH);

DBG> STEP/INTO
stepped to routine TEST\PRODUCT

6: function PRODUCT(X,Y : INTEGER) return INTEGER is
DBG>

To return to the calling routine from any point within the called routine, use
the STEP/RETURN command. It causes the debugger to step to the return
instruction of the routine being executed. A subsequent STEP command brings
you back to the statement that follows the routine call. For example:

DBG> STEP/RETURN
stepped on return from TEST\PRODUCT\SLINE 11 to TEST\PRODUCT\$LINE 15+4
15: end PRODUCT;

DBG> STEP
stepped to TEST\COUNT\S$LINE 19

19: LENGTH := LENGTH + 1;
DBG>

To step into several routines, enter the SET STEP INTO command to change the
default behavior of the STEP command from STEP/OVER to STEP/INTO:

DBG> SET STEP INTO
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As a result of this command, when the PC is at a call statement, a STEP
command suspends execution within the called routine. If you later want to step
over routine calls, enter the SET STEP OVER command.

When SET STEP INTO is in effect, you can qualify the kinds of called routines
that the debugger is stepping into by specifying any of the following parameters
with the SET STEP command:

e [NO]JSB—Controls whether to step into routines called by JSB instructions.
(VAX processors only) ¢

e [NOJSHARE—Controls whether to step into called routines in shareable
images.

¢ [NO]JSYSTEM—Controls whether to step into called system routines.

These parameters make it possible to step into application-defined routines and

automatically step over system routines, and so on. For example, the following

command directs the debugger to step into called routines in user space only. The
debugger steps over routines in system space and in shareable images.

DBG> SET STEP INTO,NOSYSTEM,NOSHARE

7.3 Suspending and Tracing Execution with Breakpoints and
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Tracepoints

This section discusses using the SET BREAK and SET TRACE commands to,
respectively, suspend and trace program execution. The commands are discussed
together because of their similarities.

SET BREAK Command Overview

The SET BREAK command lets you specify program locations or events at which
to suspend program execution (breakpoints). After setting a breakpoint, you can
start or resume program execution with the GO command, letting the program
run until the specified location or condition is reached. When the breakpoint

is triggered, the debugger suspends execution, identifies the breakpoint, and
displays the DBG> prompt. You can then enter debugger commands—for
example, to determine where you are (with the SHOW CALLS command), step
into a routine, examine or modify variables, and so on.

The syntax of the SET BREAK command is as follows:

SET BREAK[/qualifief] . . . ]] [address-expression|, . . . ]
[WHEN (conditional-expression)] :
[DO (command]; . .. D]

The following example shows a typical use of the SET BREAK command and
shows the general default behavior of the debugger at a breakpoint.

In this example, the SET BREAK command sets a breakpoint on routine COUNT
(at the beginning of the routine’s code). The GO command starts execution. When
routine COUNT is encountered, execution is paused, the debugger announces that
the breakpoint at COUNT has been reached ("break at . .. "), displays the source
line (54) where execution is paused, and prompts for another command:
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